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Abstract 
 
ORA is a network analysis tool that detects risks or vulnerabilities of an organization’s 
design structure. The design structure of an organization is the relationship among its 
personnel, knowledge, resources, and tasks entities. These entities and relationships are 
represented by the Meta-Matrix. Measures that take as input a Meta-Matrix are used to 
analyze the structural properties of an organization for potential risk. ORA contains over 
100 measures which are categorized by which type of risk they detect. Measures are also 
organized by input requirements and by output. ORA generates formatted reports 
viewable on screen or in log files, and reads and writes networks in multiple data formats 
to be interoperable with existing network analysis packages. In addition, it has tools for 
graphically visualizing Meta-Matrix data and for optimizing a network’s design structure. 
ORA uses a Java interface for ease of use, and a C++ computational backend. The current 
version ORA1.2 software is available on the CASOS website: 
http://www.casos.ece.cmu.edu/projects/ORA/index.html. 
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Getting Started 
Welcome to ORA's Help File system. The ORA help set is organized into the following 
top-level folders: 

The Main Interface 

The Main Interface is the area for working with MetaMatrices. This includes loading & 
merging, performing various math on the Matrices, generating different networks, and 
running reports. 

The Visualizer 

This are is for visualizing the MetaMatrices you worked with in the Main Interface. 
Contains tools for hiding and revealing sets or individual entities and edges. It also allows 
you to group the entities in various ways. 

ORA Measures 

Explanation of the specific rules to place on MetaMatrices for viewing data. 

Lessons 

Lessons designed to teach specific material 
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What Is ORA? 
An Overview 

The Organizational Risk Analyzer (ORA) is a statistical analysis package for analyzing 
complex systems as dynamic social networks. Many complex systems such as 
organizations, intra-state alliances, food webs, etc. can be represented as an ecology of 
interlinked networks. Within ORA any complex system is represented as a MetaMatrix. 

What follows is a general description of ORA's primary capabilities. Specific instruction 
is provided under the correlating folders in this help system. 

The ORA Visualizer 

The ORA Visualizer renders conceptual images of social networks. Entities such as 
Agents, Task, Knowledge and Organizations are represented as Entities. Entities which 
share the same attributes can be further grouped together creating metaentities. Links, 
also called ties or edges, connect entities that share a direct relationship. Such 
relationships are derived from the MetaMatrix ORA's single unit of data input, and are 
referred to as graphs. The ORA Visualizer is interactive. You can zoom, rotate, isolate, 
add and remove entitysets, and much more. 

See Basic Terms for additional definitions relating to Social Networks. 

Reports 

ORA can run many reports: Risk, Intelligence, and Sphere of Influence to name a few. 
Multiple organizations can be compared against each other, network structure can be 
optimized, subgroups within a network can be identified, and scenarios involving the 
removal of agents, links, or nodes can be examined. Reporting capabilities are constantly 
being refined and updated. 
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See Report for detailed instruction and an explanation of each of ORA's current reports. 

Charts 

Four chart types are available: Bar Chart, Scatter Plot, Histogram, and Heat Map. Each 
one in turn presents a different statistical profile of a selected nodeset. Examples of these 
reports and how to access them can be found under Basic Usages. 

See Charts for detailed description of the measures and alogoriths that drive ORA 
Charts. 

System Requirements 
ORA performs best on machines that meet or exceed the following specifications: 

Windows XP, 256 MB RAM, Pentium 4 processor (or equivalent) running at 1.0 GHz. 

When working with extremely large data sets, increasing processing speed and RAM is 
highly recommended. 

Basic Terms 
Adjacency Matrix – A Matrix that is a square actor-by-actor (i=j) matrix where the 
presence of pair wise edges are recorded as elements. The main diagonal, or self-tie of an 
adjacency matrix is often ignored in network analysis. 

Aggregation – Combining statistics from different entities to higher entities. 

Attribute – Indicates the presence, absence, or strength of a particular connection 
between entities in a Matrix. 

Centrality – The nearness of an entity to all other entities in a network. It displays the 
ability to access information through edges connecting other entities. The closeness is the 
inverse of the sum of the shortest distances between each entity and every other entity in 
the network. 

Classic SNA density – The number of edges divided by the number of possible edges not 
including self-reference. For a square matrix, this algorithm first converts the diagonal to 
0, thereby ignoring self-reference (a node connecting to itself) and then calculates the 
density. When there are N nodes, the denominator is (N*(N-1)). To consider the self-
referential information use general density. 

Clique – A sub-structure that is defined as a set of entities where every entity is 
connected to every other entity. 
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Clustering coefficient – Used to determine whether or not a graph is a small-world 
network. 

Congruence – The match between a particular organizational design and the 
organization's ability to carry out a task. 

Degree – The number of edges to other entities in the network. 

Density –  

• Binary Network: The proportion of all possible edges actually present in the 
Matrix. 

• Value Network: The sum of the edges divided by the number of possible edges. 
(i.e. the ratio of the total edge strength that is actually present to the total number 
of possible edges). 

Dyad – Two entities and the connection between them. 

Dyadic Analysis – Statistical analysis where the data is in the form of ordered pairs or 
dyads. The dyads in such an analysis may or may not be for a network. 

Dynamic Social Network – Dynamic Network Analysis (DNA) is an emergent scientific 
field that brings together traditional social network analysis (SNA), link analysis (LA) 
and multi-agent systems (MAS). 

Edge – A specific relation among two entities. Other terms also used are tie and link. 

Entities – General things within an entity class (e.g. a set of actors such as employees). 

Entity – A specific entity (e.g., Joe, Martha, Bob; or, airplanes, buses, bicycles). 

Entity Class – The type of items we care about (knowledge, tasks, resources, agents). 

Entity Set – A collection of entities that group together for some reason. 

FOG – (F)uzzy (O)verlapping (G)roups. 

General density – The number of edges divided by the number of possible edges 
including self-reference. For a square matrix, this algorithm includes self-reference (an 
entity connecting to itself) when it calculates the density. When there are N entities, the 
denominator is (N*N). To ignore self-referential information use classic SNA density. 

Gini coefficient – The measure of inequality of a distribution of income. Uses a ratio 
with values between 0 and 1: the numerator is the area between the Lorenz curve of the 
distribution and the uniform (perfect) distribution line; the denominator is the area under 
the uniform distribution line. 
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In-Degree – The sum of the connections leading to an entity from other entities. 

Isolate – any entity which has no connections to any other entity 

Link – see Edge 

Main Diagonal – in a square matrix  

Math Terms 

These mathematical terms and symbols are used: Let S be any set: 

• card(S) = |S| = the cardinality of S (the cardinality of the entity-sets is represented 
as |A|, |K|, |R|, |T|) 

• � denotes a real number 
• Z denotes an integer 

Matrix Algebra – The part of algebra that deals with the theory of matrices. 

Measure – A measure is a function that maps one or more networks to Rn. Measures are 
often scalar (n=1) or vector valued with n=|V| or n=|U|. 

MetaMatrix – A statistical graph of correlating factors of personnel, knowledge, 
resources and tasks. These measures are based on work in social networks, operations 
research, organization theory, knowledge management, and task management. 

Monte Carlo – A random optimization of your organization 

Multiplex – Network where the links are from two or more relation classes. 

Multimode Network – Where the entities are in two or more entity classes. 

Neighbors – Entities that share an immediate edge to the entity selected. 

Network – Set of links among entities. Entities may be drawn from one or more entity 
classes and links may be of one or more relation classes. 

A network N is a triple consisting of two sets of entities, called U and V, and a set of 
edges E�UxV. Thus, we write N=(U,V,E). An element e = (i,j) in E indicates a 
relationship or tie between entities i�U and j�V. A network where U=V and therefore 
E�VxV is called unimodal; otherwise the network is bimodal. We write G=(V,E) for 
unimodal networks. For our purposes, unimodal networks will not contain self loops, 

which means that (i,i)�E for i�V. 

Network Types: 
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• Unimodal networks are also called square networks because their adjacency 
matrix is square; the diagonal is zero diagonal because there are no self-loops. 

Node: – see Entity 

Notation: 

The following matrix notation is used throughout the document for an arbitrary matrix X: 

• X(i,j) = the entry in the ith row and jth column of X 
• X(i,:) = ith row vector of X 
• X(:,j) = jth column vector of X 
• sum(X) = sum of the elements in X (also, X can be a row or column vector of a 

matrix) 
• dich(X) = dichotomize (make binary) X, so that dich(X)(i,j) = 1 iff X(i,j) > 0 
• X' = the transpose of X 
• ~X = for binary X, ~X(i,j) = 1 iff X(i,j) = 0 
• X@X = element-wise multiplication of two matrices (e.g. Z=X@Y => Z(i,j) = 

X(i,j)*Y(i,j)) 

ODBC – (O)pen (D)ata (B)ase (C)onnectivity 

An access method developed by the SQL Access group in 1992 whose goal was to make 
it possible to access any data from any application, regardless of which database 
management system (DBMS) is handling the data. 

Ontology – A branch of Metaphysics dealing with the nature of being. 

Organization – An organization is a collection of networks. 

Out-Degree – The sum of the connections leading out from an entity to other entities. 
This is a measure of how influential the entity may be. 

Pendant – Any entity which is only connected by one edge. They appear to dangle off 
the main group. 

Relation – The way in which entities in one class relate to entities in another class. 

Simulated Annealing – The term Simulated Annealing draws its inspiration from 
metallurgy, where essentially atoms within a metal are heated thereby dislodging them 
from a metal's internal structure transforming the metal into another atomic state. In this 
way, your organization is heated changing its components in the attempt to arrive at an 
optimized state. 

Sphere of Influence – One entity's direct relationship with one of it's neighbors as a 
function of specified path length. 
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Social Network Analysis – The term Social Network Analysis (or SNA) is used to refer 
to the analysis of any network such that all the entities are of one type (e.g., all people, or 
all roles, or all organizations), or at most two types (e.g., people and the groups they 
belong to). 

Tie – see Edge 

Trails – Analyzes the trails that an entity class makes through another entity class; for 
example, how vessels pass through ports. 
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Social Network Analysis (SNA) 
Social Network Analysis is a scientific area focused on the study of relations, often 
defined as social networks. In its basic form, a social network is a network where the 
entities are people and the relations (also called links or ties) are a form of connection 
such as friendship. Social Network Analysis takes graph theoretic ideas and applies them 
to the social world. The term social network was first coined in 1954 by J. A. Barnes 
(see: Class and Committees in a Norwegian Island Parish). Social network analysis is 
also called network analysis, structural analysis, and the study of human relations. SNA is 
often referred to as the science of connecting the dots. 

Today, the term Social Network Analysis (or SNA) is used to refer to the analysis of any 
network such that all the entities are of one type (e.g., all people, or all roles, or all 
organizations), or at most two types (e.g., people and the groups they belong to). The 
metrics and tools in this area, since they are based on the mathematics of graph theory, 
are applicable regardless of the type of nodes in the network or the reason for the 
connections. 

For most researchers, the entities are actors. As such, a network can be a cell of terrorists, 
employees of global company or simply a group of friends. However, entities are not 
limited to actors. A series of computers that interact with each other or a group of 
interconnected libraries can comprise a network also. 

Where to find out more on SNA 

• Scott, John, 2000, Social Networks, Sage (2nd edition) 
• Wasserman, S. & K. Faust, 1994, Social Network Analysis: Methods and 

Applications 
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Dynamic Network Analysis 
Dynamic Network Analysis (DNA) is an emergent scientific field that brings together 
traditional social network analysis (SNA), link analysis (LA) and multi-agent systems 
(MAS). There are two aspects of this field. The first is the statistical analysis of DNA 
data. The second is the utilization of simulation to address issues of network dynamics. 
DNA networks vary from traditional social networks in that are larger dynamic multi-
mode, multi-plex networks, and may contain varying levels of uncertainty. 

DNA statistical tools are generally optimized for large-scale networks and admit the 
analysis of multiple networks simultaneously in which, there are multiple types of entities 
(multi-entities) and multiple types of links (multi-plex). In contrast, SNA statistical tools 
focus on single or at most two mode data and facilitate the analysis of only one type of 
link at a time. 

DNA statistical tools tend to provide more measures to the user, because they have 
measures that use data drawn from multiple networks simultaneously. From a computer 
simulation perspective, entities in DNA are like atoms in quantum theory, entities can be, 
though need not be, treated as probabilistic. Whereas entities in a traditional SNA model 
are static, entities in a DNA model have the ability to learn. Properties change over time; 
entities can adapt: A company's employees can learn new skills and increase their value 
to the network; Or, kill one terrorist and three more are forced to improvise. Change 
propagates from one entity to the next and so on. DNA adds the critical element of a 
network's evolution and considers the circumstances under which change is likely to 
occur. 

Where to learn to more: 

• Kathleen M. Carley, 2003, “ Dynamic Network Analysis” in Dynamic Social 
Network Modeling and Analysis: Workshop Summary and Papers, Ronald 
Breiger, Kathleen Carley, and Philippa Pattison, (Eds.) Committee on Human 
Factors, National Research Council, National Research Council. Pp. 133-145, 
Washington, DC. 
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• Kathleen M. Carley, 2002, “ Smart Agents and Organizations of the Future” The 
Handbook of New Media. Edited by Leah Lievrouw and Sonia Livingstone, Ch. 
12, pp. 206-220, Thousand Oaks, CA, Sage. 

• Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2005-
forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, DSS 
Special Issue on Cyberinfrastructure for Homeland Security: Advances in 
Information Sharing, Data Mining, and Collaboration Systems. 
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ORA and DNA 
In general, you may want to use ORA in conjunction with other computational tools to 
advance DNA theory. The CMU CASOS tools that work with ORA to form tool chains 
are AutoMap (extracts networks from texts) and various DNA simulators including both 
Construct and DyNet. These tools have been used in a number of real world applications: 

• Designing adaptive teams for Command and Control Networks 
• Estimating the impact of organizational downsizing 
• Estimating the effectiveness of new structures 
• Evaluating risk in organizational designs 
• Examine impact of IT effectiveness 
• Impact analysis of actions in asymmetric warfare simulation 
• Impact analysis of weaponized biological attacks on cities 

ORA is interoperable with a number of other SNA and link-analysis tools: UCINET, 
KeyPlayer, and Analyst Notebook. Additional information is listed under data import and 
export. 

Where to learn more about CASOS tools and this tool chain: 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2004, An 
Integrated Approach to the Collection and Analysis of Network Data, In Proceedings of 
the NAACSOS 2004 Conference, Pittsburgh, PA 

Kathleen M.Carley, 2004, Estimating Vulnerabilities in Large Covert Networks Using 
Multi-Level Data, In Proceedings of the NAACSOS 2004 Conference, Pittsburgh, PA 

Kathleen M. Carley, 2003, Dynamic Network Analysis in Dynamic Social Network 
Modeling and Analysis: Workshop Summary and Papers, Ronald Breiger, Kathleen 
Carley, and Philippa Pattison, (Eds.) Committee on Human Factors, National Research 
Council, National Research Council. Pp. 133-145, Washington, DC. 
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Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2005-
forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, DSS Special 
Issue on Cyberinfrastructure for Homeland Security: Advances in Information Sharing, 
Data Mining, and Collaboration Systems. 

CASOS: Center for Computational Analysis of Social and Organizational Systems 
(http://www.casos.cs.cmu.edu/index.html) 
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Where To Begin 
To begin, you must load a Meta-Matrix into ORA. Your Meta-Matrix file can be of the 
following file formats: DyNetML (a specially defined markup language for representing 
dynamic networks), CSV, GraphML, and the text (DL) and binary data formats of 
UCINET. 

Other methods to load a Metamatrix include building your own graph from an excel 
spreadsheet and cutting and pasting the information directly into ORA. For now, we will 
assume you have a MetaMatrix in one of the commonly defined formats above. There are 
two ways to load a MetaMatrix: 

Select the folder icon from the tool bar. The navigate to the directory 
where the Metamatrix data set is saved 

OR 

From the Main Menu select: File > Open Metamatrix. Then navigate to 
the directory which contains the Metamatrix you want. 

ORA can work with multiple MetaMatrices. Whether you load a MetaMatrix for the first 
time or if you had been working with a MetaMatrix from a previous session, a pop-up 
window displays the following button options: 
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Choose Replace Selected Org to remove the previous Metamatrix and replace it with the 
current one; 

Choose Append As Additional Org to add it to any MetaMatrices already loaded in the 
ORA session; 

Choose Replace all Orgs to remove any Metamatrices loaded into ORA and start over 
with the current Metamatrix only. 

ORA's Main Interface 
The ORA interface is organized into three resizable window panes. In the left corner 
appears a tree directory of the current MetaMatrix or MetaMatrices loaded into ORA. On 
the right, appears a pane that tells you basic information about the MetaMatrix you 
loaded, such as how many entities are represented. This pane also allows quick access to 
ORA's Visualizer, Reports and Chart tools. By selecting the Visualize button, the 
currently loaded MetaMatrix will render in the ORA Visualizer, which will load in a 
separate window. 

Note the considerable amount of empty space in the ORA interface's bottom pane. This 
area will be used for report data generation. For now, it can be resized to one's 
preferences. 
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Panel 1 

Panel 1 contains all the MetaMatrices you currently have active. Clicking on the plus 
icon will expand the MetaMatrix showing all the Entities and Graphs. 

 

And if you hover the pointer over a graph it will display information about that graph. 

 

Panel 2 

Panel 2 displays the information regarding the  

1. Name of the active MetaMatrix; 
2. Currently selected metaMatrix showing it's pathway; 
3. Entity Set Names (Size); 
4. Entity Set Count; 
5. Entity Count; 
6. Edge Count; 
7. Graph Count; and 
8. Total Density. 
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Panel 3 

Panel 3, which at the start is blank, will contain any reports that are run on the 
MetaMatrices. 

Adding and Removing Entities In The 
Editor 
The MetaMatrix Composer is accessed through ORA's main interface and allows you to 
add or remove entities and entitysets by creating or removing attributes you wish to 
associate with your MetaMatrix. An attribute is a label that you wish to give a particular 
entity and can literally be anything you wish (worker, leader, Africa, March, 1989, etc.) 
Attributes can be used to define entities and entitysets according to your specific 
descriptions. For example, if you wanted to add the attribute leader to describe several 
entities, you can go directly inside the MetaMatrix Editor and give attributes to those 
entities which you attribute the description leader. 

From ORA's main interface > "Editor" tab > Enter desired attribute 
under selected row and column for appropriate entity. 

The black ellipses below highlight how to access the MetaMatrix Editor from ORA's 
main interface. 
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File Menu 

 

Open MetaMatrix 

This item opens up a single MetaMatrix with the following formats: 
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Dynetml (the native ORA xml format), .dl, .##h (UCINet), .CSV (comma separated 
values, Excel spreadsheet out), .txt (text files), .raw, .net (Pajek), .graphml, .stl (GMU 
model), .lo (pathfinder) 

Data Import Wizard 

This item contains additional options for importing MetaMatrices such as multiple file 
importing. 

Import Database 

An advanced feature for importing a database. 

Import Attribute File 

It is used to add an attribute into a file. The file selected must be in the CSV format. 

Open Workspace 

You may open an entire workspace that you were previously using. A workspace consists 
of a set of MetaMatricx files that were all open at the same time, and saved as a 
workspace. 

Save MetaMatrix As… 

Save the changes you've made in a MetaMatrix under a new filename. 

Save Workspace 

Save all active MetaMatrices into a Workspace which can be opened up at a later date. 

Network Format Converter 

The Network Format Converter takes files from one format and convert it to an ORA 
format. 

CSV Table Converter 

Convert a .csv file into an ORA format. 

Exit 

Close the program and leave 
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Creating A MetaMatrix From An Excel 
Spreadsheet 
 

If you don't have a MetaMatrix, you can create one from scratch. Below is step-by-step 
instruction on how to do this. 

We will create "Network Midas" an agent-by-agent square MetaMatrix. We say it is 
"square" because all row headings correspond directly to column headings. This is 
important as it relates to specific measures ORA can run on a graph. If the graph is not 
square, some measures will not work (See Measures for additional instruction). 

Begin by opening a blank Microsoft Excel work book. In "column A" we will enter the 
name of all agents that make up our social network or organization. 



  

 

 

2007 ORA Users Guide - Page 31 

Note: When creating your spreadsheet, do not add any additional titles, 
notes, or other headings, which will interfere with the "square" 
properties of the MetaMatrix. 

 

Next, create column headings using the correlating names as they appear in row 
headings. Again, this will ensure that our MetaMatrix will be square. 
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Here we will create "links (aka edges, and ties)" between each agent. We do this by 
entering a "1" if a direct connection or relationship exists and a "0" if it does not. Please 
note that headings that cross-reference themselves are considered redundant and thus are 
left blank or "0." For instance, in cell "B2" it is assumed "agent Hank" has a tie to 
himself. 

In the example below, "Red Xs" are used to illustrate the redundant ties. This redundancy 
should continue as a smooth diagonal line from the top left corner of your MetaMatrix to 
the bottom right. 
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Tip! If you can't make this smooth diagonal line, you graph is not 
square. 

Using 1sand 0s to establish linkages, complete your spreadsheet. 

In the "Network Midas" example, we have assigned relationships randomly. Within your 
organization or network, however, you can describe any direct connections or 
relationships you are interested in analyzing. For instance, you may determine that a 
"direct connection" exits if agents within your network consult with each other at least 
once a month; literally, it can be anything you decide. 

Below is our completed MetaMatrix, Network Midas (The red fill illustrates cells that do 
not require input due to their redundancy). 
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Now that we have essentially built a MetaMatrix from scratch using Excel, the next step 
is to save it in a compatible file format ORA can interpret. For Excel spreadsheets, in all 
likelihood, this will be the "CSV" (comma separate values) file format. 

From the drop down menu: File > Save As > Save As Type > CSV (comma delimited) 
(*.csv) 
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Click "OK" 

 

Click "Yes" 

Congratulations! You have now created your own MetaMatrix from scratch. Now, simply 
load your saved CSV file as you would any DynetML file, and work with your data the 
same way. 

Below is a our MetaMatrix Network Midas rendered in the ORA Visualizer 
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ORA Charts 
Charts 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

Three charts are available: The Bar chart, Scatter Plot, Histogram, and Heat Map. ORA 
Charts can be accessed through the Main Interface by clicking the View Charts For This 
MetaMatrix button in the MetaMatrix Composer window pane or from the Main Interface 
drop down menu. 

From the Main Menu select Data Visualization > Charts; OR 

Select the [Charts] button. 

In the screen shot below, ellipses highlight both methods to access ORA Charts. 
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After choosing Reports, the following pop-up window will appear. Select the entityset 
you are interested in Charting and select the [Next] button. For this example, we will 
simply select the currently loaded entityset Agents. ORA produces the following Bar 
Chart, displayed in the screen shot below. 

 

By now, you should be able to access ORA Charts by loading a MetaMatrix by either 
using the [Charts] button in the MetaMatrix Composer window pane or from the Main 
Menu of the main interface. See Chart Types Explained for more detailed information 
about the four chart types. 
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Chart Types Explained 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, and Histogram. 

ORA Bar Chart 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

A bar chart, also known as a bar graph, is a chart with rectangular bars of lengths usually 
proportional to the magnitudes or frequencies of what they represent. Bar charts are used 
for comparing two or more values. The bars can be horizontally or vertically oriented. 
Sometimes a stretched graphic is used instead of a solid bar. 
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Scatter Plot 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

A scatterplot, scatter diagram or scatter graph is a chart that uses Cartesian coordinates to 
display values for two variables. The data is displayed as a collection of points, each 
having one coordinate on the horizontal axis and one on the vertical axis. 

A scatterplot does not specify dependent or independent variables. Either type of variable 
can be plotted on either axis. Scatterplots represent the association (not causation) 
between two variables. 

A scatterplot can show various kinds of relationships, including positive (rising), negative 
(falling), and no relationship. If the pattern of dots slopes from lower left to upper right, it 
suggests a positive correlation between the variables being studied. If the pattern of dots 
slopes from upper left to lower right, it suggests a negative correlation. A line of best fit 
can be drawn in order to study the correlation between the variables. An equation for the 
line of best fit can be computed using the method of linear regression. 
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Histogram 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

In statistics, a histogram is a graphical display of tabulated frequencies. A histogram is 
the graphical version of a table which shows what proportion of cases fall into each of 
several or many specified categories. The histogram differs from a bar chart in that it is 
the area of the bar that denotes the value, not the height, a crucial distinction when the 
categories are not of uniform width (Lancaster, 1974). The categories are usually 
specified as non-overlapping intervals of some variable. The categories (bars) must be 
adjacent. 

The word histogram is derived from histos and gramma in Greek, the first meaning web 
or mast and the second meaning drawing, record or writing. A histogram of something is 
thus, etymologically speaking, a drawing of the web of this something. 
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Over-Time Viewer 
The Over-Time Viewer enables you to study changes within your organization or 
network over a time period. For instance, the overall centrality value of your network can 
be analyzed as it relates to network data compiled over the years, say, 2000, 2001, 2002. 
The time interval is dependent only on your data collection samples. Such an analysis can 
then be compared to external or internal events. 

As an example, let us say you are interested in learning how the events of September 11, 
2001 affected a terrorist organization or how the passing of anti-terrorism legislation 
impacted the same network. In either case, you can run measures in the Over Time 
Viewer on your network samples (loaded as multiple MetaMatrices) then compare the 
results against such external events. 

There are three lessons showing the functions of the Overtime Viewer. 

1. Lesson 5: Overtime Viewer 
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2. Lesson 6: Immediate Impact 
3. Lesson 7: Near Term Impact Analysis 

Over-Time Viewer 
The Over-Time Viewer enables you to study changes within your organization or 
network over a time period. For instance, the overall centrality value of your network can 
be analyzed as it relates to network data compiled over the years, say, 2000, 2001, 2002. 
The time interval is dependent only on your data collection samples. Such an analysis can 
then be compared to external or internal events. 

As an example, let us say you are interested in learning how the events of September 11, 
2001 affected a terrorist organization or how the passing of anti-terrorism legislation 
impacted the same network. In either case, you can run measures in the Over Time 
Viewer on your network samples (loaded as multiple MetaMatrices) then compare the 
results against such external events. 

There are three lessons showing the functions of the Overtime Viewer. 

1. Lesson 5: Overtime Viewer 
2. Lesson 6: Immediate Impact 
3. Lesson 7: Near Term Impact Analysis 

ORA Measures 
ORA contains over 100 measures. A measure is a function that takes as input a 
MetaMatrix and outputs a single value or a vector of values. Consider the measure 
Density. The output for this measure is a single number used to analyze an organization. 
By default, all measures are run on a MetaMatrix. To view which measures are available, 
go to the Tools menu and select the Measures Manager. 

 

The Measures Manager dialog box will appear. A drop down box displays the measures 
in ORA. 
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The Measures Manager categorizes measures in the following ways: Entity Level, Graph 
Level, and Risk Category. 

An Entity Level measure produces vector output, a single value per entity. For example, 
Betweenness Centrality run on the Agent x Agent network outputs a value for each agent 
entity. A Graph Level measure outputs a single value. For example, Density run on any 
network outputs a single number. Additionally, seven risk categories include measures 
describing certain aspects of your organization's structure. All of the measures can be 
selected and de-selected using the buttons at the bottom of the dialog box. When a 
measure is deselected, it will not be used when generating certain reports. 

Some reports use a predefined set of measures, and these are not affected by the Measure 
Manager selections (for example, the Intel, Context, Located SubGroups, Sphere of 
Influence, and Immediate Impact reports). The Risk Report, however, uses only the 
measures selected in the Measure Manager. 
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The following sets of entities (with their abbreviated symbol) are used throughout the 
document: Agent (A), Knowledge (K), Resource (R), and Task (T). The following 
networks defined on these entity sets are used throughout the documentation. 

 
Symbol Entity Sets Name 
 U V   
AA Agent Agent Communication Network 
AK Agent Knowledge Knowledge Network 
AR Agent Resource Capabilities Network 
AT Agent Task Assignment Network 
KK Knowledge Knowledge Information Network 
KR Knowledge Resource Training Network 
KT Knowledge Task Knowledge Requirement Network 
RR Resource Resource Resource Substitute Network 
RT Resource Task Resource Requirement Network 
TT Task Task Precedence Network 

Input: 

This lists each of the matrices that are required as input to the measure. If a measure takes 
as input a specific matrix from the Meta-Matrix, such as the Agent x Knowledge (AK) 
matrix, then it is listed. If the measure runs on any square (unimodal) network then N is 
given. A measure can require more than one input matrix. 

a. Each input matrix can have one or more of the following requirements:  
i. square: the matrix must have the same number of rows as columns 

ii. binary: it must be binary data (i.e. any edges in the matrix are assumed to 
have a weight of one) 

iii. symmetric: the matrix must be undirected 
b. ORA does the following when a matrix does not meet one or more of the above 

requirements: 
i. square: measure is not computed 

ii. binary: measure is computed, and edge weights are ignored (all edges are 
given value one) 

iii. symmetric: measure is computed, and the matrix is first symmetrized 
using the union method 

A complete list of all measures available in ORA, along with references, input and output 
specifications, can be found in the following Ora Measures sections. 

Access Index: Knowledge and Resource 
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The Boolean value is true if a particular agent is the only agent who knows a piece of 
knowledge and who is known by exactly one other agent. The one agent known also has 
its KAI set to one. 

The average shortest path length between entities, excluding infinite distances.  

Ashworth, 2003 

TYPE: Entity Level 

INPUT: 

Knowledge: AK: binary; AA: binary 

Resource: AR: binary; AA: binary 

OUTPUT: Binary 

The Knowledge Access Index (KAI) for agent i is defined as follows: 

let 

 

for Resource replace AK with AR 

Then 

 

for Resource replace KAI with RAI 
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Actual Workload, Knowledge and 
Resource Based 
The knowledge an agent uses to perform the tasks to which it is assigned. 

Carley, 2002 

TYPE: Entity Level 

INPUT:  

Knowledge: AK: binary; KT: binary; AT: binary 

Resource: AR: binary; RT: binary; AT: binary 

OUTPUT:  

Actual Workload for agent i is defined as follows: 

 

for Resource replace AK with AR and KT with RT 

Note how Potential Workload is the first matrix product. 
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Measure: Average Distance 
The average shortest path length between entities, excluding infinite distances. 

Netstat 

TYPE: Agent Level 

INPUT: N: square, binary 

OUTPUT: Graph Level: 

 

Let G=(V,E) represent a square network. Define a set S of all pairs (i,j) of entities such 
that i can reach j. Then average the shortest paths. 

let S = {(i,j) | j is reachable in G from j } 

Then, 

 

 



  

 

 

2007 ORA Users Guide - Page 48 

 

Boundary Spanner 
An entity which, if removed from a network, creates a new component. This is often 
called a Gate Keeper entity. 

Cormen, Leiserson, Riverest, Stein, 2001 p.558 

TYPE: Agent Level 

INPUT: N: square, binary, symmetric 

OUTPUT: Entity level: Binary  

A Boundary Spanner is an articulation point of N, as defined in the referenced book. 

 

Centrality, Betweenness 
The Betweenness Centrality of entity v in a network is defined as: across all entity pairs 
that have a shortest path containing v, the percentage that pass through v. This is defined 
for directed networks. 

Freeman, 1979 

TYPE: Entity Level 

INPUT: N: square 

OUTPUT:  

Let G=(V,E) be the graph representation for the network. Let n=|V|, and fix an entity 
. 

For , let be the number of geodesics in G from u to w. 

If , then set . 

Define the following: 
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let 

 

let  

Then Betweenness Centrality of the entity .  

Note: if G is not symmetric, then between is normalized by (n-1)(n-2). 

 

Centrality, Bonacich Power 
The Bonacich Power Centrality computes the centrality of each entity based on the 
centrality of its neighbors. Beta should be chosen such that its absolute value is less than 
the reciprocal of the larges eigenvalue of N. 

Bonacich P, 1987 

TYPE: Entity Level 

INPUT: N: square 

 

OUTPUT:  

Let A = adjacency representation of the network N. Then Bonacich Power Centrality for 
the network is the solution c to the following system of linear equations: 

, where I is the identity matrix, and e a vector of ones. 

Note that if beta is 0, then c is simply equal to the row degree of each 
entity. 

The values of c are not normalized. 
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Centrality, Closeness 
The average closeness of an entity to the other entities in a network. Loosely, Closeness 
is the inverse of the average distance in the network between the entity and all other 
entities. This is defined for directed networks. 

Freeman, 1979 

TYPE: Entity Level 

INPUT: N: square 

OUTPUT:  

Let G=(V,E) be the graph representation of the square network. 

Fix 

 

let 

, if every entity is reachable from v. 

Then Closeness Centrality of entity 

. 

If some entity is not reachable from v then the Closeness Centrality of v is |V|. 
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Centrality, Eigenvector 
The centrality of a entity based on its degree and the degrees of its neighbors. 

Bonacich P, 1972 

TYPE: Entity Level 

INPUT: N: square, symmetric 

OUTPUT:  

Calculates the eigenvector of the largest positive eigenvalue of the adjacency matrix 
representation of a square network. A Jacobi method is used to compute the eigenvalues 
and vectors. 

 

Centrality, In Degree 
The In Degree Centrality of a entity in a network is its normalized In-degree. 

Wasserman and Faust, 1994 

TYPE: Entity Level 

INPUT: N 

OUTPUT:  

Consider the matrix representation X of a network with m rows and n columns. Each 
column j is assigned an in-degree centrality based on the sum of entries in its column. 

The In-Degree Centrality for column j 

 

This measure is also called Column Degree Centrality. 
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Centrality, Information 
Calculates the Stephenson and Zelen information centrality measure for each entity. 

Wasserman and Faust, 1994 (pg. 195) 

TYPE: Entity Level 

INPUT: N: square 

OUTPUT: Entity Level: 

 

Calculates the measure described on pg 195-6 of Wasserman and Faust. Isolates (entities 
with no edges) are first removed from the network, and the measure computed on the 
resulting sub-graph. The isolates are given centrality value 0. 

 

Centrality, Inverse Closeness 
The average closeness of a entity to the other entities in a network. Inverse Closeness is 
the sum of the inverse distances between an entity and all other entities. This is defined 
for directed networks. 

Wasserman and Faust, 1994 (pg 195) 

TYPE: Node Level 

INPUT: N: square, binary 

OUTPUT:  

Let G=(V,E) be the graph representation of the square network. 

Fix  

let 
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if i is not reachable from v. 

Then, Inverse Closeness Centrality of entity v = dist/(|V|-1). 

 

Centrality, Out Degree 
The Out Degree Centrality of a entity in a square network is its normalized out-degree. 

Wasserman and Faust, 1994 

TYPE: Entity Level 

INPUT: N: square 

OUTPUT:   (If N is binary) 

Consider the matrix representation X of a network with m rows and n columns. Each row 
i is assigned an out-degree centrality based on the sum of entries in its row. 

The Out-Degree Centrality 

 

This measure is also called Row Degree Centrality. 

 

Centrality, Total Degree 
The Total Degree Centrality of an entity in a square network is its normalized in plus out 
degree. The Total Degree Centrality of an entity is the normalized sum of its row and 
column degrees. 

Wasserman and Faust, 1994 (pg 199) 

TYPE: Entity Level 
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INPUT: N:square 

OUTPUT:  

Consider the matrix representation X of a square network with n entities. Each entity is 
assigned a value based on the sum of its row and columns. 

The Total Degree Centrality for 

 

Note that the diagonal values are ignored. 

 

Clique Count 
Computes the number of distinct cliques to which each entity in a square, undirected 
network belongs. 

Wasserman and Faust, 1994 (pg 254) 

TYPE: Node Level 

INPUT: N:square, symmetric 

OUTPUT:  

A clique of an undirected, square network is defined in Wasserman and Faust as a 
maximal complete subgraph of three or more nodes. The clique detection algorithm 
employed is the Bron-Kerbosch maximal clique algorithm, which is Algorithm 457 of the 
Collected Algorithms from CACM. 

 

Clustering Coefficient, Watts-Strogatz 
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Measures the degree of clustering in a network by averaging the clustering coefficient of 
each entity. The clustering coefficient of a entity is the density of its ego network which 
is the sub graph induced by its immediate neighbors. 

Watts and Strogatz, 1998 

TYPE: Graph Level, Entity Level 

INPUT: N: square, binary 

OUTPUT: 

Graph Level:  

Entity Level:  

let G=(V,E) be the graph representation of a square network. 

Define for each node its Clustering Coefficient :  

let Gv = ego network of entity v 

Then Clustering Coefficient for 

 

Cognitive Demand 
Measures the total amount of effort expended by each agent to do its tasks. Measures the 
total cognitive effort expended by an agent to do its tasks. 

Individuals who are high in cognitive demand are emergent leaders. Removal of these 
individuals is quite disruptive to networks. 

Note: The minimum input requirement is the AA network. All other 
networks are optional. 
Carley, 2002 

TYPE: Agent Level 

INPUT: AA:binary; [AT:binary]; [AR:binary]; [RT:binary]; [AK:binary]; [KT:binary]; 
[TT:binary] 

OUTPUT: Agent Level: 
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The Cognitive Demand for an agent i is an average of terms, each of which measures an 
aspect of its cognitive demand. Each term is normalized to be in [0,1]. The number of 
terms depends on the input networks. The computation of each term for agent i is detailed 
below: 

let x1 = # of agents with which i interacts 

= sum(AA(i,:)) / (|A|-1) 

let x2 = # of tasks to which i is assigned 

= sum(AT(i,:)) / |T| 

let x3 = sum of the # of agents assigned to the same tasks as i  

= sum(ATA(i,:)-ATA(i,i)) / (|T|(|A|-1)), where ATA = AT*AT' 

let x4 = # of resources i manages 

= sum(AR(i,:)) / |R| 

let x5 = # of knowledge i manages 

= sum(AK(i,:)) / |K| 

let x6 = sum of # resources i needs for all its tasks 

= sum(ATR(i,:)) / (|T|*|R|), where ATR = AT*RT' 

let x7 = sum of # knowledge i needs for all its tasks 

= sum(ATK(i,:)) / (|T|*|K|), where ATK = AT*KT' 

let x8 = sum of resource negotiation needs i has for its tasks 

= HammingDistance(AR(i,:), [AT*RT'](i,: )) / |R| 

let x9 = sum of knowledge negotiation needs i has for its tasks 

= HammingDistance(AK(i,:), [AT*KT'](i,: )) / |K| 

let x10 = sum of agents that i depends on or that depend on i 

let w = # number of agents assigned to each task 
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= colsum(AT) 

let s = # agents that dependent on each task 

= (T+T')*w 

let v = # tasks that agents are dependent on  

= AT*s 

Then, x10 = v(i) / ( |A|*|T|*(|T|-1)). 

Then Cognitive Demand for agent i is the average of the above terms. 

Cognitive Distinctiveness /  
Cognitive Distinctiveness, Relative 
Measures how distinct are two agents based on the number of knowledge bits they hold 
oppositely. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

For each pair of agents (i,j) compute the number of knowledge bits they have exactly 
opposite. Then normalize this sum by the total number of knowledge bits. In effect, this is 
the exclusive-OR of their knowledge vectors. 

 

Note that the CD output matrix is symmetric. 

Relative Cognitive Distinctiveness normalizes each element of CD as follows: 
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Thus, the elements of the ith row are normalized by the ith row sum. 

Relative Cognitive Distinctiveness 
Measures how distinct are two agents based on the number of knowledge bits they hold 
oppositely. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

Cognitive Expertise /  
Cognitive Expertise, Relative 
Measures the complementarity of two agents based on their knowledge. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

For each pair of agents (i,j) compute the number of knowledge bits that j knows that i 
does not know. Then normalize this sum by the total number of knowledge bits that agent 
i does not know. 
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Note that the CD output matrix is NOT-symmetric. 

Relative Cognitive Expertise normalizes each element of CE as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 

Cognitive Resemblance /  
Cognitive Resemblance, Relative 
Measures the degree of resemblance between agents based on the number of knowledge 
bits they both have or both do not have. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

For each pair of agents (i,j) compute the number of knowledge bits they have in common 
- whether known or unknown. Then normalize this sum by the total number of 
knowledge bits. 
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Note that the CR output matrix is symmetric. 

Relative Cognitive Resemblance normalizes each element of CR as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 

Cognitive Similarity /  
Cognitive Similarity, Relative 
Measures the degree of similarity between agents based on the number of knowledge bits 
they both have. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

For each pair of agents (i,j) compute the number of knowledge bits they have in common. 
Then normalize this sum by the total knowledge between them. 
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Note that the CS output matrix is symmetric. 

Relative Cognitive Similarity normalizes each element of CS as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 

Communication 
Measures the degree of similarity between agents based on the number of knowledge bits 
they both have. 

Carley, 2003 

TYPE: Agent Level 

INPUT: AA:binary; AT:binary; AR:binary; RT:binary, TT:binary 

OUTPUT:  

Communication uses the concepts from Communication Congruence: 

Handoff, Co-Assignment, and Negotiation.  

let H, C, and N be defined as in Communication Congruence. 

let M(i,j) = [AA + (H+H') + C + (N+N')](i,j) > 0, and M(i,i) = 0 
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Note that the transpose of H and N is used to make the 
communication reciprocal. 

let d = sum(M(i,:)) 

let d = d / (|A|-1), normalizing d to be in [0,1] 

Then Communication for agent i is d. 

Component Count, Strong 
The number of strongly connected components in a network. 

Wasserman and Faust, 1994 (pg 109) 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Given a square, symmetric network G=(V,E), the Strong Component Count is the number 
of strongly connected components in G. This is computed directly on G, whether or not G 
is directed.  

Component Count, Weak 
The number of weakly connected components in a network. 

Wasserman and Faust, 1994 (pg 109) 

TYPE: Graph Level 

INPUT: N:square, binary, symmetric 

OUTPUT:  

Given a square, symmetric network G=(V,E), the Weak Component Count is the number 
of connected components in G. Such components are called weak because the graph G is 
undirected. 

Component Members, Weak 



  

 

 

2007 ORA Users Guide - Page 63 

Assigns each entity an integer which corresponds to the weak component in the network 
to which it belongs. 

Wasserman and Faust,1994 

 

TYPE: Node Level 

INPUT: N:square, binary, symmetric 

OUTPUT:  

Given a square, symmetric network G=(V,E), the Weak Component Member for 
a entity is the weak component to which the entity belongs. The components are 
numbered from 1 to the number of weak components (Weak Component Count). 

Congruence, Agent Knowledge Needs /  
Congruence, Agent Resource Needs 
The number of skills that an agent lacks to complete its assigned tasks expressed as a 
percentage of the total skills required for the assigned tasks. 

Lee, 2004 

TYPE: Agent Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

Agent Knowledge Needs compares the knowledge needs of the agent to do its assigned 
tasks, with the actual knowledge of the agent. 

Let N = AT*KT' = knowledge needed by agents to do assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge needed but not available. 

Then, Agent Knowledge Needs for 



  

 

 

2007 ORA Users Guide - Page 64 

 

Agent Resource Needs is analogous, replacing AK with AR, and KT with RT. 

Congruence, Agent Knowledge Waste /  
Congruence, Agent Resource Waste 
The number of skills that an agent has that are not needed by any of its tasks expressed as 
a percentage of the total skills of the agent. 

Lee, 2004 

TYPE: Agent Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

Agent Knowledge Waste compares the knowledge of the agent with the knowledge it 
actually needs to do its tasks. Any unused knowledge is considered wasted. 

Let N = AT*KT' = knowledge needed by an agent to do its assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge the agent has but which is not needed. 

Then, Agent Knowledge Waste for 
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The equation for Agent Resource Waste replaces AK with AR, and KT with RT. 

Congruence, Communication 
Measures to what extent the agents communicate when and only when it is needful to 
complete tasks. Hence, higher congrunce occurs when agents don't communicate if the 
tasks don't require it, and do when the tasks require it. 

Communication needs to be reciprocal. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AA: binary, AT: binary, [AR/RT]: binary, [AK/KT]: binary, TT: binary 

OUTPUT:  

One of the following pairs of matrices must exist: AK/KT, AR/RT. If both exist, then the 
measure first concatenates them into [AK AR], [KT RT] and uses them. 

Communication Congruence = 1 iif agents communicate when and only when it is 
needful to complete their tasks. There are three task related reasons when agents i and j 
need to communicate: 

(a) Handoff: if i is assigned to a task s and j is assigned to a task t and s directly precedes 
task t. 

(b) Co-Assignment: if i is assigned to a task s and j is also assigned to s. 

(c) Negotiation: if i is assigned to a task s and j is not, and there is a resource r to which 
agents assigned to s have no access but j does. 

The three cases are computed as follows: 

(a) let H = AT*TT*AT' 

(b) let C = AT*AT' 

(c) let N = AT*Z*AR', where Z(t,r) = [AT'*AR - RT'](t,r)<0 

Note that C is always symmetric, but not necessarily H and N. 

let Q(i,j) = [ (H+H') + C + (N+N')](i,j) > 0. 
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Communication Congruence requires reciprocal communication, explaining the 
transposes of H and N to make them symmetric. 

let d = hamming distance between Q and AA, which measures the degree to which 
communication differs from that which is needed to do tasks. 

The maximum value for d is d_max = |A|*(|A|-1) 

Then Communication Congruence = 1 - (d /d_max), which is in [0,1]. 

Congruence,  
Organization Agent Knowledge Needs /  
Organization Agent Resource Needs 
Across all agents, the skills that agents lack to do their assigned tasks expressed as a 
percentage of the total skills needed by all agents. 

Lee, 2004 

TYPE: Graph Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

As in Agent Needs, let N = AT*KT' 

for Resource replace KT with RT 

Then 

 

Organization Agent Resource Needs is analogous, replacing AK with AR, and KT with 
RT. 
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Congruence,  
Organization Agent Knowledge Waste /  
Organization Agent Resource Waste 
Across all agents, the skills that agents have that are not required to do their assigned 
tasks. 

Lee, 2004 

TYPE: Graph Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

As in Agent Waste, let N = AT*KT' 

for Resource replace KT with RT 

Then 

 

The equation for Organization Agent Resource Needs replaces AK with AR, and KT with 
RT. 

Congruence,  
Organization Task Knowledge Needs / 
Organization Task Resource Needs 
Across all tasks, the skills that tasks lack expressed as a percentage of the total skills 
needed by all tasks. 

Lee, 2004 

TYPE: Graph Level 
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INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

As in Task Needs, let S = AT'*AK 

for Respource replace AK with AR 

Then 

 

The equation for Organization Task Resource Needs replaces AK with AR, and KT with 
RT. 

Congruence 
Organization Task Knowledge Waste / 
Organization Task Resource Waste 
Across all tasks, the skills supplied to tasks via agents that are not required by them, 
expressed as a percentage of the total skills needed by all tasks. 

Lee, 2004 

TYPE: Graph Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT: Graph Level: 

 

As in Task Waste, let S = AT'*AK 

for Resource replace AK with AR 

Then 
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The equation for Organization Task Resource Waste replaces AK with AR, and KT with 
RT. 

Congruence,  
Strict Knowledge/Strict Resource 
Measures the similarity between what knowledge is assigned to tasks via agents, and 
what knowledge is required to do tasks. Perfect congruence occurs when agents have 
knowledge when and only when (strictly) it is needful to complete tasks. 

Carley, 2002 

TYPE: Graph Level 

INPUT:  

Knowledge: AK:binary; AT:binary; KT:binary 

Resource: AR:binary; AT:binary; RT:binary 

OUTPUT:  

Knowledge Congruence = 1 iff agents have knowledge when and only when it is needful 
to complete their tasks. Thus, we compute the knowledge assigned to tasks via agents, 
and compare it with the knowledge needed for tasks.  

let KAT = dich(AK'*AT) 

for Resource KAT becomes RAT and replace AK with AR 

let 

 

for Resource replace KT with RT 



  

 

 

2007 ORA Users Guide - Page 70 

let <d = d / (|K|*|T|), which normalizes d to be in [0,1] 

for Resource replace |K| with |R| 

Then Knowledge Congruence = 1 - d 

Congruence, Task Knowledge Needs / 
Congruence, Task Resource Needs 
The number of skills not supplied to a task, and required to do the task, expressed as a 
percentage of the total skills required for the task. 

Carley, 2002 

TYPE: Task Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

 

Task Knowledge Needs compares the knowledge requirements of each task with the 
knowledge available to the task via agents assigned to it. It is similar to Knowledge 
Congruence, but quantifies only the under supply of knowledge to tasks. 

Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge required but not supplied. 

Thus, 

 

The equation for Agent Resource Needs replaces AK with AR, and KT with RT. 
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Congruence, Task Knowledge Waste / 
Congruence, Task Resource Waste 
The number of skills supplied to a task via agents that are not required by it expressed as 
a percentage of the total skills required for the task. 

Carley, 2002 

TYPE: Task Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT: Task Level: 

 

Task Knowledge Waste compares the knowledge requirements of each task with the 
knowledge available to the task via agents assigned to it. It is similar to Knowledge 
Congruence, but quantifies only the over supply of knowledge to tasks. 

Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge supplied but not required. 

Thus, 

 

The equation for Agent Resource Waste replaces AK with AR, and KT with RT. 

Connectedness, Krackhardt 
Measures the degree to which a square network's underlying (undirected) network is 
connected. 

Krackhardt, 1994 



  

 

 

2007 ORA Users Guide - Page 72 

TYPE: Graph Level 

INPUT: N:square, symmetric 

OUTPUT:  

The Connectedness of a square, symmetric network is the Density of its Reachability 
Network. 

Constraint, Burt 
The degree to which each entity in a square network is constrained from acting because 
of its existing links to other entities. 

Burt, 1992 

TYPE: Node Level 

INPUT: N: square 

OUTPUT:  

This is the Constraint measure described by Equ. 2.4 on pg. 55 of Burt, 1992. Note that 
the matrix Z is the adjacency matrix representation of the network N. 

Density 
The ratio of the number of edges versus the maximum possible edges for a network. 

Wasserman and Faust, 1994 (pg 101) 

TYPE: Graph Level 

INPUT: N 

OUTPUT:  

Let M be the adjacency matrix for the network of dimension m x n. 

If the network is unimodal, then m=n and M has a zero diagonal, and therefore 

Density = sum(M)/(m*(m-1)). 
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For rectangular networks, Density = sum(M)/(m*n). 

Diameter 
The maximum shortest path length between any two nodes in a unimodal network 
G=(V,E). If there exist i,j in V such that j is not reachable from i, then the diameter is 
returned as |V|. 

Wasserman and Faust, 1994 (pg 111) 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

The diameter of G=(V,E) is defined as: 

 

That is, the maximum shortest directed path between any two vertices in G. If there exists 
i and j such that j is not reachable from i, then |V| is returned. 

Diversity, Knowledge/Resource 
The distribution of difference in idea sharing. This is the Herfindahl-Hirshman index 
applied to column sums of AK. 

Borgatti, 2003 

TYPE: Graph Level 

INPUT:  

Knowledge: AK:binary 

Resource: AR:binary 

OUTPUT:  

This is the Herfindahl-Hirshman index (economics: sum of the squares of each firm's 
market share) applied to the normalized column sums of AK. This measures the degree to 
which knowledge is equally known. 
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let 

 

let 

 

Then 

 

Resource Diversity is analogous, replacing AK with AR. 

Edge Count, Lateral 
Fixing a root entity x, a lateral edge (i,j) is one in which the distance from x to i is the 
same as the distance from x to j. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let G=(V,E) be the graph representation of a network. And fix an entity x�V to be the 
root entity. 

Let 

 

Then Lateral Edge Count = |S| / |E| 
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Edge Count, Pooled 
A pooled edge in a network N=(V,E) is an edge (i,j)� E such that there exists at least one 
other edge (i,k) � E, and k � j. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N 

OUTPUT:  

Let M be the adjacency matrix representation of a unimodal network. 

Let S = { (i,j) | M(i,j)=1 � sum(M(:,j))>1 } 

In other words: edge (i,j) is a pooled edge iff the in-degree of entity j > 1. 

Then Pooled Edge Count = |S| / |E| 

Edge Count, Reciprocal 
The percentage of edges in a network that are reciprocated (also called Reciprocity). An 
edge (i,j) in the network is reciprocated if edge (j,i) is also in the network. Self-loops are 
ignored. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N: square, binary 

OUTPUT:  

Let G=(V,E) be the graph representation of a network. 

Let S=card{(i,j)�E|i<,(j,i)�E} 

Then Reciprocral Edge Count = |S| / |E| 

Edge Count, Sequential 
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The percentage of edges in a network that are neither Reciprocal Edges nor Pooled 
Edges. Note that an edge can be both a Pooled and a Reciprocal edge. Self-loops are 
ignored. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N: square, binary 

OUTPUT:  

Let G=(V,E) be the graph representation of a network, and let X = set of Pooled edges of 
G, and let Y = set of Reciprocal edges of G. 

Then Sequential Edge Count = | E-X-Y| / |E| 

Edge Count, Skip 
The fraction of edges in a unimodal network that skip levels. An edge (i,j) is a skip edge 
if there is a path from entity i to entity j even after the edge (i,j) is removed. 

Carley, 2002 

TYPE: Entity Level 

INPUT: N: square, binary 

OUTPUT:  

A skip edge in a network G=(V,E) is an edge (i,j)�E such that j is reachable from i in the 
graph G'=(V,E\(i,j)), that is, the graph G with edge (i,j) removed. Skip Count is simply 
the number of such edges in G normalized to be in [0,1] by dividing by |E|.  

Effective Network Size 
The effective size of an entities's communication Network based on redundancy of ties. 

Burt, 1992 

TYPE: Entity Level 

INPUT: N: square, binary 
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OUTPUT:  

This is the Effective Size of Network measure described by Equ. 2.2 on pg. 52 of Burt, 
1992. Note that the Communciation Network is used for the matrix Z. 

Efficiency, Global 
Measures the closeness of the entities in the network. 

Latora and Marchiori, 2001 

TYPE: Graph Level 

INPUT: N:square, binary, symmetric 

OUTPUT:  

Global Efficiency is the normalized sum of the inverse geodesic distances between all 
entity pairs. Let G be a square network on n entities. 

Then, 

 

Efficiency, Krackhardt 
The degree to which each component in a network contains the minimum edges possible 
to keep it connected. 

Krackhardt, 1994 

TYPE: Graph Level 

INPUT: N: square, binary, symmetric 

OUTPUT:  

Let G=(V,E) be the graph representation of a square, undirected network. 

let 
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let 

 

let 

 

let 

 

Then Efficiency = 1 - penalty/maxPenalty 

Efficiency, Local 
Measures the closeness of the entities in each ego network in the network. 

Latora and Marchiori, 2001 

TYPE: Graph Level 

INPUT: N: square, binary, symmetric 

OUTPUT:  

Local Efficiency is the normalized sum of the inverse closeness of the ego networks 
(here, the ego network for entity i does not include entity i). 

Let G = (V,E) be any square, symmetric network with |V| = N entities. 

let 

 

let 

 

to 
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define 

 

Then, 

 

Entity Level 
The Entity Level for a entity v in a square network is the worst case shortest path from v 
to every entity v can reach. 

Carley, 2002 

TYPE: Entity Level 

INPUT: N:square 

OUTPUT:  

Let G=(V,E) be the graph representation of a square network and fix an entity v. 

Entity Level if v 
cannot reach any entities, then its level 

Exclusivity — 
Knowledge, Resource, Task 
Detects agents who have singular knowledge or Resources. 

Ashworth, 2003 

TYPE: Entity Level 

INPUT:  
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Knowledge: AK:binary 

Resource: AR:binary 

Task: AT:binary 

OUTPUT:  

The Knowledge Exclusivity Index (KEI) for agent i is defined as follows: 

Resource Exclusivity Index (REI) or Task Exclusivity Index (TEI) 

 

for Resource replace AK with AR 

for Tasks replace AK with AT 

The Resource Exclusivity Index (REI) for agent i is defined exactly as for Knowledge 
Based Exclusivity, but with the matrix AK replace by AR. 

The Task Exclusivity Index (TEI) for agent i is defined exactly as for Knowledge Based 
Exclusivity, but with the matrix AK replaced by AT. 

Fragmentation 
The proportion of entities in a network that are disconnected. 

Borgatti, 2003 

TYPE: Graph Level 

INPUT: N: square, binary, symmetric 

OUTPUT:  

Consider a square, symmetric network G=(V,E). 

let 

 

let 
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Then, 

 

Hierarchy, Krackhardt 
The degree to which a square network N exhibits a pure hierarchical structure. 

Krackhardt, 1994 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let N be a square network. The Hierarchy of N is the Reciprocity of the Reachability 
Network for N. 

Interdependence and Radials 
The percentage of edges in a network N that are Pooled and Reciprocal. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let G=(V,E) be the graph representation of a square network. 

Let a = Pooled Edge Count and b = Reciprocal Edge Count of the network. 

Then Interdependence = (a+b)/|E| 
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Interlockers and Radials 
Interlockers and radial entities in a square network have a high and low Triad Count, 
respectively. 

Carley, 2002 

TYPE: Entity Level 

INPUT: N: square, binary 

OUTPUT: Binary 

Let N=(V,E) be a square network. 

Let 

= Triad Count for node i,  

Let 

= the mean of  

Let 

= the variance of  

Then, 

if , then agent k is an interlocker. 

If , then agent k is a radial. 

 

Load, Knowledge or Resource 
Average number of knowledge or resource per agent. 

Carley, 2002 
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TYPE: Graph Level 

INPUT: AK:binary 

OUTPUT:  

Knowledge Load = sum(AK)/ (|A|) 

Resource Load is defined analogously, replacing AK with AR. 

Negotiation, Knowledge or Resource 
The extent to which personnel need to negotiate with each other because they lack the 
knowledge to do the tasks to which they are assigned. 

Carley, 2002 

TYPE: Graph Level 

INPUT:  

Knowledge: AT:binary; AK:binary; KT:binary 

Resource: AT:binary; AR:binary; RT:binary 

OUTPUT:  

Compute the percentage of tasks that lack at least one knowledge (or Resource): 

let 

 

for Resource replace AK with AR and KT with RT 

let 

 

Then Knowledge (or Resource) Negotiation = |S| / |T| 
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Network Centralization, Column Degree 
A centralization based on the out degree of the column vertices in a network N.  

TYPE: Graph Level 

INPUT: N 

OUTPUT:  

Let N be a network with n column entities. 

let 

 

let 

 

Then 

 

Network Centralization, In Degree 
A centralization of a square network based on the In-Degree Centrality of each entity. 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  
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Let N be a unimodal network with n entities. 

let 

 

let 

 

Then 

 

where D = (n-2) if N is undirected, and (n-1) otherwise. 

Network Centralization, Out Degree 
A centralization of a square network based on the Out-Degree Centrality of each entity. 

NetStat 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let N be a unimodal network with n nodes. 

let 

 

let 

 

Then 
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, 

where D = (n-2) if N is undirected, and (n-1) otherwise. 

Network Centralization, Row Degree 
A centralization based on the out degree of the row vertices in a network N. 

TYPE: Graph Level 

INPUT: N 

OUTPUT:  

Let N be a network with n row nodes. 

let 

 

let 

 

Then 

 

Network Centralization, Total Degree 
A centralization of a square network based on total degree centrality of each entity. 

Freeman, 1979 

TYPE: Graph Level 
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INPUT: N: square, symmetric 

OUTPUT:  

Let N be a unimodal network with n entities. 

let 

 

let 

 

Then 

 

Network Levels 
An entity level metric is one that is defined for, and gives a value for, each entity in a 
network. If there are x entities in a network, then the metric is calculated x times, once 
each for each entity. Examples are Degree Centrality, Betweeness, and Cognitive 
Demand. 

A network level metric is one that is defined for, and gives a value for, the network as a 
whole. The metric is calculated once for the network. Examples are Centralization, Graph 
Hierarchy, and the maximum or average Betweeness. 

Given an entity level metric, e.g., degree centrality, then the minimum, maximum, 
average, and standard deviation of that metric for that network level metrics. Examples 
are average degree centrality, maximum betweeness, and the standard deviation in 
cognitive demand. 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  
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Let G=(V,E) be the graph representation of a square network and fix an entity v. 

Then 

 

Omega, Knowledge or Resource 
The degree to which an organization reuses knowledge or resource. 

Carley, Dekker, and Krackhardt 2000 

TYPE: Graph Level 

INPUT:  

Knowledge: AT:binary; KT:binary; TT:binary 

Resource: AR:binary; RT:binary; TT:binary 

OUTPUT:  

Let TAT = TA*TA' 

Let N = ((T'@TAT)*KT')@KT' 

for resource replace KT with RT 

Then Knowledge Based Omega = sum(N)/sum(KT) 

for resource replace KT with RT 

Performance as Accuracy 
Measures how accurately agents can perform their assigned tasks based on their access to 
knowledge and resources. 

Carley, 2002 

TYPE: Graph Level 

INPUT:  
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AT: binary; [AK/KT]: binary; [AR/RT]: binary 

OUTPUT:  

One of the following pairs of matrices must exist: AK/KT, AR/RT. If both exist, then the 
measure first concatenates them into [AK AR], [KT RT] and uses them. 

Accuracy is computed based on the binary classification problem. It is computed in one 
of two ways: 

(1) Knowledge based: Let b be a binary string of length |K|, let N=KT', and let S=AK. Fix 
a task t. 

let 

 

which is the correct classification of b with respect to task t. 

Now, let I={ i | AT(i,t)=1}. 

let 

 

This is agent i's classification of b with respect to t. 

The group of agents classify b using majority voting. 

That is, 

 

Then, if group_answer = answer, then the group was accurate, otherwise not. 

This is repeated multiple times for each task, and across all tasks. The percentage correct 
is Performance as Accuracy. 

(2) Resource based: let N=RT' and S=AR in the analysis of case (1). 
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Personnel Cost 
Total number of people reporting to an agent, plus its total knowledge, resources, and 
tasks. 

Carley, 2003 

TYPE: Agent Level 

INPUT: AA:binary; AK:binary; AR:binary; AT:binary 

OUTPUT:  

Personnel Cost is the sum of the in-degree centrality of all AA matrices in the graph (this 
computes the number of agents reporting to each agent), plus the out-degree centrality of 
any AK, AR, and AT graphs. 

This sum is scaled so that each entity gets a score in [0,1]. 

Potential Workload — Knowledge or 
Resource 
Maximum knowledge or resource an agent could use to do tasks if it were assigned to all 
tasks. 

Carley, 2002 

TYPE: Entity Level 

INPUT:  

Knowledge: AK:binary; KT:binary 

Resource: AR:binary; RT:binary 

OUTPUT:  

Potential Knowledge Workload for agent i = sum((AK*KT)(i,:))/sum(KT) 

for Resource replace AK with AR and KT with RT 

Redundancy, Access 
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Average number of redundant agents per resource. An agent is redundant if there is 
already an agent that has access to the resource. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AR:binary  

OUTPUT:  

This is the Column Redundancy of matrix AR. 

Redundancy, Assignment 
Average number of redundant agents assigned to tasks. An agent is redundant if there is 
already an agent assigned to the task. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AT 

OUTPUT:  

This is the Column Redundancy of matrix AT. 

Redundancy, Column 
The mean number of column node edges in excess of one. 

TYPE: Graph Level 

INPUT: N of dimension m x n 

OUTPUT:  

Let M be the matrix representation for a network N of dimension m x n. 

let 
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for 

 

this is the number of column entries in excess of one for column j. 

Then 

 

Redundancy, Knowledge 
Average number of redundant agents per knowledge. An agent is redundant if there is 
already an agent that has the knowledge. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AK: Binary 

OUTPUT:  

This is the Column Redundancy of matrix AK. 

Redundancy, Resource 
Average number of redundant resources assigned to tasks. A resource is redundant if 
there is already a resource assigned to the task. 

Carley, 2002 

TYPE: Graph Level 

INPUT: RT:binary 
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OUTPUT:  

This is the Column Redundancy of matrix RT. 

Redundancy, Row 
The mean number of row entity edges in excess of one. 

TYPE: Graph Level 

INPUT: N of dimension m x n 

OUTPUT:   for N dimension m x n 

Let M be the matrix representation for a network N of dimension m x n. 

let 

 

for 

 

this is the number of column entries in excess of one for row i. 

Then 

 

Shared Situation Awareness 
The similarity of actor pairs based on social interaction, physical distance, and socio-
demographic data. 

Graham, 2005 

TYPE: Agent Level | Dyad Level 
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INPUT:  

• AA: interaction/communication 
• AA: physical proximity 
• AA: socio demographic similarity 

OUTPUT:  

• Agent Level:  

• Dyad Level:  

SSA consists of weighted terms of interaction between actions. 

Let 

 

Let A = Agent x Agent interaction/communication matrix 

Let P = Agent x Agent physical proximity matrix 

Let S = Agent x Agent social demographic similarity matrix 

Let e = eigenvector centrality measure computed on A 

Let G = dyadic geodesics computed on A 

Then the SSA measure between agents i and j is: 

 

Simmelian Ties 
Computes the normalized number of entities to which each node has a Simmelian tie. 

Krackhardt, 1998 

TYPE: Entity Level 

INPUT: N: square, binary, symmetric 
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OUTPUT:  

Let N be a square network with n entities. The Simmelian Tie value for entity i is 
computed as follows: 

let NS = network N symmetrized using the Intersect (Minimum) method. 

All cliques of size >= 3 are computed on NS and clique membership is recorded. Let 
be the number of entities that are in a clique with entity i. 

Then the Simmelian Ties value for emtity i is . 

Span of Control 
The average number of out edges per node with non-zero out degrees. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N: square, binary 

OUTPUT:  

let S = set of entities in V that have positive out-degree 

let 

 

Then 

 

Speed, Average 
The average inverse geodesic distance between all entity pairs. The highest score is 
achieved for a clique, and the lowest for all isolates. 

Carley, 2002 



  

 

 

2007 ORA Users Guide - Page 96 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Average Speed is the average of the Inverse Closeness Centrality for the network entities. 

Speed, Minimum 
The maximum shortest path length between entity pairs (i,j) where there is a path in the 
network from i to j. If there are no such pairs, then Minimum Speed is zero. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Minimum Speed = 1 / (Levels for the Network) 

Task Completion — 
Knowledge Based / Resource Based 
The percentage of tasks that can be completed by the agents assigned to them, based 
solely on whether the agents have the requisite knowledge to do the tasks. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AK:binary; AT:binary; KT:binary 

OUTPUT:  

Find the tasks that cannot be completed because the agents assigned to the tasks lack 
necessary knowledge. 

let 
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let 

 

Knowledge Based Task Completion is the percentage of tasks that could be completed = 
(|T|-|S|) / |T| 

Resource Based Task Completion is analogous, replacing AK with AR and KT with RT. 

Transitivity 
The percentage of edge pairs {(i,j), (j,k)} in the network such that (i,k) is also an edge in 
the network. 

NetStat 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Let G = (V,E) be the graph representation of the square network. 

let 

 

let 

 

let 

 

Then 
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Triad Count 
The number of triads centered at each entity in a square network. 

NetStat 

TYPE: Agent Level 

INPUT: N:square, binary 

OUTPUT:   for N dimension n. 

Let G=(V,E) represent a square network with n entities. 

And let Triad be a matrix of dimension n x n. 

 

Then 

 

Under Supply — 
Knowledge / Resource 
The extent to which the knowledge/Resource needed to do tasks are unavailable in the 
entire organization. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AK:binary; AT:binary; KT:binary 

OUTPUT:  

This is the number of required knowledge not available to tasks based on the current 
agent task assignments normalized by the number of tasks. 
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Knowledge Under Supply = sum(dich( KT - AK'*KT)) / |T| 

Under Resource Supply is analogous, replacing AK with AR, and KT with RT. 

Upper Boundedness, Krackhardt 
The degree to which pairs of agents have a common ancestor. 

Krackhardt, 1994 

TYPE: Graph Level 

INPUT: N: square, binary 

OUTPUT:  
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Adding and Removing Entities In The 
Editor 
The MetaMatrix Composer is accessed through ORA's main interface and allows you to 
add or remove entities and entitysets by creating or removing attributes you wish to 
associate with your MetaMatrix. An attribute is a label that you wish to give a particular 
entity and can literally be anything you wish (worker, leader, Africa, March, 1989, etc.) 
Attributes can be used to define entities and entitysets according to your specific 
descriptions. For example, if you wanted to add the attribute leader to describe several 
entities, you can go directly inside the MetaMatrix Editor and give attributes to those 
entities which you attribute the description leader. 

From ORA's main interface > "Editor" tab > Enter desired attribute 
under selected row and column for appropriate entity. 

The black ellipses below highlight how to access the MetaMatrix Editor from ORA's 
main interface. 

 

Copy / Paste Editor Values 
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Creating a new Entity Set 

There are times you need to create a new Entity Set with existing values from another 
Entity Set. For example, I will create a second Entity from the set [agent] size: 15. 

 

Select the Add New Entity Set… button. 

 

This will bring up the Create Entity Set dialog box. I give it a new name, Agent-new, 
leave the type as Agent, and set the Enter a size for the entity set to 15 in order to match 
the existing set. The select the [OK] button. 

 

A new Entity set will appear in the left panel, [Agent, Agent-new] size: 15. 

 

Go back to the original Entity set. 
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Move the pointer into the topmost cell and Left-Click. This selects the entire column of 
values. 

 

From the main menu select Edit > Copy Editor Values 

 

Re-Select the new Entity set. 

 

Move the pointer into the topmost cell and Left-Click. This selects the entire column of 
values that you want to replace. 
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From the main menu select Edit > Paste Editor Values 

 

The values are now copied into the new Entity set. 
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Creating a new {Partial} Entity Set 

There may be times when you need to create a new Entity set but only need some of the 
values from an existing set. The procedure is similar to that above. 

Again, Select the Add New Entity Set… button. 

 

This will bring up the Create Entity Set dialog box as before. But this time we'll create a 
different sized Entity set from the original. 

Give the set a new name, Agent-new-2, leave the type as Agent, and this time set the 
Enter a size for the entity set to 4 in order to match the existing set. The select the [OK] 
button. 
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The new Entity set, [Agent, Agent-new-2] size: 4 appears in the left panel. 

 

Re-Select the original Entity set. Move the pointer to the first value you want to copy. 
Move the pointer to the last value you want to copy. Press and hold the Shift key and 
Left-click the last value. 

 

Re-Select the new Entity set and Left-Click in the top cell to select all the values. 
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From the main menu select Edit > Paste Editor Value 

 

The four values form the original 15 have been copied into a new, smaller, Entity set. 

 

Analysis 

 

Generate Reports – Brings up a dialog box that enables you to choose to run any report 
on any currently active MetaMatrix then select the format you want the results. 

Report Selection Wizard – Assists you in selecting the best reports for the selected 
MetaMatrix. 

Network Optimizer – Creates new MetaMatrices based on an existing MetaMatrices 
using a particular set of measures. Use this tool to maximize one or more measures within 
your organization by changing network variables and analyze your organization under 
various scenarios. 

Measures Manager – The option allows you to choose which measures are to be used in 
generating reports for the selected MetaMatrices. The dropdown menu allows you to 
chose measures lists which divide them up into categories such as: Slow Measures, 
Critical Risk Employees, and Resource Allocation Risk. 
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Dyad Measures Tool – Use this tool to produce new graphs from existing MetaMatrices 
using specific measures. You can either create new MetaMatrices or append these graphs 
to existing MetaMatrices. 

Attribute Partition Tool – Creates new MetaMatrices using an existing MetaMatrices and 
uses attribute values to affect the result. 

Near-Term Analysis – Tool used to detect the results when a set of entities is removed 
from an existing circumstance. See Lesson 7 for more information. 

ORA Charts 
Charts 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

Three charts are available: The Bar chart, Scatter Plot, Histogram, and Heat Map. ORA 
Charts can be accessed through the Main Interface by clicking the View Charts For This 
MetaMatrix button in the MetaMatrix Composer window pane or from the Main Interface 
drop down menu. 

From the Main Menu select Data Visualization > Charts; OR 

Select the [Charts] button. 

In the screen shot below, ellipses highlight both methods to access ORA Charts. 
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After choosing Reports, the following pop-up window will appear. Select the entityset 
you are interested in Charting and select the [Next] button. For this example, we will 
simply select the currently loaded entityset Agents. ORA produces the following Bar 
Chart, displayed in the screen shot below. 

 

By now, you should be able to access ORA Charts by loading a MetaMatrix by either 
using the [Charts] button in the MetaMatrix Composer window pane or from the Main 
Menu of the main interface. See Chart Types Explained for more detailed information 
about the four chart types. 
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Chart Types Explained 

Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, and Histogram. 

ORA Bar Chart 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

A bar chart, also known as a bar graph, is a chart with rectangular bars of lengths usually 
proportional to the magnitudes or frequencies of what they represent. Bar charts are used 
for comparing two or more values. The bars can be horizontally or vertically oriented. 
Sometimes a stretched graphic is used instead of a solid bar. 
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Scatter Plot 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

A scatterplot, scatter diagram or scatter graph is a chart that uses Cartesian coordinates to 
display values for two variables. The data is displayed as a collection of points, each 
having one coordinate on the horizontal axis and one on the vertical axis. 

A scatterplot does not specify dependent or independent variables. Either type of variable 
can be plotted on either axis. Scatterplots represent the association (not causation) 
between two variables. 

A scatterplot can show various kinds of relationships, including positive (rising), negative 
(falling), and no relationship. If the pattern of dots slopes from lower left to upper right, it 
suggests a positive correlation between the variables being studied. If the pattern of dots 
slopes from upper left to lower right, it suggests a negative correlation. A line of best fit 
can be drawn in order to study the correlation between the variables. An equation for the 
line of best fit can be computed using the method of linear regression. 
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Histogram 
Charts – Charts Explained – Bar Chart – Scatter Chart – Histogram  

In statistics, a histogram is a graphical display of tabulated frequencies. A histogram is 
the graphical version of a table which shows what proportion of cases fall into each of 
several or many specified categories. The histogram differs from a bar chart in that it is 
the area of the bar that denotes the value, not the height, a crucial distinction when the 
categories are not of uniform width (Lancaster, 1974). The categories are usually 
specified as non-overlapping intervals of some variable. The categories (bars) must be 
adjacent. 

The word histogram is derived from histos and gramma in Greek, the first meaning web 
or mast and the second meaning drawing, record or writing. A histogram of something is 
thus, etymologically speaking, a drawing of the web of this something. 
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Copy / Paste Editor Values 
Creating a new Entity Set 

There are times you need to create a new Entity Set with existing values from another 
Entity Set. For example, I will create a second Entity from the set [agent] size: 15. 

 

Select the Add New Entity Set… button. 
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This will bring up the Create Entity Set dialog box. I give it a new name, Agent-new, 
leave the type as Agent, and set the Enter a size for the entity set to 15 in order to match 
the existing set. The select the [OK] button. 

 

A new Entity set will appear in the left panel, [Agent, Agent-new] size: 15. 

 

Go back to the original Entity set. 

 

Move the pointer into the topmost cell and Left-Click. This selects the entire column of 
values. 
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From the main menu select Edit > Copy Editor Values 

 

Re-Select the new Entity set. 

 

Move the pointer into the topmost cell and Left-Click. This selects the entire column of 
values that you want to replace. 
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From the main menu select Edit > Paste Editor Values 

 

The values are now copied into the new Entity set. 
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Creating a new {Partial} Entity Set 

There may be times when you need to create a new Entity set but only need some of the 
values from an existing set. The procedure is similar to that above. 

Again, Select the Add New Entity Set… button. 

 

This will bring up the Create Entity Set dialog box as before. But this time we'll create a 
different sized Entity set from the original. 

Give the set a new name, Agent-new-2, leave the type as Agent, and this time set the 
Enter a size for the entity set to 4 in order to match the existing set. The select the [OK] 
button. 
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The new Entity set, [Agent, Agent-new-2] size: 4 appears in the left panel. 

 

Re-Select the original Entity set. Move the pointer to the first value you want to copy. 
Move the pointer to the last value you want to copy. Press and hold the Shift key and 
Left-click the last value. 

 

Re-Select the new Entity set and Left-Click in the top cell to select all the values. 
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From the main menu select Edit > Paste Editor Value 

 

The four values form the original 15 have been copied into a new, smaller, Entity set. 

 

Default and Advanced Experiment Type 
The Default and Advanced Experiment Type options are relevant to both the Monte 
Carlo and Simulated Annealing Optimization methods. If you select "Default" option in 
the Network Optimizer window pane, for either Monte Carlo or Simulated Annealing, no 
further input is necessary. Simply select the Next button. If you choose "Advanced" the 
following screen appears (screen shot below) requesting parameter input respective to 
either the Monte Carlo or Simulated Annealing optimization method. 

Monte Carlo 

This screen shot below requests parameter input for an "Advanced" Monte Carlo 
Simulation. The recommended value for the Monte Carlo Experiment is between 50,000 
and 500,000. 
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Simulated Annealing 

This dialog box allows the input of the parameters for the Advanced Simulated 
Annealing optimization. 

The recommended value for Initial Temperature is around 100. 

recommended value for Temperature Coefficient is around 0.95. 
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Tip! The term "Simulated Annealing" draws its inspiration from 
metallurgy, where essentially atoms within a metal are heated thereby 
dislodging them from a metal's internal structure transforming the 
metal into another atomic state. In this way, your organization is 
"heated" changing its components in the attempt to arrive at an 
optimized state. 

Data Visualization 
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Charts – When run this function will plot the three graphs, Bar Chart, Scatter Plot, and 
Histogram on the choosen Matrix. 

Visualizer – This menu item calls up the Visualizer. 

View Measures Over Time – Requires multiple MetaMatrices. First plots points for 
measure selected on each of the Matrices active with the option to see a direct line from 
the earliest to the latest point. 

View Network Over Time – Requires multiple MetaMatrices. Displays entities and edges 
for each of the active MetaMatrices 

Drill-Down Window – Allows for quick, plotting of entities connected to a choosen 
entity. 

GIS (Geographical Information System) – Analyze, forecast, and visualize a wide variety 
of spatial interactions and networks within a global-scale. 

Loom – Works with entities moving between places over time. Requires the use of a 
trailset. 

Generate Networks 

 

Generate Networks according to predefined algorithms 

Randomize Networks 

Scrambles the edges of a graph 

Create Stylized Network 

Generates new MetaMatrices using various Mathematical formulas. 

Construct Trailset 

Coming soon 
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The GIS Visualizer 
 

Data load in ORA main window 

• Before running ORA GIS, a DynetML file should be loaded in the ORA main 
window. 

The data to visualize should be highlighted. 

 

Run ORA GIS 

• After loading data, select Data Visualization > GIS. 
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• Then, ORA will display ORA GIS window showing the geospatial distribution of 
the entities across the world. 

 

Re-center and zoom-in 

You can re-center: 

1. Changing mouse mode as a recenter mode (click the recenter mode in the toolbar) 
2. Clicking a point of the map. 

You can zoom-in and zoom-out: 

1. Changing mouse mode as a zoom-in/out mode (click the zoom-in/out mode in the 
toolbar) 

2. Clicking a point of the map. 
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Or, you can use other zoom-in/out methods in the toolbar. 

 

 

Label display and entity size 

• You can display the labels of the entities by changing the label button in the 
toolbar. 
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Entity size adjustment 

• Also, you can adjust the size of the entity by changing the entity display mode. 
You can change the entity display mode by clicking the display mode change 
button in the tool bar. 

 



  

 

 

2007 ORA Users Guide - Page 126 

• The entity size will represent the number of the entities in the region. 

 

Edge display 

• You can turn on/off edge display by selecting form the menu Display > Show 
edge. 
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Selective network display (1) 

• You can selectively display networks. First, you can hide all the displayed 
networks by selecting form the menu Display > Displayed Networks > Hide all 
networks 
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• Then, you can select the network you want to show by selecting from the menu 
Display > Displayed Networks > [who knows who]. 

 

Selective network display (2) 

• This is the result of showing only who-knows-who network and turning on the 
label display. 
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Distance network creation 

You can create a distance network among the displayed edges. 

1. Select on the menu Analysis > Show a distance network 

 

2. Set the threshold for edge generation. 

 

3. Then ORA GIS tells you how many edges are created and the created edges will 
be in the map with blue links. 
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Add general locations of interest 

• ORA GIS can show the world cities, airports and harbors. Select Display > 
Display general information > Add airports. 

 

• Then, the map will show the airports. This will give you some chance to reason 
how closely the entities are located to the important locations of interest. 
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Clip board copy of the image 

• From the menu select Display > Copy the chart in the clipboard 

 

• ORA GIS will copy the image to clipboard, so you can paste the image on MS 
Word or MS Powerpoint. 
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Entity selection 

• Change the mouse mode to entity selection mode by clicking a button in the 
toolbar. 

 

• Then, click one of the entities on the map, then you will get a popup window 
displaying the detailed information of the entity at the location. 
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Matrix Algebra 
 

The Matrix Algebra allows you to perform mathematical operations on two matrices. The 
options in ORA are addition, subtraction, and multipication. These functions help spot 
strong and weak connections within a Matrix. 

I start with one MetaMatrix loaded. 

 

From the menu select MetaMatrix Management > Matrix Algebra… 

The Matrix Algebra dialog appears. There are six areas which you can manipulate. These 
are each described below the dialog box. 
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Note: Both matrices should be the same dimensions. 

 

1. Select a MetaMatrix 

 

This dropdown menu will show all the MetaMatrices you currently have active. 
To perform a math function on a matrix, highlight it in the dropdown menu. 

2. Select an Operation 

 

This option allows you to choose which operation, Add, Subtract, or Multiply, 
you want to perform on the graphs. 

o Add: This function adds together corresponding cells of two different 
graphs. 
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o Substract: his function subtracts together corresponding cells of two 
different graphs. 

o Multiply: Multiplication is slightly different than the add or subtract. The 
number of rows in the first Matrix must equal the number of columns in 
the second. A Matrix can be multipied by itself to help reveal specific 
strong and weak areas. 

3. Select Graph 1: 

Next select the first graph you want to work with. 

 

4. Select Graph 2: 

Then select the second graph to do the algebra on. 

 

5. Add Graph: 

If you wish, you can add additional graphs to the equation. Different selections in 
the previous choices will give you different options in each dropdown. 

 

6. Enter a name for the new graph: 

When everything is set, type in the name for your new graph. 

Finally, select [OK] to create you new graph. You can then create more graphcs if 
desired. When you are done, Select [Cancel] to remove the dialog box from the 
screen. 

Your new graph will now appear in the box with your MetaMatrix. Next highlight 
the graph you just created. 
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Next, select the [Visualize Only this Graph] button 

 

You will get a warning box asking if you're sure you want to visualize only one graph. 
Select [OK] to run the Visualizer or press the red X to close the box. 

 

This will bring up the Visualizer displaying the graph. Your display will depend on the 
graph selected. In this particular example there are only Agents and Edges connecting 
Agents displayed in the Visualizer and the Legend. 
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Now we'll create a second graph. This time we'll use the multiply operation, the second 
graph will throw knowledge into the mix. 

Note: Remember to name your file something different. 

 

Highlight your newly created graph and select the Visualize Only this Graph once again 
and select OK in the dialog box. 
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This time, since a graph with knowledge was selected the Visualizer and Legend display 
both Agents and Knowledge and also the Edges connecting them all. 

 

 

 

Monte Carlo Network Optimization 
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Monte Carlo, as the name implies, is a random optimization of your organization. To 
initiate a Monte Carlo Network Optimization, first select the measures you would like to 
optimize. Note that you can select multiple measures to be optimized simultaneously. 
Graph Level allows you specify the node type: Agent, Agent; knowledge, knowledge; 
Task, Task; Resource, Resource. 

The black ellipses below highlight areas of the Network Optimizer window pane that 
enable you to customize your network optimization. 

 

After selecting the measures you want, select the [Next] button. 

The next screen presents you with the variables to choose along with the parameters for 
each. 
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Please note: In the Monte Carlo method you can specify if you would 
like to run optimization with fixed or random density, and if you want 
to keep at least one non-zero element in every row of sub-matrices. 

 

After making your selections select the [Next] button. 

Specify the location for the data log file, without specifying an extension. 

Select the [Browse] button(s) to select the directory you want to save 
the file(s). 
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After selecting the destinations for your files select the [Finish] 
button. 



  

 

 

2007 ORA Users Guide - Page 143 

 

 

 

 

 

View Measures Over Time 
 

Using the View Measures Over Time on a MetaMatrix allows you to see the affect over 
multiple MetaMatrices. 

In this example I start out with three MetaMatrices loaded. 

 

From the main menu select Data Visualization > View Measures Over 
Time 

 

A dialog box will appear stating it will run on the currently loaded MetaMatrices. If you 
have any MetaMatrices you do not want in the calculation nit [Cancel] and remove them 
from Panel 1 before proceeding. 

Once you have the MetaMatrices you wish to work with active, select [OK]. 
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The View Measures Over Time box will appear. It consists of three sections: 

1. Set Aggregation Level – A slider allowing you to choose between plotting all 
Matrices or just the beginning and end points. 

2. The Measures selection tabs – Choosing a particular tab will reveal the measures 
that are capable of being run on that particular entity. 

3. The Time / Value charting area – The area in which the plots will be plotted. 

 

In this example I set the Aggregation Level to 1 and chose Clustering Coefficient. 

The program then plotted the three points form the three MetaMatrices I had loaded, 
tanzaniz_3, tanzaniz_4, and tanzaniz_5. 
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Moving the pointer to Aggregation level 2 draws a line form the beginning value to the 
ending value. 
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Mental Model Reports 
Single condensed files - per chunk, where a chunk is N days prior to or posterior to an 
event, excluding the day of the event 

Number of concepts - Number of words (frequency count per email) Carley and Kaufer, 
1993 

Number of isolated concepts - Number of words that were coded as knowledge items, but 
did not get linked into statements Carley and Kaufer, 1993 

Number of statements - Number of edges (frequency count per email) Carley and Kaufer, 
1993 

Density - Density of semantic network Carley and Kaufer, 1993 

Set-Theoretic and qualitative (word-level) comparison of maps from before and after 
event  

Concept Analysis - Concepts are classified according to whether they have high and low 
values for the measures: total degree centrality, betweenness centrality, and consensus. 

  

 

Allusions - high degree, low betweenness, low consensus Carley and Kaufer, 1993 

Buzzwords - low degree, high betweenness, low consesus Carley and Kaufer, 1993 

Emblems - low degree, high betweenness, high consensus Carley and Kaufer, 1993 

Factoids - low degree, low betweenness, high consensus Carley and Kaufer, 1993 

Ordinary Words - low degree, low betweenness, low consensus Carley and Kaufer, 1993 

Placeholders - high degree, high betweenness, low consensus Carley and Kaufer, 1993 

Stereotypes - high degree, low betweenness, high consensus Carley and Kaufer, 1993 

Symbols - high degree, high betweenness, high consensus Carley and Kaufer, 1993 
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Mental Model Reports Bibliography 
• Carley, Kathleen & Kaufer, David. (1993). Semantic Connectivity: An Approach 

for Analyzing Symbols in Semantic Networks. Communication Theory, 3, 183-
213. 

• Wasserman, S., & Faust, K.. Social Network Analysis: Methods and Applications. 
New York and Cambridge, ENG: Cambridge University Press. 

• Watts, D.J., Strogatz, S.H.(1998) Collective dynamics of 'small-world' networks. 
Nature 393:440-442. 
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Edit Menu 

 

Copy Editor Values / Paste Editor Values 

Used to create New Entity sets. The sets created can be identically sized (allowing you to 
paste an entire column in) or a smaller, subset allowing you to choose only a portion of 
the original set. 

Copy MetaMatrix / Paste MetaMatrix 

Used for quickly creating duplicate MetaMatrices to work with so your original Matrices 
remain unchanged. 

Preferences 

Contains settings for controlling the environment for working within ORA. 
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File Menu 

 

Open MetaMatrix 

This item opens up a single MetaMatrix with the following formats: 

Dynetml (the native ORA xml format), .dl, .##h (UCINet), .CSV (comma separated 
values, Excel spreadsheet out), .txt (text files), .raw, .net (Pajek), .graphml, .stl (GMU 
model), .lo (pathfinder) 

Data Import Wizard 

This item contains additional options for importing MetaMatrices such as multiple file 
importing. 

Import Database 

An advanced feature for importing a database. 

Import Attribute File 

It is used to add an attribute into a file. The file selected must be in the CSV format. 

Open Workspace 

You may open an entire workspace that you were previously using. A workspace consists 
of a set of MetaMatrix files that were all open at the same time, and saved as a 
workspace. 
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Save MetaMatrix As… 

Save the changes you've made in a MetaMatrix under a new filename. 

Save Workspace 

Save all active MetaMatrices into a Workspace which can be opened up at a later date. 

Network Format Converter 

The Network Format Converter takes files from one format and convert it to an ORA 
format. 

CSV Table Converter 

Convert a .csv file into an ORA format. 

Exit 

Close the program and leave 

 

 



  

 

 

2007 ORA Users Guide - Page 152 

 

 

 

 

 

MetaMatrix Management 

 

 

These sets of menu items enable you to control the addition or removal of MetaMatrices, 
Entity Sets, and Graphs as well as adding Attributes to an Entity Set. 

The Matrix Algebra and MetaMatrix Transform also create new Matrices, Sets, and 
Graphs but do it with Mathematical operations. 

MetaMatrix Algebra… – Enables you to perform mathematical operations on two 
MetaMatrices. 

MetaMatrix Transform… – Tools which enable you to clean up a Visualizer display 
making it easier to read. 

MetaMatrix – Used for adding or removing MetaMatrices from use. 
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Entity Set– Enables you to add an Entity Set, remove an Entity Set, change an Entity Set 
size, or Add an Attribute to an existing Entity Set. Depending on what you have selected 
different options may be greyed out. 

Graph – Similar to Entity Set only working with Graphs. Enables you to either add or 
remove a graph. 

This also enables you to Set the Diagonal of a graph to either -1, 0 or +1. Useful for 
setting consistent values on an agent-by-agent graph. 
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Matrix Transform 
 

On some occasions the display in the Visualizer is too cluttered to make sense of. But 
there are ways to clean up the display in order to make it easier to view your data. 

In the main menu select MetaMatrix Management > MetaMatrix 
Transform… 

 

The MetaMatrix Transform dialog box will appear. It consists of two sections. The top 
section allows you to pick the MetaMatrix to work with. The bottom sections allows you 
to select how you data will be transformed. 
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From the top section dropdown you can select which MetaMatrix you want to work with. 
It will list all the Matrices you currently have active. 

 

Transformations 

Dichotomize with Edges 

Dichotomize with Edges will turn valued data into binary data. First choose the type of 
measurement to determine your break point, lessThan, lessThanEquals, equals, 
greaterThanEquals, or greaterThan. Then input a value to use. By setting the 
dichotomizing value you can turn the value of the edges into a representation of the 
absence of presence of an edge. 
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Symmetrize by Method 

Symmetrize is a tool that is used to turn directed or asymmetric network data into un-
directed or symmetric data. All three methods use a pair of values from the upper and 
lower portions of the table (e.g. cell 1, 3 is compared to cell 3, 1) 

• Maximum Compares the values and uses the larger of the values. This is using the 
strongest value 

• Minimum Similar to Maximum only it uses the lower, or weaker, value. 
• Average takes the two values and averages them. 

 

Create partition graphs by attribute: 

This partitions the entity set according to the values of the specified entity attribute and 
then creates a collection of new graphs based on the partitioned entity set. 

This kind of grouping is often done in network analysis to understand how some sets of 
entities are embedded in various social roles or how they interact within larger entities. 

Example, if you have an Agent entity set that has a gender attribute for each entity that 
takes on values male and female, then using this feature four new Agent x Agent graphs 
would be created that contained edges from males to males, males to females, females to 
males, and females to females. No new entity set is created and no data is changed. 
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Create union matrices 

This creates new graphs that are the union of all graphs of the same type. 

Example, if the meta-matrix had two Agent x Agent graphs, then using this feature a new 
Agent x Agent graph would be created that was the union of the two. 

 

Remove Isolates 

Selecting this checkbox will remove any isolates from the Visualizer. 

 

Remove Pendants 

Selecting this checkbox will remove any pendants from the Visualizer. 
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View Network Over Time 
The View Network Over Time allows you to set up multiple Matrices that encompass 
various time frames and view them in succession. First, make sure you have two or more 
MetaMatrices active in the leftside panel. 

 

Now select form the menu Data Visualization > View Network Over 
Time 

 

This will bring up the Visualizer along with the Time Viewer window. At the start the 
pointer starts at the first position. You can see in the blue ellipse that hum is connected 
singularly to file. 

 

Moving the pointer to the second position you can see that hum is no longer connected to 
file but it still connected to another entity inside the cluster. 
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Moving the pointer to the third position causes hum to become a completely isolated 
entity. file is still connected to the cluster. 
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The Network Optimizer 
 

The Network Optimizer is a tool to maximize one or more measures within your 
organization. You can use this tool to change network variables and analyze your 
organization under various scenarios. 

First, make sure you have a MetaMatrix loaded. Next, start up the Network Optimizer. 

From the Main Menu select Analysis > Network Optimizer 

 

This will bring up the Network Optimizer wizard interface. Below is a screen shot of the 
Network Optimizer Interface. 
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Select the MetaMatrix you wish to optimize. You can choose from any MetaMatrix you 
have loaded into the MetaMatrix Manager. In this example, we will use the MetaMatrix 
embassy_tanzania_ct2.xml. 

Choose Experiment Type 

 

Default will make the optimum selections for you. 

Advanced allows you to select various options. 

Optimization Method 
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Monte Carlo creates a totally random network optimization based on a variety of 
variables. After selecting Monte Carlo, select the [Next] button. 

Simulated Annealing allows for a more structured network optimization. Simulated 
Annealing requires a selection of certain variables that will run your network 
optimization in a more structured manner. 
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Preferences 
 

Setting up your environment 

The ORA preferences allow you to group Reports and set of files to open automatically. 

Reports 
Reports – Export Settings – Datasets  

From this window you can Rename and Restore report names, Export settings for 
automatic loading, and Import previously created load sets. Below is the default 
preference window. 
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To rename a report Right-click on the name. A small box will popup, Rename this 
Report. If you wish to rename this report Left-click the box. 
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A dialog box will appear. Enter the name you want to rename the choosen report. 

 

In this case I chose the name fizzbin. 

 

To rename the report select OK. The report formerly known as Change in Key Modes is 
now know as fizzbin. 
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Now say you wish you hadn't renamed all those reports cause a name like fizzbin really 
doesn't make much sense. Select the button marker Reset report names. A dialog box will 
appear asking if you want to reset your report names. 

Note: Resetting report names reset ALL report names! 

 

Now all your reports names are back to their defaults. 

 

Now let's say that you know that you don't need ever single report to show up in the 
program. You can set which reports are visible and hidden. By unchecking the box to the 
left of the name the report will be invisible to the program. 
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Export Settings 
Reports – Export Settings – Datasets  

After you've finally decided which reports you want visible (and invisible) and what you 
want all your reports to be called you can save this setting for future reference. So even if 
someone else changes report names or visibility settings you can call your personnel 
setting up and quickly resume your work. 

First select the Export Settings button at the bottom of the dialog box. This will bring up 
a second dialog box. Select OK to confirm this is the action you wish. If not, select the X 
in the top-right corner. 

 

This will bring up a Save dialog box. Type in the name you want to save your settings at 
and select Save 
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So the next time you start up the program and names and settings have been changed you 
can select Import Settings, navigagte to the directory you saved you Settings file and 
have ORA reset the nanmes and visibility settings. 

 

Save this file in a place you remember so you can call up your settings quickly. 
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Data Sets 
Reports – Export Settings – Datasets  

This dialog box controls what MetaMatrices will load up during startup. There are three 
options. 
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1. Do not load any files at startup 

 

2. Restore previously loaded workspace 
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3. This option is a little more complicated. 

First select the Load specified files below radio button. Then select the Add Files button. 

 

The Open dialog box will appear. Navigate to the directory of the files you want to 
automatically open. Select one or more files. In order to select more than one file press 
and hold the Ctrl key while selecting multiple files. You will see them appear in the File 
name text field. When you have selected all your files select the Open button. 
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In the Ora preference dialog box the files you selected will appear under the Add Files 
button. 
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If at some time in the future you wish to delete one or more of the files you selected from 
automatically opening up on startup you can clear multiple files form the list. Select one 
or more files (pressing and holding the Ctrl key for multiple files. Then select the OK 
button. 

 

You will be prompted to confirm your choice. 

 

If you selected Yes then the selected files will be removed from the list of files to load at 
startup. 
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Randomize Existing Network 
 

A random graph is obtained by starting with a set of n entities and adding edges between 
them at random. Different random graph models produce different probability 
distributions on graphs. 

Creating a Random Graph 

This function randomizes the edges in a MetaMatrix 

 

From the menu select Generate networks > Randomize Existing 
Network 

 

The dialog box and form the drop down menu select the MetaMatrix you want to 
randomize. 
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In leftside panel a new MetaMatrix will appear named after the selected Metamatrix and 
denoting it has been randomized. 

 

First, return to the original MetaMatrix and select a graph. Here I selected the agent x 
agent graph. 

 

And select the Visualize Only this Graph. 

 

You will get a visualization of the agent x agent graph. 
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Now select the newly created randomized MetaMatrix you just created. Select the same 
agent x agent graph as per the original MetaMatrix. 

 

And again, select the Visualize Only this Graph. 

 

As shown in the Visualizer the edges have been randomized. 
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ORA Reports 
 

Reports 
Reports – Reports Explained  

Reports are one of ORA's core functions, which also include the Visualizer and Chart 
tools. You can access ORA reports from the main interface drop-down menu bar or from 
the Reports button, which should appear in the right panel of the main interface after you 
have loaded a MetaMatrix. 

From the Main Menu select Analysis > Generate Reports; or 

Select the [Reports] button 

The red ellipses on the screen shot below highlight how to access ORA Reports from the 
main interface. 
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ORA Reports provide a computational tool to analyze data that comprise a network as 
representated by a MetaMatrix or MetaMatrices. They are driven by a variety of key 
measures proven useful to researchers in the analysis of networks. 

Reports Explained 
Reports – Reports Explained  

All Measures - Runs a collection of measures and categorizes the output according to risk 
categories. Each category analyzes a particular aspect of the Meta-Matrix structure. 

Belief - The Belief report contains the most common beliefs shared by most people, the 
beliefs with the highest GINI coefficient, the most strongly held beliefs, the most likely to 
change beliefs, the most neutral individuals, and the most opinionated individuals. 

Capability - This report is used to assess an individuals' and organizations' capability to 
perform tasks. 

Change in Key entities - Analyzes the changes over time of the agents that score the 
highest in measure values. 

Communicative Power - Analyzes one or more mental map models, classifying concepts 
according to their values for selected measures. 

Communicators - Analyzes the communication network (agent by agent) and gives high 
level statistics on its structure. 

Complete - Computes all network analysis measures. 
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Context - Compares measured values against various stylized forms of networks in an 
effort to characterize the networks topology. 

Core Network - Computes the core network and reports general statistics. 

Drill Down - Computes the drill down from a selected organization and then to a selected 
agent 

Event Analysis - Computes the central events with respect to other network entities. 

Group Talk - Analyzes the relationships between agent and knowledge. 

Immediate Impact - Computes the key actors of a network, and then isolates them 
individually to determine the effect on measure values. 

Influence Net - Displays the influence network and gives high level statistics on its 
structure. 

Intelligence - Identifies key entities and groups who by virtue of their position in the 
network are critical to its operation. 

Located Subgroups - Identifies the subgroups present in the network using various 
grouping algorithms. 

Location Analysis - Computes the central locations with respect to other network entities 

Management - Identifies over and underperforming individuals and assesses the state of 
the network as a functioning organization. 

Potential Errors - Detects potential errors in agent to agent interactions based on the 
expected interactions from cognitive similarity and expertise. 

QAP Analysis - Computes QAP Correlation and Regression (Dekker and Y-Permutation 
methods) on input matrices. 

Semantic Network - Analyzes one or more mental map models, computing the central 
graphs and key concepts and statements. 

Shortest Path - Computes the shortest path between two entities and general statistics on 
the paths. The Sphere of Influence on each entity is also computed. 

Simmelian Ties Analysis - Calculates the number of Asymmetric, Sole-Symmetric, and 
Simmelian ties in all Agent by Agent and Organization by Organization graphs and 
computes the standard measures on them. 
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Sphere of Influence - For each individual, identifies the set of actors, groups, knowledge, 
resources, etc. that influence and are influenced by that actor. 

Standard Network Analysis - Calculates the standard network analysis measures (degree 
centrality, betweenness, centrality, etc.) 

Trails - Analyzes the trails that an entity class makes through another entity class; for 
example, how vessels pass through ports.  

Version Test - Recomputes the measures contained within the DyNetML file and 
compares them with the existing measures. This is a diagnostic tool. 
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Simulated Annealing Network 
Optimization 
 

Select the measures you would like to optimize. Note that you can select multiple 
measures to be optimized simultaneously. Graph Level allows you specify the node type 
(Agent, Agent; knowledge, knowledge; Task, Task; Resource, Resource). The black 
circles below highlight the areas of the Network Optimizer window pane that allow you 
to customize your network optimization. 
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After you have selected the measures you are interested in 
optimizing, select the [Next] button. 

Choose the sub-matrices that to be varied during the optimization process. If you chose 
Monte Carlo method you should also specify if you would like to run optimization with 
fixed or random density, and if you want to keep at least one non-zero element in every 
row of sub-matrices. 

 

Select the [Next] button 

Then choose the optimization criterion: Sum or Product. 
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Select the [Next] button 

Specify the location for the data log file, without specifying an extension. Select Verbose 
if you want to analyze the whole process of optimization. 

 

Select the [Finish] button 

The data log file will be displayed in the bottom panel of the main ORA Main Interface 
window. 
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The ORA Visualizer 
 

The ORA Visualizer renders a MetaMatrix graphically. You can interact with your data 
in a variety of ways: remove key actors, isolate certain links, or focus on any particular 
relationship by using tools such as the Path Finder and grouping algorithms. 

Below is a visualized MetaMatrix of the al Qaeda terrorist network believed to behind the 
1998 U.S. Embassy bombing in Dar es Salam, Tanzania. In this example, red squares 
denote actors; light blue triangles denote resources; green pentagons denote knowledge 
bases; and blue pentagons denote tasks. The shapes are called entities. The colored lines, 
which link entities together, represent a connection or direct relationship to each other. 
The terms edge, tie, and link are used interchangeably to describe these connections. 

Actions 
The contains a description of the functions of the Action Menu: 
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: 

Hide Isolated Entities : Remove any entity which has zero edges connecting it to other 
entities. 

Hide Pendant Entities : Remove any entity which has only one edge connecting it to 
another entity. 

Recursively Hide Pendants : This function will run the both the Hide Pendant routine 
until there are no more Pendants. 

Recursively Hide Pendants and Isolates : This function will run both the Hide Pendant 
and Hide Isolate routines until there are no more Pendants or Isolates. 

Show All Entities : Any entities that were previously hidden will be revealed. 

Show All Entities Except Isolates : Reveal any entities that were previously hidden with 
the exception of entities that have no edges connecting them to another entity. 

Set Title : Allows the user to specify a title for the Visualizer picture. Useful for creating 
slides that need a labeled picture 

 

Reset Entities Color and Size : If colors and sizes have been changed this option will 
reset them to the defaults. 
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Color Entities by Components : This computes the components of the visible network 
and then color codes the entities according to which component it is in. A component is a 
single piece of a network whereby any two entities in a component are connected by a 
sequence of edges. 

Color Entities by Newman Grouping : This computes the Newman algorithm on the 
visible network and then color codes the entities according to which Newman group it 
belongs. 

Color Entities by CONCOR Grouping : This computes the CONCOR algorithm on the 
visible network and then color codes the entities according to which CONCOR group it 
belongs. 

Each pair of actors is correlated then each row extracted and correlated with each other 
row. Shows how similar is the vector of similarities of actor X to the vector of similarities 
of actor Y? Repeat this process over and over. The elements are iterated correlation 
matrix converge on a value of either +1 or -1. 

CONCOR then divides the data into two sets on the basis of these correlations. Then, 
within each set (if it has more than two actors) the process is repeated. The process 
continues until all actors are separated. The result is a binary branching tree that gives 
rise to a final partition. 

Color Entities by Attribute or Measure : This allows the user to select a entity attribute 
and color code the entities according to its value for the attribute. 

For Attribute: If each entity contained the race attribute, then entities that had an attribute 
value of hispanic would be one color, those with value white would have another color, 
etc. 

For Measure: The user selects a measure to compute on the visible network and then the 
entities are sized according to its value for the measure. 

Note: All of the operations are on the visible network, that is, 
whatever entities and edges are currently displayed in the Visualizer. 

Size Entities by Attribute or Measure : Allows the user to scale entity sizes based on a 
measure or entity attribute. Measures are run on the visible network. 

 

Compute FOG Groups : The ORA Visualizer can locate FOG Groups within your 
MetaMatrix. FOG (Fuzzy Overlapping Groups) indicates entities that can belong to 
groups with various strength and the likelihood those entities will participate in events 
associated with that group. 
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Compute Standard Measures for Visible Network : Computes the following collection of 
measures on the visible network: Total Degree Centrality, Betweenness Centrality, 
Eigenvector Centrality, Cognitive Demand, Resource Exclusivity, T ask Exclusivity, 
Knowledge Exclusivity. The measure values can then be viewed within the Entity Status 
Window. 

 

Run MDS Layout : This runs an alternative layout algorithm which determines how the 
entities and edges are displayed on the screen. It uses a Multi-Dimensional-Scaling 
algorithm. This can sometimes create better layouts than the default. But it takes longer to 
run. 

Run Tree Layout : Displays the current visible network as a Bayes Network. 

 

 

Compute FOG Groups 
FOG Group Basics 
Basics – Example  



  

 

 

2007 ORA Users Guide - Page 190 

The ORA Visualizer can locate FOG Groups within your MetaMatrix. FOG (Fuzzy 
Overlapping Groups) indicates entities that can belong to groups with various strength 
and the likelihood those entities will participate in events associated with that group. 
Overlapping occurs when individuals belong to many groups simultaneously, so that the 
groups share members. To access the ORA Compute Fog Groups you must first be 
working in the Visualizer. 

From the Visualizer drop-down tool bar: Actions > Compute FOG 
Groups 

The red circle below highlights how to access the Compute FOG Groups function. 

 

FOG Group Example 
Basics – Example  

Using the Embassy.xml MetaMatrix, we will use the Compute FOG Group function to 
determine FOG groups within our network. 

1. Load in the Embassy.xml MetaMatrix 
2. Then access the Compute FOG Group function from the Visualizer drop-down 

tool bar. The red ellipse below highlights where to find the Compute FOG Group 
function. 
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Click Compute FOG Groups 

The following Group Viewer selector box will appear. The yellow ellipse show the 
Group Viewer box. By default, the selector box will be set to "1" 

The first FOG Group will be displayed, denoted in the screen shot below as the purple 
square in the smaller yellow ellipse. 
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Select the number of FOG Groups to compute. 

In this example, we will change the selector to "2" Notice the changes in the Visualizer. 
The screen shot below displays the Embassy.xml MetaMatrix with the Compute FOG 
Group with two groups. 
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Two FOG Groups are displayed, denoted in the yellow ellipses in the screen shot above. 

By clicking on any individual FOG Group you can access the Entity Status Box (shown 
above). This will list that FOG Groups Attributes, Measures, and Neighbors. 

Finally, below is a screen shot with the Compute FOG Groups selector set to "4" using 
the Embassy.xml MetaMatrix as an example. 
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Creating A Meta-Entity 
A Meta-Entity contains multiple entities collapsed into one. You can create Meta-Entities 
based on the entitysets in your organization, or you can create MetaN-Entities based on 
the attributes of the entities. To create Meta-Entities, you must access the Meta-Entity 
Manager. There are two ways to do this: 

1. From the drop down menu > Tools > Meta-Entities 
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2. from the Visualizer tool bar 

 

In the screen shot below Meta-Entities were created for the attribute Nationality of our 
Agent by Agent MetaMatrix graph. The Visualizer itself, shows your condensed 
visualization. All the entities, which share the same attributes, are now groped into Meta-
Entites. 

 

To view what is contained in one of the meta-entities, right-click an entity to bring up the 
contextual menu and highlight Expand Entity.  

 

Whatever entities were contained inside the Meta-Entity will be revealed. In the example 
only one entity was revealed. 
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Drill Down Wizard 
With the ORA Drill-Down Wizard you can quickly visualize ego networks by overall 
entity class (knowledge, tasks, resources, agents) or by choosing individual nodes from a 
checklist. The ORA Drill-Down Wizard is only accessible through the Visualizer: From 
the ORA Visualizer Main Menu select Tools > Drill Down 

 

The following window box will appear. 
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The top sections allow you to choose the entities for use. The bottom tabs allow for 
choosing specific entities within a set. 
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Drill Down Wizard Example 
Using the Embassy MetaMatrix, we will render the various entity classes using the Drill-
Down Wizard Tool. The screen shot below displays the Embassy MetaMatrix as it should 
first appear in the Visualizer. 

 

From the Main Menu select Tools > Drill Down. 

This will bring up the Drill Down dialog box as shown below). 
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Here, select the entity class Knowledge by selecting the Knowledge check mark box. The 
screen shot below, displays the end result that you should now see in the Visualizer. 
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Next, with the Knowledge entity box checked, add the entity class Task. The screen shot 
below displays the end result. 
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Next use the search bar feature of the Drill-Down Wizard to narrow the search. 

Enter the word Bombing in the Visualizer search field below. Then select the check box 
on the bombing row. The screen should now reflect your new search parameters. 
Everything not associated with bombing has been turned off. 

 

Drill Down Wizard Explained 
The ORA Drill Down Wizard can be broken down into three primary sections of input: 

1. Section 1: enables you choose individual entity sets or combination of entity sets 
to display in the Visualizer. 

2. Section 2: of the Drill Down Wizard enables you to search for a particular entity 
within your MetaMatix. This can be handy when you dealing with large entitysets 
and the one you are interested in finding is not easily located. 

3. Section 3: enables you check mark an individual entity within your MetaMatrix 
by entity class if so desired. 
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Hide Edges With Weight 
At times you will want to view the Visualizer with just the more weighted edges 
displayed. You can select to hide edges either Less Than or Greater Than a certain value. 

 

For this example we'll keep the Less Than option. 
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• In the example below both confession and propaganda have a connection weight 
to bin_laden of 1.0. 

• belief has a connection weight to bin_laden of 2.0. 

 

Increasing the edge weight to 1.1 will hide every edge less than that, namely confession 
and propaganda. 

 

belief, with an edge weight of 2.0, remains connected to bin_laden but the edges for 
confession and propaganda are now hidden (along with most of the other edges). 
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Entity Status 
Entity Status Window 
Window – Example  

The Entity Status Window is selected by default. It first pops-up when you select any 
entity in the Visualizer. This window provides you with a snapshot of the currently 
selected entity by displaying that entities unique Attributes, Measures, and Neighbors. 

Below is a screen shot of the Entity Status Window. By un-checking the box Show this 
window when a entity is selected, the entity Status Window will cease to appear when 
clicking on entities within the Visualizer. 
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Attributes are descriptions you may or may not have given to particular entity or 
entitieset in your network. 

Measures describes computational functions in which the entity is directly involved. A 
more complete description can be founc under ORA Measure. 

Neighbors are entities that share an immediate link to the entity selected. 

Entity Status Example 
Window – Example  

Using the Embassy MetaMatrix visualization, select the entity media consultant 
highlighted in the following screenshot with the red circle. 

 

The screen shot below displays the result. You will see that the entity media consultant 
has two neighbors, Usama Bin Laden and Khalid al-Fawwaz. 
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Tip! If you are more interested in using other functions within the 
Visualizer, such as the Path Finder, deselect the Entity Status option to 
un-clutter your visualization. 

Group Viewer 
The Group Viewer helps separate entities into distinct groups. Take the starting view 
form the Visualizer. Not much can be discerned from this rather jumbled view with all of 
the entities choosen. 

There are five group which can be called up: CONCOR, Newman, Johnson, FOG, and K-
FOG 
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When you first call up the Visualizer every entity is listed and displayed on screen. At 
first glance, not much can be discerned. 
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One way is to visualize one of the graphs. Highlight one of the graphs you want to view 
in difference groups. 

 

Then Select Visualize Only this Graph 

 

We now have a much more manageable display. 
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Select from the Menu Tools > Group Viewer 

 

Which calls up the Group Viewer dialog box. First let's see what happens with the 
CONCOR options. Select [Compute] to activate the grouping. 

 

The default is one group with all visible entities connected to the center 
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The dialog box, increase the Select a number of groups to see: to 2. 

 

Now displayed are two groups. On the left most of the knowledge entities are connected 
to two agents, bin_laden and mustafa_fadhil. The group on the right consists of the 
remaining agents combined with a few of the knowledge entities. Notice that the 
knowledge driving_expertise is one of the knowledge entities on the right. 

 

Now change the group to Newman and select [Compute] and increase the Select a 
number of groups to see: to 2. 
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Once again we see two groups but the division is different. The left group contains all the 
knowledge entities except driving expertise. And now there are fewer agent entities 
connected to this knowledge. 

 

Now change the group to Johnson and select [Compute] and increase the Select a number 
of groups to see: to 2. 

 

driving_expertise is still the only knowledge in the right group but notice that now there 
is only one agent connected to it, mustafa_fadhil. Looking back, he was connected to 
driving_expertise in Newman but not CONCOR. 
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Hyperbolic View 
The Hyperbolic function creates a bulge within your visualization adding a sense of 
depth. By moving the slider from right to left, you can increase or decrease this bulge 
effect and create different depth-added views. The Hyperbolic radio button and slider can 
be found at the bottom of the window. 
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Note : The Hyperbolic function, when selected, converts the slider to 
this feature. This is also true of using the zoom and rotate functions. Use 
all three in conjunction to get your visualization just the way you want 
it. Scroll down below this screen shot for another when viewed with the 
Hyperbolic feature. 

 

In the screen shot below, black ellipse highlights the effect of adding the Hyperbolic 
View to a visualization. Compare the slider positions and visualizations in both screen 
shots to examine this subtle effect. Of course, the best way to become familiar with the 
Hyperbolic view is to simply experiment within the Visualizer itself. 
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Note : It is useful to use this tool in conjunction with the Rotate and 
Magnify tools to obtain just the view you desire. 

Removing Isolates 
To further simply a visualization, it may prove useful to remove isolated entities from the 
visualization. Isolated entities are entities not directly linked or connected to other 
entities, which share direct ties with each other. In the screen shot below, the red ellipse 
highlights an isolated entity which needs removed. 
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Select from the Main Menu: Actions > Hide Isolated Entities. 

 

In the screen shot below, after removing isolated entities, the visualization is further 
simplified.  
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Adding And Removing entities In The 
Key Set 
The ORA Key Set Selector allows you to determine which entities are visible in the 
Visualizer. The Key Set Selector is accessible through the ORA tool bar. 

From the ORA menu choose Tools > Key Set Selector 

 

This will bring up the following dialog box in which to make your selections. 
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Above is a screen shot of the Key Set Selector accessible through the ORA Visualizer 
tool bar. The red rectangles show the primary areas of the Key Set Selector, which enable 
you to hide and add entities to your visualization. Note the green checkmarks along the 
first column. These checkmarks indicate exactly which entities within your visualization 
are selected. The button within the Visualizer Commands section of the window pane, 
allow you to view your visualization by Show Only Selected or Show All But Selected. 

Furthermore, Visualizer Commands allows you to Add Selected, Remove Selected, and 
Create Meta entities. 

Note: The difference between Showing and Adding and conversely 
Show All But Selected and Remove Selected. 

Essentially, when you add you are literally adding entities to your visualization versus 
showing, which is displaying entities already part of the current visualization. 



  

 

 

2007 ORA Users Guide - Page 218 

The Node Title Row, highlighted by the middle red rectangle on the screen shot below, 
allows you filter entities in your visualization. To view only the entities in your 
visualization that contain a certain attribute, which you are interested in examining, you 
can turn the filter on by clicking the drop down tab in the row immediately following the 
Entity Title row (Scroll for another screen shot of filtering the current MetaMatrix using 
attribute 1 from the Key Set Selector column heading). 

In the screen shot below, note that using the filters we selected under attribute 1 the 
attribute 1988 from the drop down menu. A black ellipse highlights that by selecting this 
attribute, 4 out of 611 entities contain that attribute. By clicking Show Only Selected the 
ORA Visualizer will render these four entities. Note that the green check marks in the 
first column have been unselected. Only the entities that shared the 1988 attribute will be 
selected. If you scroll down this column, those entities will turn up as selected. By 
clicking Show All But Selected the ORA Visualizer will render the MetaMatrix without 
the four entities containing the attribute 1988. Other filters can be used to create a variety 
of visualizations correlating any attributes that you are interested in examining. Note also 
that you will note be able to add attributes directly into the Key Set Selector. This must 
be done in the MetaMatrix Editor (See Adding and Removing entities In the Editor to add 
attributes). 

 

By clicking the Show Only Selected button in the Visualizer Ket Set Commands, the four 
entities, which contained the attribute 1988, will appear in the Visualizer. You can see 
that these entities share no direct ties. 
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Show / Hide Labels 
Entity labels, which often prove helpful in describing entity points, can sometimes clutter 
a visualization. Thus, it may be necessary to eliminate labels from your visualization. The 
following procedure will help clarify the screen when it is clouded by the many labels. 

To remove labels go to Visualizer tool bar and select Show Labels 
button. 

The red circle highlights where to find the Label Button on the Visualizer tool bar. 

 

This initial screen shot shows the Visualizer with all the labels. 
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When you click the Label button on the Visualizer tool bar ORA removes all labels. In 
the screen shot below, our example above has the labels removed. Note that now a much 
more clearer conceptual picture of the network is produced. 
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Legend 
The Legend box allows you to quickly hide and reveal entities and edges in the 
Visualizer. Placing a mark in the checkboxe will make an element visible. 

When you start the Visualizer up all the boxes will contain checkboxes. 
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And in the Visualizer all entities and edges are revealed. 
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By using the Legend checkboxes you can selectively hide entities and edges. Deselect the 
checkbox to the left of [agent]. Notice in the Visualizer that all of the Entities marked as 
agents are now hidden, along with any connections they had with the rest of the entities. 
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Then Selecting and Deselectin various checkboxes will affect what is displayed on the 
screen. Here we've reselected [agent] and deselected [event, manual_event], [knowlegde], 
location, manual_location], and [resource]. In the Visualizer only [agent] and [task] 
remain visible and connected. 

 

 

Next Reselect all the entities and Deselct all edges except knowledge x task. Most of the 
entities are now disconnected except the few that contain knowledge x task edges. 
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In the screenshot below the two red circles show the only two groups that remain 
connected. By removing the checkmarks from all but the knowledge x task edges only 
two groups remain. 
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Options 

 

Show Weight Edges – Toggles whether the weight of various edges is displayed. 

Show Self-Loops –  

Edge Color – Options for coloring the edges. 
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Show Mouse Overs –  

Entity Style –  

 

Black and White Only –  

Background Color – Changing the background color changes it in both the Visualizer and 
the Legend. 

Beware: Some of the possible background colors can make it difficult to 
view the Visualizer. Your best choice is white. 

 

Background Image – Allows you to chose a .jpg, .gif, or .png to use as a background. 
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Color Entities from Color Attribute –  

The Path Finder 
Path Finder Basic 
Basics – Examples  

The Path Finder allows you to focus or drill down on a particular entity, or multiple 
entities, that you may be interested in analyzing in greater detail. This is accomplished 
within the ORA Visualizer by using the Path Finder tool, accessible from the Visualizer 
menu. The Path Finder creates an Ego Network for any particular entity or selection of 
entities and can show you how entities are connected. 

An Ego Network, or Sphere of Influence, is essentially a visual representation of a 
selected entity and its relationship to its immediate neighbors, or other entities, within the 
network. Each direct tie between an entity and its neighboring entities in a network is 
referred to as a path. Path length is the number of ties that separate any two entities. 
Multiple entities can be used by the Path Finder for comparing Ego Networks. 

From the Main Visualize Menu select Tools > Path Finder 

 

After selecting the Path Finder, the following dialog box will appear. 
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From this dialog box you select which entities you want to use, then select the two 
entities from the tabs at the bottom. 

Path Finder Example 
Basics – Examples  

In this example, we are working with the MetaMatrix embassy_bombing. Below in an 
example of this MetaMatrix as it first appears in the Visualizer. We will now attempt to 
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find the path between the agent entity Abdal Rahmad and the knowledge node Media 
Consultant. We will now connect the circled entities in the Visualizer. 
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From the Main Menu select: Tools > Path Finder 

 

To filter out any extemporaneous edges, select the Filter "Extra" Edges 
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Now select the entity sets you wish to use to connect the two entities 

 

Make sure the Entity 1 tab is active. In the search box, type abdal This will filter out all 
but the abdal_rahmad line. In other MetaMatrices there may be others that match. Type in 
as much as needed to find your choice. Select the checkbox on the left. 

 

Now select Entity 2. In the search box now type media. This will filter out everything but 
media_consultant  
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Now select the [Close] button. 

You are now shown the path from abdal_rahmad to media_consultant without any extra 
entities or edges.  

 

Visualizer Patterns 
This is a list of patterns that can make it easier to find various clusters. 

No Edges 
No Edges – 2-Group – Bowtie – Chain – Circle – Star  
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2-Group 
No Edges – 2-Group – Bowtie – Chain – Circle – Star  

 

Bowtie 
No Edges – 2-Group – Bowtie – Chain – Circle – Star  
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Chain 
No Edges – 2-Group – Bowtie – Chain – Circle – Star  

 

Circle 
No Edges – 2-Group – Bowtie – Chain – Circle – Star  
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Star 
No Edges – 2-Group – Bowtie – Chain – Circle – Star  

 

Removing Pendants 
Pendant entities share links to other entities. But their linkage is tangential and therefore 
isolated from the core linkages you may be interested in examining. Pendant entities, like 
Isolated entities, can be removed. 
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From the drop down menu in the Visualizer tool bar > Tools > Hide 
Pendant Entities. 

 

Below is a Before/After screen shot of the visualization before showing the removal of 
the pendant entities. The red circles show the entities which have been removed. 
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Removing Entities In The Visualizer 
You can remove entities directly from the ORA Visualizer by right clicking on a entity 
and selecting Hide Entity. 

In the Visualizer, find the entity you want to hide. Here we will hide mohamed_owhali.  
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Place the cursor over the entity and right-click on the entity to bring up the contextual 
menu. Highlight Hide Entity. 

 

When you release the button mohamed_owhali's entity will be hidden. From this action 
we see the elimination of mohamed_owhali isolates jihad-mohammed_ali 
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Resize Entity by Attribute or Measure 
Sizing entities by basic SNA measures 

ORA has the capability to visualize entities by scaling them relative to each other in 
relation to common SNA Measures or Attributes as selected within the ORA Visualizer. 
The key benefit to sizing entities by Measure or Attribute is the ability to conceptually 
capture which entities in your network figure more prominently in terms of measures by 
simply gauging their size visually and intuitively. 

To demonstrate this function will work with a graph of the 
TanzaniaEmbassyEnhanced_2-07_1999 dataset. 

First, we will load our Metadata into ORA. 

Below is a screen shot of the TanzaniaEmbassyEnhanced-2-07_1999 Metadata set loaded 
into ORA's main interface: 
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To better illustrate the functionality of this tool, we will choose to work with a sub-graph 
part and parcel of the above Tanzania Meta-Matrix. Let us select the agent x knowledge 
graph of the of the TanzaniaEmbassyEnhanced_2-07_1999 dataset. The screen shot 
below displays this graph when selected in the ORA Main Interface. 

 

After the graph is selected, click the Visualize this Graph button to display this graph in 
the ORA Visualizer. The screen shot below displays the result: 
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Note: we have zoomed in on this image, thus obscuring from view two 
isolate nodes. 

Next, we will size the entities in this graph by accessing the Visualizer's Main Menu bar. 

From ORA Visualizer's Main Menu Bar > Size Entities by Attribute or 
Measure 

The red ellipse on the screen shot below shows how to access the Size Entity by Attribute 
or Measure tool from ORA's Visualizer Main Menu Bar. 
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After you select Size Entities by Attribute or Measure, the Entity Size Selector pop-up 
window will appear: 
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Using the drop down arrows, you can choose to select a Measure or Attribute by which to 
size your entities. In our example we are going to choose the measure Exclusivity, 
Knowledge from Select a Measure drop down arrow selector.  
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After we choose the measure to size, the Visualization should now scale your entities 
relative to their respective Exclusivity, Knowledge measure value. The screen shot below 
shows the result of this selection for our dataset: 
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Notice that the size of the nodes has now changed according to the entities relative value 
of Exclusivity. 

Let us drill down on the wadih_el-hage agent entity, which is ostensibly larger than the 
other agent entities. We will now check to see that this entity's Exclusivity, Knowledge 
value is higher than a smaller sized entity render in the ORA Visualizer. 

To do so, click on the entity wadih_el_hage. The Entity Status window will appear which 
shows information for the currently selected entity in the Visualizer. Scroll down in this 
window to you find the Measures value. The screen shot below shows were to find the 
Measures value in the Entity Status window. 
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Now we will compare this Measure value with that of the entity Mohamed_owhali, which 
is ostensibly smaller in size than wadih_el_hage. 
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Notice that this much smaller sized entity reflects a much smaller value (.00006) for the 
Exclusivity, Knowledge measure versus the wadih_el-hage entity (.0058).  

Sizing by Attributes 

You can also choose to size entities by Attributes. To do so, follow the procedures above 
until you get to the Entity Size Selector box. 
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This time opt for the first drop down selector Select an attribute and pick and attribute 
from the choices available. The screen shot below shows you the attributes available for 
our example Tanzania Bombing dataset. 
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The ORA Visualizer will now scale your entity sets according to attribute. 

SUMMARY 

By now you should know how to accomplish the following tasks: 

• Understand the benefit of sizing an entity set by attribute or measure. 
• Access the Size Entity by Attribute or Measure tool in the ORA Visualizer. 
• Select and Attribute or Measure available to your graph and render the graph in 

the Visualizer scaled according to a measure or attribute value. 

Rotating A Visualization 
You can rotate a visualization with the slider bar at the bottom of the interface or from 
the tool bar at the top. To do this from the slide bar, click the rotate option toward the 
bottom of the interface. This activates the rotate feature. As you move the slider from the 
left to right, your visualization will rotate correspondingly. From the tool bar, you can 
click inside the rotate icon, which will turn the visualization depending on exactly where 
you clicked. In the screen shot below, the yellow ellipses highlight where to access 
ORA's rotate tool both at the bottom and top of the Visualizer interface. 



  

 

 

2007 ORA Users Guide - Page 251 

Note : Use the rotate feature in tandem with the magnifying glass to find 
a visualization's maximum screen size. 

 

Sphere of Influence 
Sphere of Influence Basics 
Basics – Filters – Examples  

Each entity within a network has a unique Sphere of Influence or Ego Network. 
Essentially it's a direct relationship with it's neighbors as a function of specified path 
length. The ORA Visualizer allows you to focus on this relationship by creating an Ego 
Map centered on any particular entity you choose. 
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From the Visualizer's Main Menu select: Tools > Sphere of Influence 

 

The following dialog box will then appear. From here you can select the Size of your 
sphere's influence, the entitySets, and Key Sets to use. 
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Sphere of Influence Window 

Size Selector box : The drop down box allows you to choose the path length you are 
interested in for that particular entity or set of entities. 

Auto-Center : Keeps the visualized Ego Network centered within the Visualizer display. 

Auto-Zoom : Maximizes your ego network within the Visualizer. 
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Expand only these entities : Allows you to select the components you wish to have 
displayed in a entity's Sphere of Influence. 

Key Set Commands :  

Entity selection table : Allows the selection of individual entities for visualization. 

Sphere of Influence Filter 
Basics – Filters – Examples  

Using the embassy bombing MetaMatrix, we will find the Sphere of Influence of the 
Task entity bombing by performing a basic analysis. First will we run it with the filter 
Entity must match AT LEAST ONE filter. On the second we will change that to the filter 
Entity must match ALL filters so you can see the difference. 

Entity must match AT LEAST ONE filter 

Checkmark [agents] under Expands only these entities:. Next make sure the radio button 
for Entity must match AT LEAST ONE filter is selected. At the bottom of the screen you 
will notice is states that there are 18 entities and 45 edges. 
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Entity must match ALL filters 

This next example is similar to the above except we are going to change the filter to 
Entity must match ALL filters. The first thing you notice is the amount of entities and 
edges has changeed to 11 entities and 19 edges  

 

Sphere of Influence Example 
Basics – Filters – Examples  

The Sphere of Influence allows you to see how other entities relate to a particular entity 
you have choosen. For this example we want to see what other entities are connected to 
bombing. 

The size is set to 1, Hide connections between levels is checked to turn off extra edges, 
and all the checkboxes under Expands only these entities are empty except for [agents]. 
At the bottom of the box, type bombing into the search box. In the table at the bottom, 
one row will be displayed - bombing. Select the bombing checkbox. Then select the 
[Close] button. 
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The Visualizer will display the task bombing and any entity that has a connection to 
bombing. In this instance, there are five agents that are connected. 
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Next let's add an attribute to the mix. We want to see what other knowledge has 
connections to the task bombing. Then select the [Close] button. 

 

In addition to the five agents previously connected to bombing, we see the knowledges 
weapons_expertise and religious_extremism have been added to the display. 
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Now let's take a step backwards. and change the way the Visualizer will display the 
information. 

1. Increase to 2 the selector Select a size for the sphere of influence to display. 
2. Uncheck the knowledge checkbox. 
3. Select the [Close] button. 

 

You'll see that weapons_expertise and religious_extremism have displayed form the 
display. But also you'll notice that six more agents (denoted with the blue circles) have 
appeared, but the new agents are only connected to agents directly connected to bombing. 
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Next, we'll add the knowledge attributes back to the display. Once again, add in the 
Knowledge attributes again. Select the [Close] button. 

 

Notice that in addition to the tasks, weapons_expertise and religious_extremism 
reappearing the task surveillance_expertise also appears but is only connected as a second 
level away from bombing. 
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So by changing the size of the sphere of influence or switching which entities you want 
displayed will ultimately alter the information displayed in the Visualizer. 

The Tool Bar Explained 
When you first load a MetaMatrix you will see the pause button depressed in the 
Visualizer tool bar. 

You can layout the network by clicking the play button. The visualization will space 
apart across the screen. This is called laying out a MetaMatrix. The Visualizer is 
separating entities and ties that at first appear on top of each other. You can pause this 
process again when you think the network is satisfactorily spaced apart or you can let 
ORA lay out the entire MetaMatrix. Your computer speed as well as the complexity of 
MetaMatrix will determine how long this takes.  

This section explains the function of each of the toolbar's buttons. 

Copy Paste 

 

The Copy Paste feature allows you quickly capture a visualization and save it to be 
pasted into another document later. 
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Play / Pause 

 

The Play Pause function works very similar to the play pause feature on any device. The 
pause button (two vertical bars) is depressed, the Visualizer stops laying out a network. 
When the play button is depressed (right pointed triangle) ORA Visualizer begins laying 
out the network as described above. The red ellipse highlights on the tool bar where this 
feature is located and accessible. 

Magnifying / Maximizing 

 

The Magnifying Glass icon with the plus sign inside it, allows you to instantly fill the 
Visualizer window pane with the currently rendered MetaMatrix. The red circle in the 
screen shot below highlights where to access this feature on the Visualizer tool bar. 

If there are any entities off screen, clicking the button once will bring all the entities into 
view on the screen. 

Tip! This function works well when selecting a small part of your 
overall network and magnifying it to fill the visualizer screen. 

Rotating The Visualization 
See also Rotating a Visualization  

 

To Rotate your visualization look for the word next to the Noon-pointing sundial icon in 
the tool bar. This feature is another way to manipulate your visualization to fill the entire 
visualizer window pane. 

Tip! Use this feature in conjunction with the magnifying glass function 
to work your visualization into largest size possible. 

Show Labels 
See also Show/Hide Labels  
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The Show Labels button allows you to toggle the labels on & off in the visualizer. 

Show Edges 

 

The Show Edges button allows you to toggle the edges on & off in the visualizer. 

Show Arrows 

 

The Show Edges button allows you to toggle the arrows on & off in the visualizer. 

Font Size 

 

The Font Size allows for setting the size of the font in the visualizer 

 

This allows you to change the size of the font to suit you needs for each individual 
visualizer set. It ranges from 4, which is almost unreadable, to extremely large numbers, 
which can also be unreadable by virtual of overcrowding. So pick the size of font that 
best suits your screen. 

Entity Size 
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The Entity Size allows for changing the entity size, larger or smaller by increments of 
one. Four is the smallest size possible and creates a very small, almost indisguishable dot. 
As the number increases is becomes easier to see the indivdual entities until the number 
gets to a point where is can simply overpower the screen. But this gives you the ability to 
customize the entity size to suit your needs. 

 

Edge Width 

 

The Edge Width allows for changing the entity size, larger or smaller. And as the options 
before you can pick the exact size which best suits your needs for the display. 

 

Meta Size 
See also Creating a Meta Entity  

 

Use the Meta Entity Manager to handle creating and removing Meta Entities. 

Entity Sizes 

 

The Toggle Entity Size rotates through three sizes for the entities (As seen below). 
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Hide Edges by Weight 
Hide Edges by Weight  

 

Use the Hide Edges with Weight to select which edges to display or not. As long as there 
are edges with different values you can hide edges of smaller values leaving only the 
more important edgesa visible. This can assist in seeing edges that might normally be too 
cluttered to view. 
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Visualizer Tools 
The ORA Visualizer provides a suite of tools to visually analyze your MetaMatrix: 

 

• Drill Down  

With the ORA Drill-Down Wizard you can quickly visualize ego networks by 
overall entity class knowledge, tasks, resources, agents) or by choosing individual 
nodes from a checklist. The ORA Drill-Down Wizard is only accessible through 
the Visualizer: 

• Entity Status  

The Node Status Window is selected by default. It first pops-up when you select 
any node in the Visualizer. This window provides you with a snapshot of the 
currently selected node by displaying that nodes unique Attributes, Measures, and 
Neighbors. 

• Group Viewer Allows viewing of current display to be viewed in various 
grouping: CONCOR, Newman, Johnson, FOG, and K-FOG 

• Key Set Selector 
• Legend  
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Allows for toggling visibility of entities and edges on the fly.  

• Meta-Entities  

A MetaEntity contains multiple entities collapsed into one. You can create 
MetaEntities based on the entitysets in your organization, or you can create 
MetaEntities based on the attributes of the entities. To create MetaEntities, you 
must access the MetaEntity Manager. 

• Path Finder  

The Path Finder allows you to focus or drill down on a particular entity, or 
multiple nodes, that you may be interested in analyzing in greater detail. 

• Sphere of Influence  

Each entity within a network has a unique Sphere of Influence or Ego Network, 
essentially it's direct relationship with it's neighbors as a function of specified path 
length. 

Zooming 
At the bottom of the Visualizer interface is a sliding zoom bar. The red ellipse below 
highlights this feature. You can drag the slider it to the left or to the right increasing or 
decreasing the magnification of your visualization. In this example, we will click on the 
slider and move it toward the right. Scroll down to see a screen shot of the following 
visualization magnified. 
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In the screen shot below, note the position of the slider on the slide bar highlighted with 
the red ellipse. You can increase the magnification to the point that parts of the 
visualization will move off the screen. 
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Note : Use the Magnifying glass in the Visualizer tool bar to zoom your 
visualization to the greatest possible size, which still captures the entire 
visualization. 
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Tasks 
This section explains how to analyze your network or organization by taking you step-by-
step through common tasks such as simplifying complex visual networks or how to create 
your own MetaMatrix from scratch. 

• Creating A MetaMatrix From An Excel Spreadsheet 
• Eliminating Labels 
• Hyperbolic View 
• Rotating a Visualization 
• Zooming 

Creating A MetaMatrix From An Excel 
Spreadsheet 
If you don't have a MetaMatrix, you can create one from scratch. Below is step-by-step 
instruction on how to do this. 

We will create "Network Midas" an agent-by-agent square MetaMatrix. We say it is 
"square" because all row headings correspond directly to column headings. This is 
important as it relates to specific measures ORA can run on a graph. If the graph is not 
square, some measures will not work (See Measures for additional instruction). 

Begin by opening a blank Microsoft Excel work book. In "column A" we will enter the 
name of all agents that make up our social network or organization. 
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Note: When creating your spreadsheet, do not add any additional titles, 
notes, or other headings, which will interfere with the "square" 
properties of the MetaMatrix. 

 

Next, create column headings using the correlating names as they appear in row 
headings. Again, this will ensure that our MetaMatrix will be square. 
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Here we will create "links (aka edges, and ties)" between each agent. We do this by 
entering a "1" if a direct connection or relationship exists and a "0" if it does not. Please 
note that headings that cross-reference themselves are considered redundant and thus are 
left blank or "0." For instance, in cell "B2" it is assumed "agent Hank" has a tie to 
himself. 

In the example below, "Red Xs" are used to illustrate the redundant ties. This redundancy 
should continue as a smooth diagonal line from the top left corner of your MetaMatrix to 
the bottom right. 
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Tip! If you can't make this smooth diagonal line, you graph is not 
square. 

Using 1sand 0s to establish linkages, complete your spreadsheet. 

In the "Network Midas" example, we have assigned relationships randomly. Within your 
organization or network, however, you can describe any direct connections or 
relationships you are interested in analyzing. For instance, you may determine that a 
"direct connection" exits if agents within your network consult with each other at least 
once a month; literally, it can be anything you decide. 

Below is our completed MetaMatrix, Network Midas (The red fill illustrates cells that do 
not require input due to their redundancy). 
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Now that we have essentially built a MetaMatrix from scratch using Excel, the next step 
is to save it in a compatible file format ORA can interpret. For Excel spreadsheets, in all 
likelihood, this will be the "CSV" (comma separate values) file format. 

From the drop down menu: File > Save As > Save As Type > CSV (comma delimited) 
(*.csv) 
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Click "OK" 

 

Click "Yes" 

Congratulations! You have now created your own MetaMatrix from scratch. Now, simply 
load your saved CSV file as you would any DynetML file, and work with your data the 
same way. 

Below is a our MetaMatrix Network Midas rendered in the ORA Visualizer 
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Lessons 
This sections contains lesson on running various facets of ORA. 

1. ORA Interface 
2. Loading, Saving, and Manipulating Data 
3. Running an Intelligence Report 
4. What's Going on Where 
5. Over-Time Viewer 
6. Over-Time Viewer-Immediate Impact 
7. Over-Time Viewer-Near Term Impact Analysis 
8. Using the Data Import Wizard 

Lesson 1 
Overview of ORA Interface 

An overview of the ORA interface 

Below is a screen capture showing the ORA interface: 
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The menu bar runs across the top of the window, and the rest of the screen is divided into 
three panels. 

Panel 1 displays a list of the meta matrix that has been loaded into ORA and its 
components and sub-matrices. To view information about a particular meta matrix or 
sub-matrix, single-click on it in Panel 1 to highlight it. 

Panel 2 displays information about whatever meta matrix or sub-matrix is highlighted in 
Panel 1. 

Panel 3 displays information about the results of analyses you run on your meta matrices. 

Loading a meta matrix into ORA 

You have three options for opening your meta matrix in ORA: 

• Go to File in the ORA menu bar and click Open MetaMatrix. A small window 
titled Help: Opening Meta Matrix pops up. Your data should already be in the 
correct format, so click [OK].  

• Next, a file chooser titled Open pops up. Browse to the location of your dataset, 
single-click on it, and click the Open button in the bottom right corner. 

• Click the first icon in the row directly below the menu bar. It looks like a half-
open file folder. A window titled Import Data into ORA will pop up. Click the 
Select Files button. A file chooser titled Open pops up. Browse to the location of 
your dataset, single-click on it, and click the Open button in the bottom right 
corner. You will be returned to the Import Data into ORA window. Click the 
Finish button in the bottom right corner. 
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• In panel 2, click the Load button on the far right. A window titled Import Data 
into ORA pops up. Click the Select Files button. A file chooser titled Open pops 
up. Browse to the location of your dataset, single-click on it, and click the Open 
button in the bottom right corner. You will be returned to the Import Data into 
ORA window. Click the Finish button in the bottom right corner. 

You will see a list of your meta matrix and sub-categories in Panel 1, as well as the 
location and basic statistics of your meta matrix in Panel 2. You are now ready to begin 
analyzing the meta matrix. 

I. What does the network look like? 

To visualize a meta matrix, first make sure the meta matrix you wish to visualize is 
highlighted in Panel 1. If it is not highlighted, single-click on it. 

In Panel 2, click the Visualize this MetaMatrix button. A new window will pop up 
displaying your meta matrix graphically. A small legend also appears. 

Below is a screen capture showing the visualization of the meta matrix for the Tanzania 
Embassy bombing data: 

 

The visualization displays the connections between all items in the Tanzania Embassy 
bombing network. For example, the red circles represent key agents in the terrorist 
network that carried out the Embassy bombing. A line connecting an agent to another 
agent indicates that those two agents were in direct communication. 

You might want to keep this visualization window open for future analysis (minimize it 
but don't close it). 
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Lesson 2 
Loading, Manipulating, and Saving Data 

1. Open MetaMatrix 
2. Data Import Wizard 
3. Import Database 
4. Import Attribute File 
5. Open Workspace 
6. Save MetaMatrix 
7. Save MetaMatrix As… 
8. Save Workspace 
9. Network Format Converter 
10. CSN Table Converter 

ORA allows a variety of ways to load and Save data: Loading single or multiple 
MetaMatrices, Appending data into open MetaMatrices or Saving MetaMatrices as single 
files or Workspaces. All these options are all located in the Main Menu under File. 

Below is a reminder of the names of the panels we will be using throughout the lessons. 

 

I. Loading Data 

Open MetaMatrix opens up a single MetaMatrix file. 
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• From the Main Menu File > Open MetaMatrix. 

 

The dialog box below will appear informing you that this option is primarily for opening 
up a MetaMatrix file. 

 

If you are not sure which format your data is and how to proceed then select [Cancel]. 

• Select [OK] to bring up the Open dialog box. 

From here you can navigate through your directories and find the MetaMatrix you wish 
to open.  
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Highlight the file you want in the main window and will it's name will appear in the box 
titled File name.  

• Select the [Open] button. 

 

Your Meta Matrix will then appear in Panel 1. 
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II. Data Import Wizard 

The Data Import Wizard menu item allows you other options in importing MetaMatrix 
files. 

• From the Main Menu select File > Data Import Wizard. 

 

The following dialog box will appear asking you to indicate the file you wish to open. 
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• Under the section [Select one or more files below to begin] select the [Select 
Files] button. 

 

This will bring up the Open dialog box where you can navigate to the directory with the 
file you wish to open. 

• Highlight the file you want to open 

• Select the [Open] button. 
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The file you selected will now appear in the box under [Select one or more files below to 
begin]. 

 

You can also open multiple files from this dialog box. This can be done in two ways. 
Select the [Select Files] button to call up the Open dialog box and navigate to the 
directory with your files. 
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NOTE: You can only open multiple files that are in the same directory 
with this procedure. 

If all the files in sequential order, 

• Select the topmost file you want to add. 
• Press and hold the Shift key 
• Select the bottomost file you want to add 

This will highlight a set of files (as per the example below) 

• Selecting [Open] will place them in the Import Data into ORA dialog box. 

 

If the files are not in sequential order 

• Highlight the first file you want 
• Press and hold the Control key 
• Highlight another file 
• Continue this procedure till all files you want are highlighted (as per the example 

below) 

NOTE: If you selected a file and change your mind or selected a file in 
error, then press and hold the Control key and click the mouse pointer 
on the file to deselect it. 

• Selecting [Open] will place them in the Import Data into ORA dialog box. 
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At the Import Data into ORA dialog box the files you have selected are ready to load. 
(The example below shows 4 files selected) 

 

• When you are sure these are the file(s) you want, select [Finish] 

Next a dialog box will appear and you will be asked how you wish to open this file. 

The Import Data dialog box has three options for opening files which are explained 
below. 
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1. Replace Selected MetaMatrix – If you had a MetaMatrix currently selected in 
Panel 1 then the new MetaMatrix will replace it. All other MetaMatrices will 
remain unaffected. 

2. Append as Additional MetaMatrix – 
3. Replace All MetaMatrices – All current MetaMatrices will be deleted and the new 

MetaMatix(s) will become active. 

After selecting one of the three options your files will appear in Panel 1 of the Main 
Interface. 

Below is an example showing the multiple files opened in Panel 1. 

 

III.Import Database 

The Import Database function is an advanced feature. 
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IV. Import Attribute File 

This function requires that a file is set up to match an existing MetaMatrix. It is used to 
add an attribute into a file. The file selected must be in the CSV format. 

The CSV ("Comma Separated Value") file format is often used to exchange data between 
disparate applications. The file format, as it is used in Microsoft Excel, has become a 
pseudo standard throughout the industry, even among non-Microsoft platforms. 

• From the Main Menu select File > Import Attribute File 

 

The following dialog box contains the parameters for how the attribute file will be 
imported. Each section will be explained separately. 
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If your CSV file contains a headers row leave the check in the top checkbox. If there is 
no header row then select the bottom checkbox. You will be prompted to give the data an 
attribute name. The example file has no column headers so we will give it an attribute 
name. 

• This file has not header so the bottom box is checked. This file will be used to 
specify whether an agent speaks English. Type english into the box on the right. 

 

If your CSV file contains information regarding the entities leave the check in the top 
checkbox. If there is no entity information within the CSV file place the check in the 
bottom checkbox. 

• This file has no information regarding the entities so place a check in the bottom 
checkbox. 
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• Select the [Select Attribute File] button to open the Open dialog box. This allows 
you to select the new attribute file to open. 

 

An Open dialog box will appear. 

• Navigate to the Attribute file you wish to use and select [Open] 

 

After selecting [Open] at the bottom of the dialog box the Import Attributes dialog box 
will reflect your choices showing the path to the file you chose. 
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Finally, at the bottom of the dialog box, is a drop-down menu for choosing the type of 
entity for this attribute file. The file we chose was agent_knowledge so we will be leaving 
it set to agent. 

 

Below is the complete dialog box. 
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• Select [OK] to load the file(s) into ORA. 

Return to the Main Interface. 

• Select the [agent] entity from Panel 1 
• Select the Editor tab from Panel 2. 

Displayed in the table will be the new attribute that was imported under the heading 
English with the data from the file. 
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V.Open Workspace 

You may open an entire workspace that you were previously using. A workspace consists 
of a set of MetaMatricx files that were all open at the same time, and saved as a 
workspace. 

• From the Main Menu select File > Open Workspace 
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A dialog box will appear to make sure you understand you're asking to open a workspace. 

 

• Select [OK] 

 

• Navigate to the directory where your Workspaces are saved 
• Select one of the Workspaces (files with the extension .ows) 
• Select [Open] 

All MetaMatrices contained within the choosen workspace will be open in ORA. 

VI. Save MetaMatrix 

This option is currently non-functional. Usethe menu item below Save MetaMatrix As... 
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VII. Save MetaMatrix As... 

Choose the Save MetaMatrix As... menu item to save the changes you've made in a 
MetaMatrix. 

 

Selecting this option will bring up the Save MetaMatrix dialog box. From here you can 
save your MetaMatrix to any directory and rename it a different name. You can either 
lightlight an existing file in the window or type in an entirely new filename. 
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VIII Save Workspace 

While working with multiple MetaMaarices you may want to retain that information for 
later use. The Save Workspace menu item 

 

After selecting Save Workspace the following dialog box will appear. This informs you 
exactly what you're going to do. 
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This will bring up the Save ORA Project window. In the File name box, type the name 
you wish to save your workspace to. 

 

This Workspace can then be called up with the Load Workspace in a future session. 
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IX. Network Format Converter 

 

The Network Format Converter takes files from one format and convert it to an ORA 
format. The screenshot below shows the main interface with no MetaMatrix loaded. 

 

• From the Main Menu File > Network File Converter. 

The dialog box will appear. So to the tab marked Load Network. 
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• Move the pointer over the inverted triangle to select the format of the file to 
convert. 

Below is the list of file types available to convert. 

Select the file type CSV. 

 

• Select the [Load] button 

This will bring up the Open dialog box. 
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• Select the file you wish to convert and select the Open button. 

Your screen should now look like that below. 

 

Now select the Save Network tab. Select the file format you want to convert your file to. 
In this case we'll leave it at DYNETML. 
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• Select the [Save] button 
• Navigate to the directory you want to save your file. 
• Type in the name you want your file to be called. 

NOTE: Remember to type in the extension .xml so it will be recognized 
by ORA. 

 

In order to access this file in ORA goto File > Open MetaMatrix and open it normally. 

Below is a screenshot showing the newly saved file agent_agent_labelled.xml. 
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X. CSV Table Converter 

 

Below is a screenshot of ORA with no MetaMatrices loaded. From here we'll convert a 
.csv file and load it into ORA. 
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• From the Main Menu goto File > CSV Table Converter to bring up the CSV 
Table Converter. 

 

• Select the [Load Table] button at the top which will bring up the Open window 
• Navigate to the file directory you want, highlight the file, and select the [Open] 

button. 
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The window will show the file you selected in the text field. 

 

We want to show this information in some sort of graph. 

• Type in the name of the graph in the field Graph Name 
• Select the [Add] button 

 

Near the bottom of the window it will reflect the graph you just created. 
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• Select the [Save Network] button at the bottom to create a new MetaMatrix. 

 

This will bring up the Save dialog box. 

• Navigate to the file directory where you want to save your file. 
• Type in the name for your file (remembering to attach the .xml extension). 
• Select the [Save] button. 

 

You will return to the CSV Table Converter dialog box 

• At the bottom of the CSV Table Converter window select the [OK] button to 
close the window. 
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The exit dialog box till appear. 

• Select [Yes] to exit and return to ORA. 

 

Now you are ready to load your newly created MetaMatrix into ORA. 

• From the Main Menu goto File > Open MetaMatrix. 

This will bring up the Open dialog box. 
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• Find the file you just created 
• Highlight the new file 
• Select the [Open] button. 

 

Below is Panel 1 in the Main Interface showing the newly loaded file. 

 

You could then go and convert any number of individual CSV files and load them into 
ORA as shown below. 

Lesson 3 
Running an Intelligence Report 

Who are the critical actors? 

An Intelligence Report identifies key actors (individuals and groups) who are positioned 
in the network in ways that make them critical to its operation. 

To run an Intelligence Report: 

• Return to the ORA interface. 
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• Go to Analysis in the menu bar and click Generate Reports which brings up the 
Generate Reports dialog box.  

• At the top of the window is a pull-down menu titled Select Report. Pull down the 
menu by clicking the small inverted arrow icon to its right, and select Intelligence.  

• In the box titled Select one or more meta matrices: select the box for the Tanzania 
Embassy bombing meta matrix.  

• At the bottom of the popup window is a file chooser titled Enter a file name (any 
extension will be ignored) for the results file: Select the [Browse] button to the 
right and navigate to the location you want. Type in a filename (for example, 
IntelOutput) and select Open.  

Below is a screen capture showing the popup windows with the correct options chosen: 

 

• Select the [Next] button at the bottom of the dialog box. Select the [Finish] 
button. 

An HTML file will pop up in your browser displaying the Intelligence Report. The same 
text is also displayed in Panel 3 in ORA. 

Below is a screen capture of the ORA interface with the Intelligence Report displayed in 
Panel 3: 
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Below is the HTML file for the Intelligence Report on the Tanzania Embassy bombing 
data: 

INTELLIGENCE REPORT 

Input data: TanzaniaEmbassyEnhance_2-07 

Start time: Fri Feb 23 10:30:55 2007 

KEY ACTORS 

Emergent Leader (cognitive demand) 

Measures the total amount of cognitive effort expended by each agent to do its tasks. 

   
Rank Value Nodes 
1 0.378917 fazul_mohammed 
2 0.341104 khalfan_mohamed 
3 0.299063 mohamed_owhali 
4 0.280313 a13 
5 0.269833 mohammed_odeh 
6 0.243792 abdullah_ahmed_abdullah 
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7 0.192542 a10 
8 0.183771 a4 
9 0.180042 wadih_el-hage 
10 0.176083 a16 

In-the-Know (total degree centrality) 

The Total Degree Centrality of a node is the normalized sum of its row and column 
degrees. 

Input graph(s): Agent x Agent 

   
Rank Value Nodes 
1 0.4 wadih_el-hage 
2 0.266667 mohamed_owhali 
3 0.266667 bin_laden 
4 0.2 abdullah_ahmed_abdullah 
5 0.133333 ali_mohamed 
6 0.133333 khalid_al-fawwaz 
7 0.133333 a16 
8 0.1 mohammed_odeh 
9 0.0666667 fazul_mohammed 
10 0.0666667 a13 

Number of Cliques (clique count) 

The number of distinct cliques to which each node belongs. 

Input graph(s): Agent x Agent 

   
Rank Value Nodes 
1 2 wadih_el-hage 
2 2 bin_laden 
3 1 mohamed_owhali 
4 1 ali_mohamed 
5 1 khalid_al-fawwaz 
6 1 abdullah_ahmed_abdullah 
7 1 a16 
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8 0 khalfan_mohamed 
9 0 mohammed_odeh 
10 0 a4 

Most Knowledge (row degree centrality) 

The Row Degree Centrality of a node is its normalized out-degree. 

Input graph(s): Agent x Knowledge 

   
Rank Value Nodes 
1 0.75 mohamed_owhali 
2 0.75 mohammed_odeh 
3 0.75 fazul_mohammed 
4 0.5 khalfan_mohamed 
5 0.5 wadih_el-hage 
6 0.5 ali_mohamed 
7 0.5 a10 
8 0.5 jamal_al-fadl 
9 0.5 a13 
10 0.25 bin_laden 

Most Resources (row degree centrality) 

The Row Degree Centrality of a node is its normalized out-degree. 

Input graph(s): Agent x Resource 

   
Rank Value Nodes 
1 0.75 abdullah_ahmed_abdullah 
2 0.5 fazul_mohammed 
3 0.5 ahmed_ghailani 
4 0.25 khalfan_mohamed 
5 0.25 mohammed_odeh 
6 0.25 wadih_el-hage 
7 0.25 bin_laden 
8 0.25 a10 
9 0.25 a16 
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10 0 mohamed_owhali 

Leader of Strong Clique (eigenvector centrality) 

Calculates the principal eigenvector of the network. A node is central to the extent that its 
neighbors are central. 

Input graph(s): Agent x Agent 

   
Rank Value Nodes 
1 0.167408 wadih_el-hage 
2 0.147407 bin_laden 
3 0.101381 mohamed_owhali 
4 0.0992916 ali_mohamed 
5 0.0992915 khalid_al-fawwaz 
6 0.0836873 abdullah_ahmed_abdullah 
7 0.0791944 mohammed_odeh 
8 0.0583699 a16 
9 0.0527998 mahmud_abouhalima 
10 0.0527997 fazul_mohammed 

Potentially Influential (betweenness centrality) 

The Betweenness Centrality of node v in a network is defined as: across all node pairs 
that have a shortest path containing v, the percentage that pass through v. 

Input graph(s): Agent x Agent 

   
Rank Value Nodes 
1 0.233333 wadih_el-hage 
2 0.197619 mohamed_owhali 
3 0.192857 bin_laden 
4 0.0690476 abdullah_ahmed_abdullah 
5 0.0452381 mohammed_odeh 
6 0 khalfan_mohamed 
7 0 a4 
8 0 fazul_mohammed 
9 0 ali_mohamed 
10 0 ahmed_ghailani 
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Connects Groups (high betweenness and low degree) 

The ratio of betweenness to degree centrality; higher scores mean that a node is a 
potential boundary spanner. 

Input graph(s): Agent x Agent 

   
Rank Value Nodes 
1 0.26046 mohamed_owhali 
2 0.254184 bin_laden 
3 0.205021 wadih_el-hage 
4 0.158996 mohammed_odeh 
5 0.121339 abdullah_ahmed_abdullah 
6 0 khalfan_mohamed 
7 0 a4 
8 0 fazul_mohammed 
9 0 ali_mohamed 
10 0 ahmed_ghailani 

Unique Task Assignment (task exclusivity) 

Detects agents who exclusively perform tasks. 

    
Rank Value Nodes Speciality 
1 0.205078 fazul_mohammed t3 
2 0.0136876 mohamed_owhali t1 
3 0.0136876 a13 t1 
4 0.011305 abdullah_ahmed_abdullah t1 
5 0.00995741 ali_mohamed t1 
6 0.00507781 khalfan_mohamed t5 
7 0.00366313 a4 t5 
8 0.00141468 mohammed_odeh t4 
9 0.00141468 a16 t4 
10 0.00134759 ahmed_ghailani t4 

Special Expertise (knowledge exclusivity) 

Detects agents who have singular knowledge. 
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Rank Value Nodes Speciality 
1 0.0919699 bin_laden k4 
2 0.0919699 khalid_al-fawwaz k4 
3 0.00214043 mohamed_owhali k3 
4 0.00214043 mohammed_odeh k3 
5 0.00214043 fazul_mohammed k3 
6 0.00191246 khalfan_mohamed k3 
7 0.00191246 ali_mohamed k3 
8 0.00168449 abdullah_ahmed_abdullah k3 
9 0.000455941 wadih_el-hage k1, k2 
10 0.000455941 a10 k1, k2 

Special Capability (resource exclusivity) 

Detects row nodes who have singular ties to column nodes. 

Input graph(s): Agent x Resource 

    
Rank Value Nodes Speciality 
1 0.108996 abdullah_ahmed_abdullah r4 
2 0.0965488 ahmed_ghailani r4 
3 0.0919699 bin_laden r2 
4 0.0919699 a10 r2 
5 0.0170257 fazul_mohammed r3 
6 0.0124468 wadih_el-hage r3 
7 0.0124468 a16 r3 
8 0.00457891 khalfan_mohamed r1 
9 0.00457891 mohammed_odeh r1 
10 0 mohamed_owhali  

Workload (actual based on knowledge and resource) 

The knowledge and resources an agent uses to perform the tasks to which it is assigned. 

   
Rank Value Nodes 
1 0.692308 fazul_mohammed 
2 0.307692 mohamed_owhali 
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3 0.307692 khalfan_mohamed 
4 0.230769 mohammed_odeh 
5 0.230769 a13 
6 0.230769 abdullah_ahmed_abdullah 
7 0.153846 wadih_el-hage 
8 0.153846 a16 
9 0.0769231 ali_mohamed 
10 0.0769231 ahmed_ghailani 

KEY KNOWLEDGE 

Dominant Knowledge (total degree centrality) 

The Total Degree Centrality of a node is the normalized sum of its row and column 
degrees. 

   
Rank Value Nodes 
1 0.571429 k2 
2 0.428571 k1 
3 0.333333 k3 
4 0.0952381 k4 

KEY RESOURCES 

Dominant Resource (total degree centrality) 

The Total Degree Centrality of a node is the normalized sum of its row and column 
degrees. 

   
Rank Value Nodes 
1 0.333333 r3 
2 0.285714 r1 
3 0.190476 r4 
4 0.142857 r2 

KEY LOCATIONS 

Dominant Location (total degree centrality) 
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The Total Degree Centrality of a node is the normalized sum of its row and column 
degrees. 

   
Rank Value Nodes 
1 1.125 u_s 
2 0.847222 afghanistan 
3 0.833333 pakistan 
4 0.722222 washington 
5 0.708333 indonesia 
6 0.701389 europe 
7 0.673611 airport 
8 0.604167 america 
9 0.527778 turkey 
10 0.506944 somalia 

PERFORMANCE INDICATORS 
  

Entity class Size 
agent 16 
event 3 
knowledge 4 
location 54 
resource 4 
task 5 

Overall Complexity = 0.22707503 

Density of the Meta-Matrix: Social Density = 0.11666667 

Density of the Agent x Agent network: Social Fragmentation = 0.45 

Fragmentation of the Agent x Agent network: Communication Congruence = 0.416667 

Measures to what extent the agents communicate when and only when it is needful to 
complete tasks. Perfect congruence requires a symmetric Agent x Agent network: 
Knowledge Congruence = 0.55 

Measures the similarity between what knowledge are assigned to tasks via agents, and 
what knowledge are required to do tasks. Perfect congruence occurs when agents have 
access to knowledge when and only when it is needful to complete tasks: Performance 
As Accuracy = 0.36 
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Measures how accurately agents can perform their assigned tasks based on their access to 
knowledge and resources: Avg Communication Speed = 0.438406 

The average speed with which any two nodes can interact. This is based on the inverse of 
the shortest path lengths between node pairs. 

Produced by ORA developed at CASOS - Carnegie Mellon University 

 

From this Intelligence Report, it appears that Fazul Mohammed, Khalfan Mohamed, 
Mohamed Owhali, Mohammed Odeh, Abdullah Ahmed Abdullah, and Wadih El-Hage 
are among the most important people in the terrorist network. This means they may have 
a great deal of knowledge, influence over many other agents in the network, special 
expertise or capability, or access to important resources and locations. 

For example, Wadih El-Hage is important because he is the most in-the-know, commands 
important cliques within the network, and has the most potential influence in the network.  

III. What do we know about an actor of interest? 

There are three ways to get additional information about an actor of interest: 

1. Visualize information about a selected actor 

For example, we can view information about Wadih El-Hage. 

• Return to the meta matrix visualization pop-up window. 
• Single-click on the red circle for the actor of interest. A window will pop up 

displaying information on the actor. 

Below is a screen capture of the information resulting from clicking on the red circle for 
Wadih El-Hage: 
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2. Visualize an actor's sphere of influence 

A sphere of influence is the set of actors, groups, knowledge, resources, events, and 
locations that influence and are influenced by a particular actor of interest. 

For example, we can examine the sphere of influence of Ahmed Ghailani. 

To visualize an actor's sphere of influence: 

• Return to the meta matrix visualization pop-up window. 
• Make sure the whole meta matrix is visualized. If it isn't, go to Actions in the 

menu bar and select Show All Entities. 
• Go to Tools in the menu bar and select Sphere of Influence. A window titled 

Sphere of Influence (Ego Network) will pop up. 
• In the Search field halfway down the popup window, type the beginning of the 

actor's name. From the options that appear in the chart below, click the box next 
to the name of your actor of interest. That actor's sphere of influence will be 
displayed in the visualization window. 

Below is a visualization of the sphere of influence of Ahmed Ghailani: 



  

 

 

2007 ORA Users Guide - Page 319 

 

To return to the original full meta matrix visualization, go to Actions in the menu bar and 
select Show All Entities. 

3. Run a Sphere of Influence Report 

A Sphere of Influence Report for an individual identifies the set of actors, groups, 
knowledge, resources, events, and locations that influence and are influenced by that 
actor. 

For example, we can examine the sphere of influence of Ahmed Ghailani. 

To run a Sphere of Influence Report: 

• Return to the ORA interface. 
• Go to Analysis in the menu bar and click Generate Reports. A window titled 

Generate Reports pops up.  
• At the top of the window is a pull-down menu titled Select Report. Pull down the 

menu by clicking the small inverted arrow icon to its right, and select Sphere of 
Influence.  

• In the box titled Select one or more meta matrices: click the box for the Tanzania 
Embassy bombing meta matrix.  

• At the bottom of the popup window is a file chooser titled Enter a file name (any 
extension will be ignored) for the results file: Click the Browse button to the right 
and navigate to the location you want. Type in a filename (for example, 
SOIOutput) and click Open.  

• Click the Next button at the very bottom of the popup window.  
• From the pull-down menu titled Select an Entity: choose Ahmed Ghailani.  
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• Click the Finish button. 

It may take a few minutes for ORA to run the Sphere of Influence Report. When ORA is 
finished, a small window will pop up tell you the analysis was successfully completed. 
Click OK. 

An HTML file displaying the Sphere of Influence Report will pop up in your browser 
window. 

Below is the HTML file for Ahmed Ghailani's sphere of influence: 

 

SPHERE-OF-INFLUENCE REPORT 

Input data: TanzaniaEmbassyEnhance_2-07 

Start time: Fri Feb 23 11:10:54 2007 

Sphere of Influence Analysis for agent ahmed_ghailani 

The radius of the network is 1 
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Size Statistics 

Contains the size of each node type within the ego network, expressed as an absolute 
value and as a percentage of the nodes in the original input network. 

   
Node Type Size Percent 
agent 1 +6% 
manual_location 6 +11% 
resource 2 +50% 
task 1 +20% 

Attributes 

These are the attributes of the ego node. 

  
Name Value 
first_name ahmed 
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hostility_level 2 
kinship mother 
last_name ghailani 
nationality tanzanian 
nationality_relation hostile 
nyi president 
source_date 2006-05-10 
source_name xmldata/pacrim_ilchul.xml 
title ahmed_khalfan_ghailani 

Exclusive Connections 

Find nodes that have connections exclusively to the ego node. These are also called 
pendant nodes of the ego. 

There are no pendants attached to this node. 

Most Similar Node 

Computes the node that is most similar to the ego node with respect to Cognitive 
Similarity. This is computed two ways: first, using just the ego network, and second, 
using the original input network. 

   
Network Node Type Node Name 
Original Network agent abdullah_ahmed_abdullah 
Ego Network agent ahmed_ghailani 

Top Measures 

Computes a collection of standard network analysis measures and reports those for which 
the ego node is among the top 10 nodes. 

    
Measure Name Measure Input Rank Value 
Centrality, Row Degree Agent x Resource 3 0.5 
Centrality, Betweenness Agent x Agent 10 0 
Boundary Spanner, Potential Agent x Agent 10 0 
Exclusivity, Task Agent x Task 10 0.00134759 
Exclusivity Agent x Resource 2 0.0965488 
Actual Workload Agent x Knowledge 10 0.0769231 
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Measure Value Range 

Computes a collection of network analysis routines for all the nodes in the network and 
reports whether the ego node has a Low, Medium, or High value with respect to the other 
nodes. Low means less than one standard deviation from the mean; high means more than 
one standard deviation from the mean; Medium is neither low nor high. 

   
Measure Name Measure Input Range 
Cognitive Demand Agent x Agent Medium 
Centrality, Total Degree  Medium 
Clique Count Agent x Agent Medium 
Centrality, Eigenvector Agent x Agent Low 
Centrality, Betweenness Agent x Agent Medium 
Boundary Spanner, Potential Agent x Agent Medium 
Exclusivity, Task Agent x Task Medium 
Exclusivity, Knowledge Agent x Knowledge Medium 
Exclusivity Agent x Resource High 
Actual Workload Agent x Knowledge Medium 

Resource Analysis Section 

Computes the resources that ahmed_ghailani can directly leverage and that can be 
mobilized. Direct resource are those directly connected to it, and indirect resources are 
those directly connected to a neighbor. 

Resources that can be leveraged 

 

Resources that can be mobilized 

ahmed_ghailani does not have any resources to mobilize. 

   
Measure Value Percent of total 
Direct resources 2 +50% 
Indirect resources 0 0% 
Possibly constrained resources 0 0% 
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Possibly constrained resources are both directly and indirectly linked to the ego entity. 

Contacts with the most resources (directly linked entities with the most resources): 

  
Name Number of resources 

Contacts with the unique resources (directly linked entities with exclusive resources): 

  
Name Unique resources 

Produced by ORA developed at CASOS - Carnegie Mellon University 

________________________________________  

IV. What are the connections between two actors of interest? 

Sometimes, rather than influencing an actor directly, you may want to examine whether 
that actor has a connection with someone who is more interesting to you. For this, the 
Path Finder feature is most useful. 

For example, we can look at how Ahmed Ghailani and Wadih El-Hage are connected. 

To use the Path Finder feature: 

• Return to the meta matrix visualization pop-up window. 
• Make sure the whole meta matrix is visualized. If it is not, go to Actions in the 

menu bar and select Show All Entities. 
• Go to Tools in the menu bar and select Path Finder. A window titled Path Finder 

will pop up. 
• In the bottom half of this pop-up window, there are two tabs titled Entity 1 and 

Entity 2. Entity 1 is the from entity, and Entity 2 is the to entity. In other words, 
Path Finder searches for communication and information that is passed from 
Entity 1 to Entity 2. 

• In the Entity 1 tab, type the name of your first actor of interest into the Search 
field. From the chart of agents below the Search field, check the box for the name 
of that agent. (For example, Ahmed Ghailani). 

• Click on the Entity 2 tab and type in the name of your second actor of interest into 
the Search field. From the chart of agents below the Search field, check the box 
for the name of that agent. (For example, Wadih El-Hage). 

• The visualization of the connections between Entity 1 and Entity 2 will appear in 
the visualization window. 
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Below is a screen capture showing the connection between Ahmed Ghailani and Wadih 
El-Hage: 

 

V. What is the immediate impact of a particular agent on the 
network? 

VI. What happens to the network when certain entities are 
removed? 

We can examine the impact of removing a particular entity from the network by using 
Near Term Analysis (NTA). NTA removes a given entity and estimates the changes in 
the remaining network. 

This provides a what if?... analysis of the network. We can simulate strategic 
interventions or eliminations of certain agents, and examine how the network should 
react and change. For example, we can look at how the Tanzania Embassy bombing 
network changes if Ahmed Ghailani and/or Wadih El-Hage are eliminated. 

To run a Near Term Analysis: 
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1. Start the Near Term Analysis window 

• Return to the ORA interface. 
• Make sure the meta matrix is highlighted in Panel 1. If it is not highlighted, 

single-click on it. 
• Go to Analysis in the menu bar and select Near-Term Analysis. A window titled 

Near Term Analysis will pop up. 

NTA has two modes, Novice and Advanced, displayed as tabs in the Near Term Analysis 
pop-up window. Novice mode provides an automatic analysis set-up, but does not allow 
users to set up their own hypotheses. 

• Click on the Advanced mode tab to switch to Advanced mode. 

Below is a screen capture showing the Advanced mode tab in the Near Term Analysis 
pop-up window: 

 

• In the field titled Settings, find the number boxes on the far right. Change the 
number of replications (the top number box) to 2, and the number of simulated 
time-points (the bottom number box) to 52. The timeline in the Simulated time 
line field will expand to include 52 time-steps. 

2. Open the simulation scenario wizard 
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• In the middle of the pop-up window, find and click the Add new simulation 
instances button. A small window titled Near Term Analysis - Simulation 
scenario create wizard will pop up. 

Below is a screen capture showing this wizard window: 

 

• In this wizard window, make sure the first option in the Options field is selected. 
Click the Next button. The wizard window will display options for creating a 
custom scenario. 

Below is a screen capture showing this custom scenario field in the wizard window: 

 

3. Remove Wadih El-Hage 
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• Click the box for Wadih El-Hage in the table of agents in the wizard window. 
Change the Timing box to 10 in the same row. 

• To add this event set-up to the Near Term Analysis, click the Add events button 
located next to the Search field (above the list of agents). 

The timeline at the top of the wizard window will mark the isolation of Wadih El-Hage at 
time 10. 

Below is a screen capture of this timeline: 

 

• Click the Add a simulation button at the bottom of the wizard window. The 
wizard window will close automatically. In the NTA window, the new simulation 
case will appear in the Cases to simulate field. 

4. Remove Ahmed Ghailani 

• Follow Step 3, but replace Wadih El-Hage with Ahmed Ghailani. 

Your two simulation cases appear in the Near Term Analysis window in the Cases to 
simulate field, along with the Baseline case. The Baseline case is simply the network with 
no entities removed. 

You can view your different simulation cases by clicking on them in the Cases to 
simulate field, and the simulation time-line will change accordingly. 

5. Run the Near Term Analysis 
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• Click the Execution button at the bottom of the Near Term Analysis window. 
• A small window will pop up to warn you that the execution may take a long time. 

Click OK. Another small window will pop up to show you how the simulations 
are progressing in the Near Term Analysis. 

6. View the results of the Near Term Analysis 

• When the analysis is complete, a new window titled Near Term Analysis Results 
will pop up. 

Below is a screen capture of the results pop-up window: 

 

These two performance lines correspond to deviations from the baseline of knowledge 
diffusion over time. Examining this performance change over time reveals how much an 
agent's elimination impacts the performance of the organization. 

• To draw a bar chart, click the Draw bar chart button in the results window. The 
resulting bar chart displays a performance comparison for each time-point. 

Below is a screen capture of the bar chart: 
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The results of the Near Term Analysis are also available in HTML format. 

7. Save the results of the Near Term Analysis in HTML format 

• Go to File in the menu bar and select Save the html report. A file chooser window 
will pop up. Navigate to the location you want and type a filename for your 
HTML report. 

• A window titled Image Size Input will pop up. Type in the width of the image and 
click OK. 

• Another window titled Project Saved will pop up displaying the location of your 
saved analysis results. Click OK. 

8. Save the organizational structures resulting from your simulations in ORA 

• Return to the ORA interface. 
• To save the Agent-to-Agent communication network at time-step 40 in the 

simulation, go to File and select Save the Agent-to-Agent communication 
matrices during evolution. 

• A small window titled Save the probability of interaction matrix will pop up. 
Click the Yes button. 

• Another small window titled Save timing will pop up. Enter 40 and click OK. 
• A final window titled Saved will pop up. Click OK. 

You can view saved simulations in Panel 1 of the ORA interface. 
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Below is a screen capture of Panel 1 after simulations have been saved: 

 

Lesson 4 
What is Going on Where? 

We want to identify what events are related to what agents and the locations pertinent to 
both. 

I. Who are the critical actors and where were they seen 
together? 

A Location Report identifies the central locations with respect to other network entities. 

To run a Location Report: 

• Return to the ORA interface. 
• Under Analysis in the menu bar and select Generate Reports. 
• A window titled Generate Reports pops up (see below). 
• At the top of the window is a pull-down menu titled Select Report. Pull down the 

menu by selecting the small inverted arrow icon to its right, and select Location 
Analysis. 

• In the box titled Select one or more MetaMatrices: select the box for the Tanzania 
Embassy bombing MetaMatrix. 

• At the bottom of the popup window is a file chooser titled Enter a file name (any 
extension will be ignored) for the results file: Select the Browse button to the right 
and navigate to the location you want. Type in a filename (for example, 
locationReport) and select Open. 

Below is the popup window with the correct options chosen: 
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• When you've chosen the parameters you want, select the Finish button. 

ORA will now create an HTML file which will open your internet browser and display 
the file. The same text is also displayed in Panel 3 in ORA. 

Below is the ORA interface screen with the Intelligence Report displayed in Panel 3: 
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Below is the HTML file for the Location Analysis Report on the Tanzania Embassy 
bombing data: 

 

LOCATION-ANALYSIS REPORT 

Input data: embassy_tanzania 

Start time: Mon Feb 26 09:56:07 2007 

Before the calculation of the measures the input network is transformed to create a single 
graph per type. For example, all Location x Location graphs are unioned. Further, bi-
modal graphs, such as Location x Agent, are unioned with their transposes, in this case 
Agent x Location. 

Key locations (the most connections to non-location entities) 

The Row Degree Centrality of a node is its normalized out-degree. 

Input graph(s): location x agent, location x event 

Rank Value manual_location 

1 1.05263 u_s 
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2 0.631579 afghanistan 

3 0.578947 pakistan 

4 0.473684 america 

5 0.421053 somalia 

6 0.368421 europe 

7 0.315789 saudi_arabia 

8 0.315789 tanzania 

9 0.315789 london 

10 0.315789 indonesia 

Central locations (the most connections to other locations) 

The Total Degree Centrality of a node is the normalized sum of its row and column 
degrees. 

Input graph(s): manual_location_location 

Rank Value manual_location 

1 1.33962 u_s 

2 1.03774 afghanistan 

3 1.0283 pakistan 

4 0.924528 washington 

5 0.90566 indonesia 

6 0.886792 europe 

7 0.877358 airport 

8 0.735849 america 

9 0.679245 turkey 

10 0.641509 sudan 

Most active locations for events. 

The Row Degree Centrality of a node is its normalized out-degree. 

Input graph(s): location x event 

Rank Value manual_location 

1 2 u_s 

2 2 afghanistan 
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3 1.66667 pakistan 

4 1.66667 america 

5 1 europe 

6 0.666667 saudi_arabia 

7 0.666667 london 

8 0.666667 indonesia 

9 0.666667 somalia 

10 0.666667 spain 

Highest concentration of actors 

The Row Degree Centrality of a node is its normalized out-degree. 

Input graph(s): location x agent 

Rank Value manual_location 

1 0.875 u_s 

2 0.375 tanzania 

3 0.375 pakistan 

4 0.375 somalia 

5 0.375 afghanistan 

6 0.375 africa 

7 0.25 saudi_arabia 

8 0.25 israel 

9 0.25 london 

10 0.25 indonesia 

Actors at the most locations 

The column Degree Centrality of a node is its normalized in-degree. 

Input graph(s): location x agent 

Rank Value agent 

1 2.40741 bin_laden 

2 0.222222 ahmed_ghailani 

3 0.185185 ali_mohamed 

4 0.111111 wadih_el-hage 
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5 0.0740741 mohamed_owhali 

6 0.0740741 mohammed_odeh 

7 0.0740741 jamal_al-fadl 

8 0.037037 khalfan_mohamed 

9 0.037037 fazul_mohammed 

10 0.037037 khalid_al-fawwaz 

Produced by ORA developed at CASOS - Carnegie Mellon University 

 

From the report we notice a couple of locations that contain high values in multiple 
tables: U.S., Afghanistan, Pakistan, and Somalia. In the last table, Actors at the most 
locations, we see both Bin Laden and Ahmed Ghailani have the highest degrees of 
Centrality. We will explore how Bin Laden and Ahmed Ghailani relate to each other as 
well as to the five most prominent locations. 

II. What do we know about the actors of interest? 

First run the Sphere of Influence tool to find any connection between Bin Laden and 
Ahmed Ghailani and the location(s) they have both been reported to be seen at. 

• First make the Visualizer the active window by selecting the Visualize button 
underneath the filename path in the middle of the Main Interface window. 

 



  

 

 

2007 ORA Users Guide - Page 337 

• Under Actions on the menu select Show All Entities. 

 

• Under Tools on the menu select Sphere of Influence. 

 

• In the dialog box that appears find the section Expands only these entities:. Make 
sure that only the [agent] and [location] boxes contain checkmarks. 

 

• In the lower part of the dialog box there is a table. Select the tab labeled agent. 
Then find the rows containing the names of both Bin Laden and Ahmed Ghailani. 
Place a checkmark in the box in each of these rows. Make sure you have no other 
agents selected. 
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The visualizer will now display all the locations that are connected to both Bin Laden and 
Ahmed Ghailani. At this time, it will display every location that they have in common. 

• Select Close in the Sphere of Influence dialog box. 
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Obviously this is more information than we want to displayed at this time. There's a way 
to reduce the amount of information displayed. 

• Under Actions on the menu, select Hide Pendant Entities. This will effectively 
reduce the information to only the locations that are common between Bin Laden 
and Ahmed Ghailani. 

 

Below is the new display in the Visualizer. This has removed all the locations that were 
attached to only one or the other agent, Bin Laden or Ahmed Ghailani, and show the 
locations they have in common. 
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III. What are the important locations? 

Now let' take a look at the individual locations in the above display and the events that 
they have in common. 

• Under Tools on the menu select the Sphere of Influence. 
• First make sure the Hide connections between levels box contains a check in 

order to make the extra edges invisible. 

 

• Next, under Expands only these entities: select both [agent] and [event]. 

 

• In the lower table select the tab labeled manual-location. 
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• Select each of the locations in the display above, individually. 

After doing this for each of the six locations you will be able to view how the six 
locations relate to Bin Laden, Ahmed Ghailani, and the events within the database. The 
six figures below show the screenshots of the six locations displayed individually and 
their connections to people and events. 

Remember; deselect the current location before selecting the new 
location. 

 

From these six displays we can see the following information: 
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• Five of the locations, U.S., New York, Afghanistan, Somalia, and Pakistan, are all 
connected to 11-sep. 

• Three of the locations, U.S., Afghanistan. And Pakistan, are connected to jihad. 
• From the Actions menu, select Show all entities in order to display all 

information. 
• From the Tools menu, select the Sphere of Influence. 

This brings up the Sphere of Influence dialog box again. 

• Make sure to select Hide connections between levels to remove any extra edges. 

 

• Under Expands only these entities: Select [event] 

 

• In the bottom table select the tab labeled manual-location. 

 

• One at a time place a checkmark next to the five locations obtained from the last 
Sphere of Influence report: U.S., New York, Afghanistan, Somalia, and Pakistan. 
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The following will be displayed in the visualizer. This shows how each of the five 
locations relates to each of the events. 

 

IV. How do the agents, locations and events tie together? 

• In the Sphere of Influence dialog box place a checkmark next to [agent]. 

 

Find all of the agents other than Bin Laden and Ahmed Ghailani, and right-click on each 
to bring up the contextual menu. Select Hide Entity to hide them form the current display. 



  

 

 

2007 ORA Users Guide - Page 344 

 

Now you have the two Agents (Bin Laden & Ahmed Ghailani), how they relate to the 
five Locations (U.S., New York, Afghanistan, Somalia, and Pakistan), and their 
relationship to the two Events (Jihad & 11 SEP). 

Lesson 5 
Performing a View Network Over-Time Analysis 

The purpose of this lesson is to perform both a View Network Over Time and View 
Measures Over Time Analysis. To do so requires multiple network datasets 
representative of your network over different time periods. The goal is to analyze how a 
network changes across multiple time periods. The time period is determined by the 
intervals of collected network data and presented as multiple Meta-Matrices, which are 
loaded into ORA in sequential order. The steps below provide detailed instruction on how 
type of analysis. 

To perform a View Network Over-Time Analysis, you must load Meta-Matrices that 
relate to different time captures of your network data, which need to be in the form of 
multiple Meta-Matrices. 

In the following example, we will use network time captures of the 1998 Embassy 
Bombing in Tanzania Meta-Matrix data set and compare the same data set as we knew it 
in 1997 and 1996 and 1998. We will then compare all the Meta-Matrices in the Network 
Over-Time Viewer to gain a visual representation of how this network changed between 
1996 and 1998. 
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Note: For our purposes, we have changed data in this example and 
have renamed the Meta-matrix for three different years. This will 
denote different network variables that have changed over time. 

You will see in the left window pane under input dataset three Meta-Matrices, 1998, 
1997, and 1996, have been loaded. 

From the menu bar: File > Open Meta Matrix 
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Choose [Select Files] 

 

You will see all of our example data sets, which will load simultaneously into ORA, buy 
highlighting and selected all the files. 
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Highlight all files you analyze in Over-Time Viewer. Press [Enter]. 

 

The import data window will appear (below). This will confirm the files you wish to 
analyze. 

 

Select [Finish]. 

All three Meta-Matrices should display in Panel 1. 
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Performing the Over-Time Analysis 

Now that we have time captures of our network data represented and loaded into ORA in 
the form of three Meta-Matrices relating to 1996, 1997 and 1998, we can perform the 
Over-Time Analysis. 

From the Menu Bar > Data Visualization > View Network Over-Time 

 

The ORA Visualizer will render all of the loaded Meta-Matrices. 

Please take special note of the Time Viewer pop-up Window. This window displays a 
slider, which will allow you to quickly change from the first Meta-Matrix time capture of 
1996, to 1997 and 1998 respectively. 
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By moving the slider from one Meta-Matrix to the next, you will gain a visual 
perspective on how the network has changed over Time. 

The series of screen shots below display how the visualized data changes from one slider 
to position to the next. These renders then allow you a picture of how the network 
changes Over-Time. 

Please note: Depending on the complexity of the network and the 
extent to which relationships (ties) have changed, the visualization of 
those changes may be subtle. 

The screen shots below, however, will emphasize the extent to which the role of the 
WTC Event entity has changed from 1996 to 1998 in relation to the network of which it 
is part of namely the Tanzania data set. Below these screen captures, are a series of detail 
screen captures focusing on the WTC Event node. 

Example Slider Position 1 
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Example Slider Position 2 

 

Example Slider Position 3 
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Detail of WTC Event Node when visualized in the Over-Time Viewer as part of the 
1996, 1997 and 1998 Tanzania Data Sets. 

WTC Event Node: Detail 1 - 1996 
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WTC Event Node: Detail 2 - 1997 

Notice who how the relationships of this node to the rest of the 
network has changed from 1996 to 1997. 

 

Notice that the connections (links) have changed from 1996 to 1997. 
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As you can see, as we progress through the data sets pertaining to 1996, 1997 and 1998, 
the event node WTC lost direct ties to other parts of the network. In the 1996 data set, 
WTC had 3 ties to other entities in the Tanzania Embassy network; In 1997, only 2; 
Finally, in 1998, the WTC event node had only 1 link to Tanzania Network. This may 
indicate that the WTC node may have lost importance from one year to the next. 

Summary of Lesson 

At this point, you should be able to complete the following tasks to perform an Over-
Time Network Analysis. 

• Load multiple Time Data Captures in the form of Meta-Matrices, which are 
representative of your network (Meta-Matrix) over time. 

• Use the Over-Time slider window tool to move from one time capture to the next. 
• Gain a visual perspective of how your overall network has changed from one time 

capture to the next. 

Performing the View Measures Over-Time Analysis 

ORA provides an alternative method to analyzing your network data (in the form of 
MetaMatrices captured over time) than the only in the Visualizer. By running a View 
Measures Over Time analysis you can visualize how your network changes in relation to 
any given measure in the form of charts, which take you from one time point to the next. 
Below is a series of screen captures and instruction on how to access the View Measures 
Over Time feature: 

From the main menu bar: Data Visualization > View Measures Over 
Time 
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Select View Measures Over Time. 

 

Select [OK] 

The View Measure Over Time Window will appear. You will see that this window is 
primarily organized into three sections. 

Area 1: is a slider where you can control various inputs that affect the aggregation level 
of your Meta Matrices. 

Area 2: is a tabbed index allowing you to select the graph level you desire and the 
individual entity sets you are interested in analyzing.  

Area 3: displays the actual chart based on the measures you selected in the tabbed index 
and the position of the aggregation slider. 
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Interpreting The Results After Performing View Measures Over-
Time Analysis 

In the example above, we have loaded all three of our network time captures into the 
View Measures Over Time Analysis tool. The result of our analysis, as we have indicated 
before, will be displayed as a chart in the bottom section of the ORA interface in Panel 3. 
But, what does this tell us? To find out, we will examine the Graph Level measure 
Knowledge Waste. From the tabbed measures window: 

Graph tab > Congruence, Organization Measure, Knowledge Waste. 

The result is displayed below. 

 

We can see the chart displays an axis scale correlating to our networks over time. The 
graph level measure of Knowledge Waste was selected using the View Measures Over 
Time tool and the result is displayed in the chart area of the window. 

We can see that the graph level measure of Knowledge Waste held a value slightly above 
40 in the first Meta Matrix, 1996, displayed with 1 on the Time axis. We can deduce from 
the chart that in 1997 something affected our measure of Knowledge Waste to increase 
the value to nearly 60. This corresponds to the time scale axis of 2, which represents 
1997, our second year of network data. In the final year, 1998, our measure of 
Knowledge Waste declined to the value in 1996. This should be visually evident with its 
relative line graph position. 
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It is clear that the value for the Knowledge Waste Measure increased from the first Meta 
Matrix (1996) to the second (1997) and then retreated back to its original (1996) level. It 
would be up to you to determine what may have affected that measure for it to undergo 
this progression and regression. 

Summary of Lesson 

At this point, you should be able to complete the following tasks to perform a View 
Measures Over-Time Analysis: 

• Load multiple data files into ORA (in the form of Meta-Matrices) representative 
of your network across certain periods of time. 

• Select an aggregation level and choose a graph level or entity entity set to 
analyze. 

• Analyze the data output in the charting tool located in the bottom section of the 
View Measures Over Time window. 

• See how your network may have changed from one time capture to the next for 
any given graph level or entity node measure. 

• Use this visual comprehension to draw conclusions about how your network 
changed across multiple time periods. 

Lesson 6 
Immediate Impact 

The Immediate Impact report in ORA allows you to analyze what happens to a network 
after isolating or removing a key actor. The actor can be any entity: knowledge, task, 
location or agent. The idea behind the report is to give you a statistical breakdown of key 
changes that are affected by removing or isolating any particular agents.  

To access the Immediate Impact report: 

From the menu bar: Analysis > Generate Reports > Immediate Impact 

The highlight bar in the following series of screen shots show how to access this report 
from the ORA main interface. 
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At this point the Generate Reports window will appear. You can find the Immediate 
Impact report under the drop down arrow menu. It will also list the other reports available 
in ORA. Note that on the Generate Reports window you can choose text or html output or 
both. You can also select one or more of the MetaMatrices currently loaded into ORA. 

For our example we are using the Tanzania Embassy bombing data set. The version we 
are using is te_3. Once you have selected or changed all variables, select Next.  
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The Generate Reports Immediate Impact window will appear. 

 

The Generate Reports Window provides you with options relating to the specific type of 
analysis you wish to produce and what variables you would like to change. Pay particular 
attention to the tabbed window pan, where you can access individual agents, events, 
knowledge, location, resources, and task entities for removal. 

The screen shot below shows where the tabbed options are located. Here you can specify 
exactly which entity you would like to isolate (remove). The tabs separate your entities 
by entity class, such as knowledge. 
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The Generate Reports – Immediate Impact window does allow additional filtering of your 
entities according to any entities particular attributes. The screen shot below shows the 
attribute and value filters. 
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In our example we are going to select ahmed_the_german. This will be the entity we 
chose to isolate. Select ahmed_the_german by checking the appropriate box. We will 
leave all the other boxes checked to their default settings. 

 

After you have finished selected your entity to be isolated, in our case, 
ahmed_the_german, select the finish button. The Progress window should appear as ORA 
completes the report. 

 

You should see a complete box when the analysis has been completed successfully by 
ORA. 
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You may recall we selected both the HTML and Text output options previous. The 
HTML report will be displayed in a web browser. The text report will be displayed in the 
bottom window of the main ORA Interface. 

Below is the completed immediate impacted analysis as displayed in HTML. Here are 
results are displayed in a Mozilla Firefox web browser. 

 

Below is the full report as produced in the HTML out put option. 

IMMEDIATE-IMPACT REPORT 
Input data: te_3 

Start time: Fri May 11 13:15:45 2007 

What is the impact of the removal of selected key entities from the network? 

The selected entities are removed from the network and the effects are measured by 
comparing the values of key metrics before and after their removal. The results are shown 
graphically in terms of the portion of the network "near" the entities that are removed and 
statistically based on the entire meta-matrix. The portion of the network that is "near" the 
entities that are removed is defined as all known entities of the user selected entity classes 
within a path length of 2 from the target entities. 



  

 

 

2007 ORA Users Guide - Page 362 

For example, if the entity class is agent, and the target is Alexander Bell then the 
displayed network contains all other agents that are directly connected to Bell or are 
directly connected to someone who is directly connected to Bell. 

The following entities were removed: 

Entity 
class Name 

agent ahmed_the_german 

Before Isolation 
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After Isolation 

 

 Before After Percent Change 
Number of nodes 86 85 -1.16% 
Density 0.227981 0.234285 +2.76% 
Diffusion 0.558594 0.586667 +5.03% 
Performance As Accuracy 0.16 0.16 0.00% 

Emergent Leader (cognitive demand) 

Measures the total amount of cognitive effort expended by each agent to do its tasks. 

Name Rank 
Before 

Value 
Before 

Rank 
After 

Value After Value 
Change(%) 

fazul_mohammed 1 0.378917 1 0.379524 +0.16% 

khalfan_mohamed 2 0.353604 2 0.354857 +0.35% 

mohamed_owhali 3 0.305313 3 0.307667 +0.77% 

      

jihad_mohammed_ali 4 0.280313 4 0.281 +0.25% 
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mohammed_odeh 5 0.276083 5 0.278238 +0.78% 

abdullah_ahmed_abdullah 6 0.243792 6 0.245762 +0.81% 

mohammed_salim 7 0.192542 7 0.193429 +0.46% 

ahmed_the_german 8 0.183771 Entity removed 

wadih_el-hage 9 0.180042 8 0.183429 +1.88% 

ahmed_ghailani 10 0.177292 10 0.178143 +0.48% 

Centrality (the nodes with the most links to other nodes) 

The Total Degree Centrality of a node is the normalized sum of its row and column 
degrees. 

Input graph(s): agent x agent 

>tr> 

Name Rank 
Before 

Value 
Before 

Rank 
After 

Value 
After 

Value 
Change(%) 

wadih_el-hage 1 0.433333 1 0.464286 +7.14% 
mohamed_owhali 2 0.366667 2 0.392857 +7.14% 
bin_laden 3 0.266667 3 0.285714 +7.14% 
abdullah_ahmed_abdullah 4 0.2 4 0.178571 -10.71% 
mohammed_odeh 5 0.166667 5 0.178571 +7.14% 
abdal_rahmad 6 0.133333 6 0.142857 +7.14% 
ali_mohamed 7 0.133333 7 0.142857 +7.14% 
khalid_al-fawwaz 8 0.133333 8 0.142857 +7.14% 
fazul_mohammed 9 0.1 9 0.107143 +7.14% 
jihad_mohammed_ali 10 0.0666667 10 0.0714286 +7.14% 

Potentially Influential (betweenness centrality) 

The Betweenness Centrality of node v in a network is defined as: across all entity pairs 
that have a shortest path containing v, the percentage that pass through v. 

Input graph(s): agent x agent 
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Name Rank 
Before 

Value 
Before 

Rank 
After 

Value 
After 

Value 
Change(%) 

wadih_el-hage 1 0.292857 1 0.319597 +9.13% 
mohamed_owhali 2 0.271429 2 0.28663 +5.60% 
bin_laden 3 0.104762 3 0.117216 +11.89% 
mohammed_odeh 4 0.0690476 4 0.0677656 -1.86% 
abdullah_ahmed_abdullah 5 0.0571429 6 0.010989 -80.77% 
fazul_mohammed 6 0.047619 5 0.0549451 +15.38% 
abdal_rahmad 7 0 7 0 NA 

Produced by ORA developed at CASOS - Carnegie Mellon University 

Below is the completed Immediate Impacted analysis as rendered with the TEXT output 
option. 
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Summary 

At this point you should be able to do the following in ORA: 

• Understand the purpose of the Immediate Impact Report analysis; 
• Locate the Immediate Impact Report in ORA; 
• Perform a Immediate Impact Analysis 
• Filter your network data and use the Generate Reports – Immediate Impact 

window. 
• Choose variable relating to the output of your analysis in either HTML or TEXT 

format. 

Lesson 7 
Near Term Impact analysis 

In this step, we use a Tanzania bombing dataset to see how Near Term Analysis (NTA) in 
ORA is working. NTA is an analysis function utilizing a multi-agent model, Dynet. 
Particularly, NTA assumes a set of node removals from a given organizational structure 
and estimates the performance changes and the emergent structures. Thus, the what-if 
analysis with NTA will provide an answer on how the organization will behave and 
change with a sequence of strategic interventions or unexpected personnel loss. This 
demonstration hypothesizes two agent removals: Wadih-Al Hage and Ahmed the 
German, from the bombing dataset. 

1) Loading an organizational structure and starting the Near Term Analysis function. 

The target data should be loaded in the dataset management panel in ORA main window, 
as in Figure 1. Also, the data must be highlighted before starting NTA. 

 

Figure 1 – a loaded dataset in the ORA main window 

Under the Analysis menu in the ORA main window (Figure 2), you can find Near-Term 
Analysis. Click the menu to start NTA. 
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Figure 2 – menu for starting Near Term Analysis 

If your dataset has all the necessary information for the analysis, ORA should display the 
NTA main window, Figure 3. 

 

Figure 3 – a novice mode of Near Term Analysis 

NTA has two modes: Novice and Advanced (Figure 4). Novice mode provides an instant 
analysis setup, so you can just click the button, Execute, at the bottom of the window. 
However, this demonstration will not use this mode because Novice mode does not allow 
users to setup their own analysis question and virtual experiment hypothesis. Instead of 
using Novice mode, we will use Advanced mode, and you can switch Novice mode to 
Advanced mode by clicking on the tab of Advanced mode. 
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Figure 4 – tabs for Novice mode and Advanced mode 

2) Analysis Setup in the Advanced mode of Near Term Analysis 

After clicking the Advanced mode tab, the NTA main window will change like Figure 5. 
We will proceed our rest of the demonstration in this mode. The NTA main window 
consisted of four sub panels: input panels, settings, simulation time line and cases to 
simulate. We will see the usage of the sub panels throughout this sub section. 

 

Figure 5 – an advanced mode of Near Term Analysis 

First, we change the global parameter in Settings. As in Figure 6, we change the number 
of replication and the number of simulated time-points to 2 and 52, respectively. The 
inside analysis engine of NTA is Dynet, a stochastic multi-agent social simulation. 
Therefore, we specify the number of replication and the simulation length for each virtual 
experiment cell. After specifying the simulation length as 52, you should see that the 
simulation time line expands to 52 time steps. 
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Figure 6 – global parameter setting 

 

Figure 7 – simulation time line 

After setting up the global parameters, we setup the virtual experiment cells. Initially, 
there is a pre-defined simulation cell, Baseline. Baseline is the cell without any entity 
removals, so it can be a result when the organization does not experience any 
interventions. Besides Baseline, we will setup two more cells, the removal of Wadih-Al 
Hage and that of Ahmed the German. We start setting an experiment cell by clicking Add 
new simulation instances, located above the simulation time line and under the global 
parameters. 

After clicking Add new simulation instances button, you should see a dialog, titled as 
Near Term Analsys – Simulation scenario create wizard. This wizard supports the 
creation of virtual experiment cells in three different ways. First, you can setup as you 
want by choosing the first option, and we will use this option. The second and the third 
option will ask you a set of criteria for selecting important agents in the network and 
make experiment cells according to the selection. Therefore, the first option give full 
flexibility to users, and the second and the third option provides a systematic analysis 
setup method. To proceed this demonstration, we select the first option and click Next.  

 

Figure 8 – a simulation scenario creation wizard 

Selecting the first option brings the dialog window in Figure 9. We can setup events by 
using the table in the window, add the events to the simulation case, and add the finished 
simulation case to the NTA main window. 
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Figure 9 – a scenario creation wizard for user specified event option 

First, we will make a case experimenting the removal of Wadih-Al Hage. This case 
consists of an event, the removal (isolation) or Wadih-Al Hage. To create the event, we 
find his name in the table located at the bottom of the dialog window. Then, we check his 
name in the left most check box, and change the event timing at 10 (or the time step when 
you want to isolate him). After that, the setup should look like Figure 10. 

 

Figure 10 – select an agent and assign an event and its timing to that agent 

We finished the setup of one event, so we have to add the event to the simulation case. To 

add the setup event, we click Add events button ( ) located next to the 
search text input display. After adding the event, the time line in the dialog will change as 
Figure 11, which means that we are isolating one agent at time 10. For now, we finished 
making one simulation case because we are removing just one agent for each case. To 
finish the setup of the case, we click Add a simulation button located at the bottom of the 

dialog ( ). After clicking add a simulation button, the dialog will 
disappear, and the NTA dialog will have one simulation case at Cases to simulate display. 
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Figure 11 – after 'add event' in the case creation wizard 

Just going through the above one more time, we create one more simulation case by only 
differentiating the removed agent name, from Wadih-Al Hage to Ahmed the German. 
Thus, we have two removal simulation cases in the list. 

 

Figure 12 – simulation case list in NTA main window after add simulation in the wizard. 

NTA dialog window tells you that we have total six simulations to run because we have 
three cases (one baseline + two removal case) that should be replicated for two times. 
Also, you can highlight the simulation case by clicking it, and the simulation time line 
will change as you change the highlight. The simulation time line tells how the 
simulation case is designed. 

 

Figure 13 – information on how many simulation runs will be initiated. 

 

Figure 14 – simulation time line display for each of different cases. 

3) Running the Near Term Analysis 

Since we finished setting the three simulation cases, we have to execute the simulations. 

We click Execute button ( ) at the bottom to start the simulations. After starting 
the execution, you will see a small warning dialog, Figure 15. This is just a warning 
about the long execution time when you have a large network. This dataset should not 
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take such a long time. After clicking OK, a dialog will display how many simulations are 
done, Figure 16. 

 

Figure 15 – a warning about long simulation time when the dataset is big. 

 

Figure 16 – simulation processing procedure. 

4) Results from Near Term Analysis 

The simulation results will be displayed in a new window Near term analysis result, 
Figure 17. Because we have two removal experiment cells, we have two performance 
lines over time. The lines represent the deviation from the baseline in terms of a 
performance measure, Knowledge diffusion. Examining this performance change over 
time reveals how much the removal of the agent will impact to the performance of the 
organization. Also, we can draw a bar chart by clicking Draw bar chart button 

( ). The bar chart, Figure 18, will display the performance comparison at 
the end time of the simulation. 
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Figure 17 – a line chart from Near Term Analysis displaying the performance over time. 

 

Figure 18 – a bar chart from Near Term Analysis describing the deviation of performance 
at the end time. 
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We can obtain just the displayed charts, Figure 20 and 21, by putting the chart in the 
clipboard of Windows. You can find a menu, Copy the chart in the clipboard, Figure 19, 
and it will take the displayed charts in the clip board, so you just paste in any Word 
Documents or Graphics editing tools. 

 

Figure 19 – a menu for copying the images into the windows clipboard. 

 

Figure 20 – copied line char image. 
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Figure 21 – copied bar chart image. 

NTA produces three performance different estimations: knowledge diffusion, binary task 
accuracy and energy task accuracy. You can change the Y-axis performance value by 
selecting one of the three performance metrics from the drop down box at the middle of 
the result window, Figure 22. 

 

Figure 22 – performance metric change. 

The text output is available in HTML format. You can save the result HTML document 
by clicking Save the html report menu under File menu, Figure 23. After the click, you 
will be asked to provide a file name, the width and the height of images, Figure 24 and 
25. If the HTML report is successfully saved, NTA will pop up a dialog saying that the 
document is well saved, Figure 26. The produced HTML report will look like Figure 27. 
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Figure 23 – a menu for saving the HTML report. 

 

Figure 24 – file name specification 
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Figure 25 – width/height specification for the images in the HTML report. 

 

Figure 26 – success indication about saving HTML report. 

 

Figure 27 – the saved HTML report. 

Finally, you can save the emerged organizational structures after simulations in the ORA 
main window. Under File menu, there is a set of menus about saving different emergent 
structures. This demonstration will save the Agent-to-Agent communication network at 
simulation time step 40. First, you can find Save the Agent-to-Agent communication 
matrixes during evolution menu under File menu, Figure 28. If you click it, NTA shows a 
warning, Figure 29, that the saved networks will be from the simulation cases that you 
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selected. You can select or deselect a simulation case by changing check boxes in the 
simulation case table at the bottom of the NTA window, Figure 30. If you click okay at 
the warning, NTA will ask you which time step you want to save, so we specify time step 
40, Figure 31. If saving is successful, it will produce a popup dialog. After this, you will 
be able to see additional saved meta-matrixes in the ORA main window, as in Figure 33, 
so you can run additional ORA reports on the saved networks. 

 

Figure 28 a menu for saving the evolved organizational structure  

 

Figure 29 a warning about selecting cases to save  
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Figure 30 the simulation case list for selection  

 

Figure 31 the simulation time-step to save  

 

Figure 32 success message about saving the emerged structure  

 

Figure 33 ORA main window showing the saved meta-matrixes  

Lesson 8 
Import Data 

The purpose of this lesson is to become familiar with loading your own network data into 
ORA. Your primary tool for doing so is the ORA Data Import Wizard, which is 
accessible from ORA Main Menu bar. The goals of this lesson are following: 
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• How to locate the Data Import Wizard 
• Learn what formats ORA can read. 
• How to work with a CSV file 
• How to work with an ODBC compliant Database 

The screen shot below illustrates where to find the Data Import Wizard from the Main 
Menu bar. 

 

In this example, we are first going to load a MetaNetwork, 
TanzaniaEmbassyEnhanced_2-07_1996.xml, which is already is in ORA's native 
formatting language - Dynet.ml. 

From the Main Menu Bar: Data Import Wizard > Import Data into ORA 
window (should appear) 

The screen shot below displays the Import Data into ORA wizard. 
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The Import Data into ORA window lists the acceptable file formats that can be read into 
ORA. They are the following: 

• Dynetml (the native ORA xml format) 
• .dl 
• .##h (UCINet) 
• .CSV (comma separated values, Excel spreadsheet out) 
• .txt (text files) 
• .raw 
• .net (Pajek) 
• .graphml 
• .stl (GMU model) 
• .lo (pathfinder) 

Note! ORA will only recognize the file extension to determine what form 
the data is in. Additionally, the ORA Import Data Wizard is a separate 
tool from the ORA application (e.g. When accessed, ORA launches a 
separate executable file - .exe). 

From the Import Data Into ORA window, click the Select Files button. 

From the Main Menu Bar: Data Import Wizard > Import Data into ORA window > 
Select Files 

The ORA Open window will appear (screen shot below). 
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We will select the .xml file TanzaniaEmbassyEnhanced_2-07 in this example. You 
will see that the file path is now populated in the Select Files field. 
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Click Next. 

The Import Data into ORA window will now prompt you for several options concerning 
the network you are importing. In particular, you need to specify what kind of graph you 
are creating and if you are adding it to a MetaNetwork already in ORA or if this will be a 
new one completely. The screen shot below shows these options. 

 

Select the drop down menu under Choose a source entity set: to specify a source entity. 
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Next select a target entity under Choose a target entity set:. 
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At this point you have an option to specify a graph name. You can call it whatever you 
choose. By default, it will name your graph based on the source and target entity set. 

If you are working in a CSV file, please be aware that the rows are the source and 
columns are the target. 

 

Select Finish. 

The Import Data window will appear. 

 

Now you can choose to replace any selected MetaMatrix already loaded into ORA; 
Append your new graph to a MetaMatrix; or, choose to replace all MetaMatrices. 

You should now see your MetaMatrix loaded into ORA's main interface. 
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ODBC Compliant Databases 

(O)pen (D)ata (B)ase (C)onnectivity 

ORA has the capability to read ODBC compliant databases. Generally speaking, ORA 
will need to know what type of query to run. To do so requires wrapping a query in the 
proper XML format. Therefore a user must be familiar with writing an XML script to 
accomplish this task. The details of exactly how to do this are beyond the scope of this 
lesson. However, should you require technical assistant in doing just that, please contact 
the CASOS Center for specific instructions. 

Summary 

After completing this lesson, you should be able to: 

• Locate the Data Import Wizard from the ORA Interface.  
• Learn what formats ORA can read. 
• How to work with a CSV file 
• How to work with an ODBC compliant Database 
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